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重要！
在使用本產品之前，請注意下述重要資訊。

• 在使用另選交流電變壓器供電之前，必須首先檢查交流電變壓器是否有任何損壞。請仔細檢查電源線，看是否有斷裂、斷線、裸
線及任何其他嚴重損壞。切勿讓兒童使用已嚴重損壞了的交流電變壓器。

• 切勿試圖對電池進行再充電。
• 不要使用充電電池。
• 切勿混用新舊電池。
• 請使用推薦的電池或相同種類的電池。
• 必須確認電池正（＋）負（－）極的方向與電池盒旁邊標記的方向一致。
• 任何電力不足的蹟象出現後應盡快更換電池。
• 不要讓電池端子短路。
• 3歲以下兒童不能使用本產品。
• 只能使用 CASIO AD-E95100L變壓器。
• 交流電變壓器不是玩具。
• 在清潔本產品之前必須拔下交流電變壓器。

●不得複製本說明書或其中的任何部分。根据版權法，您可以個人使用本說明書，未經卡西歐（CASIO）的許可不得他用。
●卡西歐（CASIO）對於因使用或無法使用本說明書或產品而引起的任何損失（由利益損失而產生的包含的無限制的損害，
工作中斷，資料丟失）一律不負任何責任。即使卡西歐已接到此種損害可能性的警告。

●本用戶說明書之內容如有更改，恕不另行通知。
●產品的實際外觀可能會與本用戶說明書的插圖中所示的有所不同。

●本說明書中涉及的公司及產品名稱可能是相關所有者的註冊商標。
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Ch-5

部位說明
• 在本說明書中，按鈕、旋鈕、端子及其他部分由組編號（1，2等）及部分名組合表示。

1至5組的排列能讓您方便地邊聽邊調節聲音。

1 這些按鈕用於選擇分配在滑鈕（5）及2鈕上的功能。☞第 Ch-34頁

2 在編輯獨奏合成器音色或改變分配在滑鈕（5）上的聲部時使用這些按鈕。☞第 Ch-23頁

3 這些旋鈕用於調節擊鍵、衰減及其他聲音的參數。☞第 Ch-34頁

4 這些按鈕用於用步音序器打開或關閉各步。☞第 Ch-53頁

5 這些滑鈕用於調節參數。其還用於用步音序器及混頻器進行編輯。☞第 Ch-34, Ch-53, Ch-78頁

左面 中央 右面 盤

背面

左下

• 盤稍微傾斜。請小心，不
要讓放在上面的物品滑
落。

• 不要在盤上放置杯子或任
何其他液體容器。

1

3

4

52
（滑鈕）

左面
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部位說明

Ch-6

6 [POWER]鈕用於開機與關機，而 [VOLUME]旋鈕用於調節音量。☞第 Ch-9頁

7 頂上的三個按鈕用於選擇合成器的模式。底部的三個按鈕用於編輯及保存音色及其他資料，以及配置系統級的通用設定。
☞第 Ch-11, Ch-12, Ch-81頁

8 這些按鈕用於調節步音序器、樂句及其他播放的速度。☞第 Ch-46頁

9 這些按鈕用於選擇聲部，以便用步音序器或混頻器進行編輯。☞第 Ch-52, Ch-78頁

bk 這些按鈕用於為步音序器的播放或編輯選擇步。☞第Ch-52頁

bl 這些按鈕用於選擇步音序器的型。☞第 Ch-11, Ch-52頁

bm 這些按鈕用於取樣循環器的錄音與播放。☞第 Ch-64頁

bn 這些按鈕用於打開或關閉琶音及保持功能，以及改變混頻器或音效設定。☞第 Ch-37, Ch-40, Ch-78頁

bo 這些按鈕用於執行樂句的音序器錄音及播放。☞第 Ch-45頁

bp 旋鈕用於快速改變畫面上顯示的數字或數值。☞第 Ch-11頁

6

9 bk bl

7 bn8 bm bo bp

中央

LCD

表示當按鈕被按下時的功能名。

（旋鈕）
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部位說明

Ch-7

bq 這些按鈕用於選擇音色編號、演奏編號等。☞第 Ch-19頁

br 右側的六個按鈕用於在畫面上移動游標，而減（–）與加（+）鈕用於改變顯示的數值。按 [MENU]鈕可顯示目前進行的操作的
選單。☞第 Ch-20頁

bs 這些鍵用於改變聲音的音高。☞第 Ch-36頁

bt [BENDER]用於彎音，而 [MODULATION]用於為音符添加顫音。☞第 Ch-34頁

背面 請參閱下一頁。

bq

br

bs

右面

bt

左下
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Ch-8

演奏前的準備

• 要在合成器上連接任何裝置時，必須查閱該裝置附帶的用戶文件。
• 本合成器不內置揚聲器。除非連接一些能輸出聲音的裝置，否則其不產生聲音。

ck 左後

cl 右後

連接

記憶卡（第 Ch-86頁） 電腦（第 Ch-92頁） 其他電子樂器（第 Ch-82頁）

(1) (2) (3) (5) (6) (7)(4)

*1 標準插頭（單聲道）
*2 立體聲標準插頭
*3 立體聲迷你插頭

踏板 麥克風 耳機 室內電源插座

CD唱機，音響唱機等。 音頻裝置，放大器等

其他電子樂器

*1 *3 *1 *1 *1 *2

配置與種類依
您的地理位置
而不同。

XWG1_ch.book  Page 8  Wednesday, January 18, 2012  10:34 AM



演奏前的準備

Ch-9

請找到室內電源插座或準備電池。

• 請務必參照另一冊“安全注意事項＂。本產品使用不當有造
成觸電及火災的危險。

• 在插上或拔下交流電變壓器之前，或在裝入或取出電池之前
必須關閉產品的電源。

只能使用為本產品指定的交流電變壓器（JEITA標準，有統一
的極性插頭）。使用其他種類的交流電變壓器會引起故障。

1. 使用為本合成器指定的交流電變壓器將其與室內
電源插座連接。

2. 按6 POWER打開電源。
• 要關閉電源時，請再次按6 POWER。

目的： 操作：

（1） 使用踏板 連接一個另選的延音踏板。有關當踏板被踩下時產生的音效類型的說明，請參閱
第 Ch-74頁。

（2） 從其他電子樂器輸入聲音 用市賣連接線在合成器上連接其他樂器的輸出端子（單聲道）。*4

• 創建作為合成器音色（第 Ch-21頁）一部分的新音色時，您還可以為輸入的聲
音添加音效（第 Ch-36頁）並使用輸入音。

（3） 從外接裝置輸入 用市賣連接線在合成器上連接 CD唱機或便攜唱機的輸出端子（立體聲）。*4

（4） 使用麥克風從外部輸入聲音 在合成器上連接市賣動態麥克風。*4

用 cl MIC VOLUME可以調節從麥克風輸入的聲音，獨立於其他聲音。
• 有關為從麥克風輸入的聲音添加音效的說明請參閱第 Ch-78頁。有關使用輸入
音進行音色創作的說明請參閱第 Ch-21頁。

（5） 使用音頻裝置或放大器輸出合成器的

聲音

用市賣連接線在合成器上連接音頻裝置或放大器的輸入端子（AUX IN等）。*4

• 要用一根連接線進行單聲道輸出時，請在合成器的 L/MONO端子中插入連線。

（6） 使用耳機 在合成器上連接另選的或市賣的耳機。*4

• 不要長時間地用非常大的音量聽音樂。否則有損壞聽力的危險。

（7） 為合成器通上電源 請參閱下述“電源＂一節。

*4 在連接之前，必須先切斷合成器及其連接裝置的電源，並調低6 VOLUME。

電源

室內電源插座的使用

指定的交流電變壓器：AD-E95100L
6

交流電變壓器
• 配置與種類依您的地理
位置而不同。

DC 9.5V

室內電源插座
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演奏前的準備

Ch-10

• 若您只是輕輕地按6 POWER，則畫面將點亮片刻，但電
源不打開。這不表示發生了故障。請完全按下6 POWER
打開電源。

• 長時間使用後，交流電變壓器會變熱。此為正常現象，並不
表示發生了故障。

• 為防止電源線斷裂，請不要在電源線上放置任何重物。

• 切勿在產品的 DC 9.5V端子中插入金屬、鉛筆或任何其他物
品。否則有發生意外的危險。

本產品需要六節 D型電池進行供電。
• 請使用鹼性電池或鋅碳電池。
切勿使用氧化物電池或任何其他鎳性電池。

1. 打開合成器底部上的電池蓋。

2. 在電池艙中裝入六節 D型電池。
• 確認電池的正極+及負極-方向正確，如圖所示。

3. 將電池蓋的卡榫插入電池艙一側的孔中，然後關
閉電池蓋。

4. 按6 POWER打開電源。

■電池電力不足指示符
下面介紹電池的大約壽命。
約 35個小時 *（鹼性電池，使用另選的 CASIO CP-16耳機）

* 使用高音量設定，在極低的溫度下演奏，以及一些其他的演
奏環境可能會縮短電池的壽命。

當“Battery Low＂訊息出現並且下示指示符在畫面上閃動時
表示電池的電力不足。請將電池更換為新電池。

沒有任何操作經過預設時間時，為避免浪費電源，合成器自動

關機。自動關機的動作時間由電池供電時為六分鐘，而由交流
電變壓器供電時為四小時。

• 如“合成器的通用設定＂一節（第 Ch-81頁）所述關閉
“自動關機＂設定可解除自動關機功能。

使用未指定的配件有造成火災、觸電及人身傷害的危險。

• 從您的經銷商或從下示 CASIO網站可以得到 CASIO的產品
目錄，有關本產品的另購件的資訊可以在產品目錄中找到。
http://world.casio.com/

不可彎曲！ 不可纏繞！

電池的使用

卡榫

自動關機

附件及另選件

電池電力不足指示符（閃動）

XWG1_ch.book  Page 10  Wednesday, January 18, 2012  10:34 AM



Ch-11

如何通過彈奏來學習演奏（對於合成器的新手）

本章通過實際使用合成器使您熟悉基本操作，避免陷於理論和

技術的細節之中。對於首次使用合成器的用戶來說是個完美的

開始。

那我們就開始吧！

按6 POWER打開電源。合成器最初進入演奏模式。

演奏模式能在演奏過程中最大限度地發揮合成器的作用，但不

大適合此處的基本說明。現在，讓我們從音色模式中的基本操
作開始。

按7 TONE進入音色模式。

■三種合成器模式

現在，請選擇一種音色並聽一聽是什麼聲音。

音色分為四個類別。轉動 bp旋鈕選擇所需要的音色編號。或
者，您還可用 bq鈕輸入指定的音色編號（第 Ch-19頁）。

• 有關詳情請參閱第 Ch-19頁。

首先，讓我們看看獨奏合成器的音色是什麼樣的聲音。轉動

bp旋鈕選擇音色編號。

用內置音色的演奏

6

7

演奏模式

演奏模式

音色模式

步音序器模式

點亮

音色模式

演奏模式

此模式用於彈奏及演奏。使用音色

類別、步音序器等能實現高水平的

演奏。

音色模式
此模式用於創建音色。您可以選擇
一種音色並對其進行編輯。

步音序器模式
此模式用於創建步音序器的資料
（組）。

類別
概要

編號 名稱

P000至
P099

獨奏合成器 傳統的模擬合成器音色

P100至
P399

PCM旋律音色
PCM鼓音音色

這些音色讓您使用取樣

音再現各種不同樂器的
聲音。

– 用戶波形音色
保存用取樣循環器錄音
的音色。
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如何通過彈奏來學習演奏（對於合成器的新手）

Ch-12

在鍵盤上進行彈奏，聽一聽產生的音色像什麼聲音。用6 
VOLUME調節音量。
• 請注意，獨奏合成器的音色是單聲道的。若您按多個琴鍵，
只有最後按的鍵盤的音符產生。

獨奏合成器實際上是含有 100種內置（預設 *）音色的類別。
我們現在彈奏的就是其中之一。讓我們彈奏此類別中更多的一

些預設音色。
* “用戶音色＂是指您創建並為以後調用而保存的音色。“預
設＂及“用戶＂這些詞還用於其他類型的資料，例如，步
音序器資料，演奏資料等。

按 br加（+）鈕。按該鈕將遞增預設音色編號並改變音色設
定。

使用相同的操作可以選擇獨奏合成器以外其他類別中的音色，
這樣您可以瞭解都有些什麼音色。

創建音色實際上是使用合成器的全部目的。從預設音色開始，
通過改變各種參數可以創建您的原創音色。

對於此設定，按7 EDIT鈕可選擇強大的編輯功能
（第 Ch-20頁）。另外，您還可以用5滑鈕輕易地改變音

色，而不需要使用7 EDIT鈕。讓我們簡單地看一下對獨奏
合成器音色的編輯。在本說明書的後部對此操作有極為詳細的

說明。

按7 TONE後轉動 bp旋鈕選擇音色編號。

在鍵盤上彈奏一些音符。在彈奏的同時轉動3 
ASSIGNABLE KNOBS。聲音的音色特徵改變。繼續調節直
到音色產生您需要的聲音。

例如：當 P:000被選作音色時轉動 K1

完成後，結果可以保存為用戶音色。

按7 WRITE進入保存模式。保存的目的地將出現在畫面上。

用 bp旋鈕或 br減（–）及加（+）鈕指定要保存用戶音色
的音色編號。

br 背面 前進

音色編號

音色名 P：預設
U：用戶

音色的創建

• 向右轉動能使音色更加明亮。
• 向左轉動能使音色更加深沉。

保存目的地
U:用戶編號
000: 音色編號 000
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如何通過彈奏來學習演奏（對於合成器的新手）

Ch-13

然後，按 br向下（w）鈕進入音色名輸入畫面。

例如﹕

用 br左（U）及右（I）鈕在輸入位置之間移動游標，用

bq音色編號鈕輸入字符。
• 下圖表示各 bq音色編號鈕輸入的字母。按一個按鈕將循環
選換字母或選換其設定。有關可輸入的字符種類的說明請參
閱第 Ch-103頁。

• 您還可以用 br減（–）及加（+）鈕或 bp旋鈕選換字符。

音色名輸入完畢後，按 br ENTER。此時“Replace?＂（要
替換目前的音色嗎？）出現在畫面上。*1

按 br YES保存用戶音色。*2

*1 在音色編號下保存資料將刪除該編號下之前分配的所有資
料。

*2 若您不想保存資料，請按 br NO，而非 YES。

• 建議您將合成器記憶器中儲存的所有資料備份到記憶卡或電
腦的硬磁碟上。要在記憶卡上保存資料時，請參閱“記憶
卡的使用＂一節（第 Ch-86頁）。要在電腦上保存資料時，
請參閱“電腦的連接＂一節（第 Ch-92頁）。

要調用已保存的用戶音色時，請使用與調用預設音色相同的操

作步驟。現在讓我們來試著調用剛剛保存的音色。
• 在指定音色編號之前，請按 bq PRESET/USER進入用戶音
色選擇模式。

到此為止，您已掌握了編輯及保存音色所需要的最簡單的操作

步驟。但您不應該在這裡停止。本合成器配備有強大的其他音
色編輯特長、功能及工具。在這些上多花些時間學習，您將能

進行高水平的音色編輯。更多說明請參閱第 Ch-18頁上“音
色的選擇及創作＂一節。

合成器不僅僅能創作音色。其還配備有能增進演奏的各種功
能，其支援有獨特表現力的節奏及樂句。本節簡單地介紹這些

功能中的一部分。

按 bn ARPEGGIO使該鈕點亮。

在鍵盤上按任意琴鍵。琶音功能將使分配在琴鍵上的音符反覆

循環演奏。當您鬆開鍵盤琴鍵時循環停止。
按兩個或三個鍵盤琴鍵將循環演奏您所按的琴鍵的音符。按三

個或更多的琴鍵將使琶音（有時稱為“曲弦＂）演奏。

游標：輸入位置

符號（第 1部分）

數字

ABC DEF GHI JKL

（切換大寫 /小寫字母）

MNO PQRS TUV WXYZ

符號（第 2部分）

bq

步音序器及樂句的使用

琶音功能

bn

點亮（表示用戶音色被選擇。）

用戶音色

點亮
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如何通過彈奏來學習演奏（對於合成器的新手）

Ch-14

有各種不同的內置琶音類型。您可以用與選擇預設音色相同的

方法選擇一個，對其進行編輯並作為用戶琶音類型進行保存。
讓我們先看一下選擇預設琶音類型的操作步驟。

• 本合成器的琶音分為名為“庫＂的 10組。共有編號 0至 9的
10個琶音庫，每個庫中有 10種琶音，因此共有 100種琶
音。

按住 bn ARPEGGIO直到下示畫面出現。

現在使用與選擇音色相同的方法（第 Ch-11頁），轉動 bp旋
鈕選擇預設樂句類型。
有關琶音的詳細說明請參閱第 Ch-40頁上的“琶音的自動產
生＂。

為了理解什麼是樂句，讓我們聽一段預設樂句。

按住 bo KEY PLAY直到下示畫面出現。

按 bo PLAY/STOP。合成器的內置預設樂句之一開始播放。
然後，轉動 bp旋鈕並選擇其他預設樂句。

除使用 bo PLAY/STOP以外，您還可以通過在鍵盤上按一個
琴鍵來開始播放樂句。讓我們來看看操作過程。

首先，按 bo KEY PLAY使按鈕點亮。

此表示現已進入琴鍵彈奏模式。在琴鍵彈奏模式中按一個鍵盤
琴鍵可自動開始樂句的播放。按另一個琴鍵可使樂句以不同的

音高播放。在琴鍵彈奏模式中，使用鍵盤能以不同的音高連續
彈奏一個樂句，產生有趣的效果。

樂句音序器的主章節詳細說明如何錄音自己的樂句，並在需要
時進行播放。有關詳情請參閱第 Ch-47頁上的“新樂句的錄
音＂一節。

讓我們從聽一些預設序列資料開始介紹步音序器。

按7 STEP SEQ進入步音序器模式。

樂句音序器

畫面標題（琶音類型） 庫 -類型編號

預設

樂句音序器模式 庫 -樂句編號

預設

樂句名

bo

步音序器

7

點亮

點亮

步音序器模式 庫 -序列編號

預設

序列名
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如何通過彈奏來學習演奏（對於合成器的新手）

Ch-15

選擇音色時，使用 bp旋鈕可以選擇所需要的序列。現在讓我
們選擇預設序列 2-3，然後按 bk START/STOP。所選序列將
開始播放。

每個序列都含有 8個變奏（型），可以用 bl PATTERN 1至
8鈕進行選擇。通過選擇各種型可以瞭解什麼能夠使用。

例如：要選擇 3型時

步音序器使用合成器音源的 16個聲部中的 9個（8至 16），
能滿足非常複雜的節奏的要求。通過檢查合成器畫面上的音量
計可以隨時知道哪些聲部在輸出聲音。

在序列播放過程中，4鈕（1至 16）不斷地打開或關閉，表
示正在編輯的聲部（由上圖中的指針（e）指示的聲部）音
符的移動。這就是步音序器反覆產生 16步的方法。
使用9 PART減（–）及加（+）鈕可以選擇要編輯的聲部。
用5滑鈕編輯各步。有關詳情請參閱第 Ch-50頁。

此處看到的只是本合成器能產生的各種眾多節奏中的一小部

分。請務必參閱第 Ch-50頁上“步音序器的使用＂一節中的
操作步驟，瞭解如何創建自己的原創序列。

下面舉例說明如何用取樣循環器對聲音進行取樣並建立循環。

在合成器上連接其他要取樣的電子樂器或麥克風。（參閱

第 Ch-8頁。）

按 bm REC顯示 LOOPER REC（取樣循環器的錄音設定）
畫面。
• 用 br游標（q, w）鈕與 br減（–）及加（+）鈕將
“Rec Mode＂設定改變為“NORM-AT＂，將“Length＂
設定改變為“04bt＂。

再次按 bm REC。
這將使 bm REC鈕閃動。進入錄音自動開始模式。

在其他電子樂器或麥克風上輸出聲音，或在合成器上進行演

奏。合成器將探測聲音並開始錄音。
• 錄音開始時 bm REC鈕點亮。

錄音完四拍後，錄音內容開始自動循環播放。
• bm REC鈕開始高速閃動，覆蓋錄音暫停。您此時進行的任
何演奏都不會覆蓋錄音在取樣中，因此可以與之前的錄音進
行雙重奏或為之後的錄音進行練習。

準備好開始覆蓋錄音時，再次按 bm REC，bm REC鈕燈停止
閃動，開始點亮。

• 您此時的演奏覆蓋錄音在之前的錄音之上。
• 按 bm REC可交替選換循環播放與覆蓋錄音。

要停止錄音時請按 bm PLAY/STOP。

有關詳情請參閱“如何用取樣循環器錄音與播放＂

（第 Ch-64頁）。

bk

bl 點亮：選擇的型

聲部 11及 14未使用

為編輯選擇的聲部（e）

取樣的錄音與循環

bm

REC模式的設定畫面

自動 REC模式

閃動
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如何通過彈奏來學習演奏（對於合成器的新手）

Ch-16

若您已閱讀了說明書中本簡介的所有資訊，則可以開始使用演
奏功能了。在音色模式中，您知道如何選擇一種音色並在鍵盤

上彈奏。在演奏模式中您可以同時使用最多四種音色進行演

奏。使用演奏模式還能以稱為“演設＂的設置登錄音色、步音
序器及其他設定。即使您正在演奏，演設亦可以隨時調用，立

即改變序列的設置。

按7 PERFORM進入演奏模式。

演奏模式的鍵盤使用區段聲部 1至 4的四種音色。有關區段聲
部及其音色的詳細說明請參閱第 Ch-18頁上的“音色的選擇
及創作＂一節。

• 獨奏合成器音色只能分配到區段聲部 1。

必須先配置區段聲部 1。同時按7 PERFORM與7 TONE
進入快速音色模式，此模式可以進行簡單的演奏編輯。

若畫面上的指針（e）不在 1的下面，請用9 PART減
（–）及加（+）鈕將其移動到 1。
在確認指針（e）位於 1之後，用 bl bp bq br為區段聲部
1選擇音色。

然後，用9 PART減（–）及加（+）鈕將畫面指針（e）
移動到 2處，然後用與上述相同的操作步驟為區段聲部 2選擇
音色。反覆執行上述操作為區段 3及 4選擇音色。

為各區段聲部選擇了音色之後，按 br EXIT返回演奏模式畫
面。然後，在鍵盤上進行彈奏，看看發出什麼聲音。您通過上
述操作選擇的所有四種音色都會產生。

畫面上的驚嘆點（！）指示符表示有尚未保存的待定編輯。按

7 WRITE進入保存模式。然後，使用與保存用戶音色相同的
操作步驟保存用戶演奏資料。

演奏功能的使用

7

點亮

演奏模式 庫 -演設編號

預設

演設名

7

快速音色模式

正在編輯的區段聲部音色

正在編輯的區段聲部

編輯待定指示符

XWG1_ch.book  Page 16  Wednesday, January 18, 2012  10:34 AM



如何通過彈奏來學習演奏（對於合成器的新手）

Ch-17

例如：要在用戶庫 2，演設 1中保存演奏時

• 編輯待定指示符（！）及編輯保存指示符（*）亦在其他編
輯及保存資料（音色，步音序器等）模式中使用。

當您演奏樂曲“Aura Lee＂時，只要調用用戶演設 2-1為合成
器配置您在上面登錄的四種音色即可。請調用一種不同的演設
編號後調用用戶演設 2-1。

除鍵盤音色之外，您還可以將各種其他的設定登錄為演設資
料。使用庫比較有效的方法應該是作為樂曲指定庫使用。例

如，用於“Aura Lee＂的庫 2，用於另一首樂曲的庫 3等。有
關詳情請參閱第 Ch-71頁上的“演奏模式的使用＂。

使用下述操作步驟可以演奏能展示合成器各種能力的內置示范
曲。

同時按7 SETTING及7 WRITE。

然後按 br ENTER。示範曲開始播放。
• 用 br減（–）及加（+）鈕選擇其他樂曲，用 bk START/

STOP可停止示范曲的演奏。有關詳情請參閱第 Ch-84頁。

即使關機，您在合成器上配置的音色編號及其他設定仍將保
留。有關使設定返回初始預設值的說明請參閱第 Ch-84頁上的
“合成器的全體設定及資料的初始化＂一節。

至此，面向合成器新手的章節結束。有關在本節中概要說明的

主題的詳細資訊，請參閱本說明書中的其他章節。請花些時
間，不要冒進，確保所學習的內容都能完全理解。若您對在本

節中所使用的術語不理解，請在網上查找更多的訊息，或參考
關於合成器或電子樂器的書籍。

很快您便能發揮聲音創作的全部潛力。

編輯保存的指示符

表示“Aura Lee＂演奏資料的名稱

內置示范曲的演奏

7

結論
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Ch-18

音色的選擇及創作

本合成器的音色由下示 16個聲部組成，外加外部輸入聲部。本章介紹如何在音色模式（第 Ch-11頁）中選擇並用區段聲部 1*編
輯及保存音色。

還介紹用於增強音色的音效功能，在您演奏的過程中其控制器可對音色產生各種變化。

* 關於區段與區段聲部
鍵盤、踏板、按鈕及其他操作不僅影響合成器的預設音色，還會傳送MIDI資料並影響與合成器連接的所有外接裝置（電子樂器
或電腦）。

同時作用於內部及外接各聲部的設定共同稱為“區段＂，而對應各區段的合成器內置音源的各聲部稱為“區段聲部＂。例如，若

您用合成器的區段 2選擇一種音色，該音色即對應內部音源的區段聲部 2，亦對應外接裝置的 MIDI頻道 2。

概要

聲部編號 聲部名 特長

1 區段聲部 1* 合成器的主聲部。在鍵盤上彈奏時此聲部演奏。分配在區段聲部 1的音色可以選擇，
亦可以編輯。

2至 4 區段聲部 2至 4* 這些聲部只能在演奏模式中演奏。與區段聲部 1相比，對這些聲部的音色的分配及編
輯是有限的（第 Ch-71頁）。

5至 6 多功能鍵
樂句 1（聲部編號 5）與樂句 2（聲部編號 6）使用這些聲部，由多功能鍵功能分配
（第 Ch-73頁）。

7 引導，預計數 錄音樂句（第 Ch-47頁）時由引導及 /或預計數使用。

8至 16 鼓音 1至和弦 步音序器的音符聲部（第 Ch-40頁）。

– 外部輸入 這些音色從 cl MIC IN, INST IN插孔（第 Ch-78頁）輸入。

• 區段與 MIDI頻道（第 Ch-73頁）的關係是可以改變的。

9 bl

7 bn bo bp

bq

br

bs

3

5
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1. 按7 TONE。
該鈕點亮，合成器進入音色模式。

2. 按 bq PRESET/USER選擇預設音色或用戶音色。
• 該鈕熄滅時表示選擇了預設音色，而該鈕點亮時表示選擇了用戶音色。

3. 用 bq的數字鈕（0至 9）輸入音色編號。
• 旋轉 bp旋鈕亦能選擇音色編號。
• 改變音色編號的另一種方法是用 br減（–）及加（+）鈕遞增或遞減顯示的號碼。同時按 br減（–）及加（+）鈕可跳至目
前所選類別中的第一個音色（參閱下一節）。

■音色類別概要

• 另一冊“附錄＂中有音色的完全列表。

如何選擇音色

類別

說明

音色數

編號
名稱 預設 用戶

預設 用戶

P000-P099 U000-U099 獨奏合成器
此類別中包含傳統的模擬合成器音色。您可以選擇一
種波形作為基礎，然後編輯聲音的三個元素（音高、

音色、音量），創作所需要的聲音。單聲道。

100 100

P100-P399 U100-U199 PCM旋律音色 此類別中的音色讓您使用取樣音再現各種不同樂器的

聲音。

300 100

P400-P419 U300-U309 PCM鼓音音色 20 10

– U200-U210 用戶波形音色

編輯用取樣循環器（第 Ch-64頁）錄音的聲音的波
形。聲音的波形可以編輯後保存為用戶波形音色。

• 用戶波形音色U210是一種由取樣循環器的錄音實時
改變的音色。

– 11

區段聲部 1 區段聲部 2 區段聲部 3 區段聲部 4

（MIDI頻道 1） （MIDI頻道 2） （MIDI頻道 3） （MIDI頻道 4）

區段 1的設定 區段 2的設定 區段 3的設定 區段 4的設定

內置音源

外接裝置
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1. 選擇要編輯的音色。
• 您可以選擇一種預設音色或一種已有的用戶音色進行編
輯。

2. 按7 EDIT。
音色編輯列表的頂部畫面出現。

例如：獨奏合成器音色編輯列表的第一頁

3. 用 br選擇所需要的項目並改變選擇的設定。
• 旋轉 bp旋鈕亦可以改變設定。
• 有關顯示內容的詳情，請參閱本說明書中從“獨奏合成
器音色的可編輯參數＂（第 Ch-21頁）至“用戶波形音
色的可編輯參數＂（第 Ch-32頁）各節中各音色類別的
說明。

例如：要選擇頂部畫面上的“Volume＂（音量）項目並改
變其設定至 055時

4. 編輯完畢後，按7 EDIT。
本機退出音色編輯列表。
• 編輯待定指示符（！）表示有尚未保存的待定編輯。若
您在未保存的情況下進行其他操作，則您進行的編輯將

丟失。要保存編輯的內容時請進行到下述第 5步。

5. 按7 WRITE後將編輯後的音色保存為用戶音色。
• 有關保存用戶資料的說明，請參閱保存用戶音色的操作
（第 Ch-12頁）。

• 有關如何刪除用戶音色的說明請參閱第 Ch-83頁。

• 音色編輯列表上的有些項目的設定可以用合成器的滑鈕來改
變，而不需要通過音色編輯列表。請參閱下一節中的“聲

音的控制＂。

■如何在外接裝置上保存用戶音色
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

如何編輯音色並保存為用戶音色

列表標題

列表

此畫面上的選項為由多個項目組成的組。

選擇一個組並按 br ENTER進入組。

頁號

項目選擇游標 設定

brbp

改變設定。 換頁。

選擇項目。

進入一個組。

從一個組退出。

編輯待定指示符

XWG1_ch.book  Page 20  Wednesday, January 18, 2012  10:34 AM



音色的選擇及創作

Ch-21

獨奏合成器音色由編號為（1）至（6）的六單元音色合成而來，如下圖所示。在實際進行音色編輯之前，您需要花一點時間熟悉
各單元的結構和細節。

■獨奏合成器音色的配置圖

* Envelope Generator（包絡生成器）

獨奏合成器音色的可編輯參數

MIC IN

INST IN

（1） Synth OSC1單元

EG* EG* EG*

Synth OSC 濾音器 放大器

（2） Synth OSC2單元

（3） PCM OSC1單元

EG* EG* EG*

PCM OSC 濾音器 放大器

（4） PCM OSC2單元

（5）外部輸入音單元

EG* EG* EG*

音高移位器 濾音器 放大器

（6）噪音單元

EG* EG*

噪音生成器 濾音器 放大器

（8） LFO1單元

EG*

LFO

（9） LFO2單元

（7）總單元

EG*

濾音器
獨奏合成器

DSP

輸出

至單元（1）至（9）

（10）控制器

• 鍵盤
• 踏板
• bn HOLD
• 彎音輪
• 變音
• MIDI接收訊息

（虛擬控制器）

至單元（1）至（7）
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說明

（1）合成器 OSC1單元

“OSC＂是“oscillator＂（振盪器）的縮寫，是聲音實際產生的地方。有兩個合成 OSC單元使
用正弦波、鋸齒波或其他基本波形產生聲音，就像模擬合成器一樣。

• Synth OSC：生成基本聲音並確定音高。
• 濾音器：切去一些頻率，調整音質。
• 放大器：調節音量。
• 三個 EG（包絡生成器）：
控制音高、音質、音量及其他參數隨時間的變化。

插圖所示為音量包絡的范例。

（2）合成器 OSC2單元

（3） PCM OSC1單元 此單元根據 PCM音（與 PCM音色類別中的聲音有相同的音質）產生聲音。有關此單元的可編
輯參數與上述 OSC單元差異的說明，請參閱“單元（1）至（6）的可編輯參數＂一節
（第 Ch-23頁）。（4） PCM OSC2單元

（5）外部輸入音單元
除了振盪器之外，此單元亦能根據從合成器的 cl MIC IN及 INST IN插孔輸入的聲音來產生聲
音。此單元產生的聲音的音高變化範圍是有限的。

（6）噪音單元
除振盪器之外，此單元亦根據由指定的噪音生成器產生的噪音創作聲音。此單元產生的聲音的

音高不能編輯。

（7）總單元 此單元混合訊號（1）至（6），並向濾音器及 DSP（一種音效）發送完成的音色。

（8） LFO1單元 “LFO＂是“low-frequency oscillator＂（低頻振盪器）的縮寫。LFO向用作變音、顫音及其他
回響音效基礎的各單元傳送波形訊息。

（9） LFO2單元

（10）控制器

控制器包含鍵盤、彎音輪及其他控制器，以及 MIDI訊息。控制訊息被傳送到單元（1）至
（9）以控制音色。
虛擬控制器功能可用於自由配置控制器類型（源）及受控制的參數（目標）的組合，以執行諸

如“踩踏板，改變音量＂等的操作。

音量

時間

擊鍵 延音 釋鍵 2

衰減 釋鍵 1
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■單元（1）至（6）的可編輯參數
• 九個滑鈕（5）與四個旋鈕（3）可用於快速簡單地調整下表中的一些參數（第 Ch-34頁）。

準備

從第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面開始執行下述操作。

1. 選擇“OSC Block >Ent＂後按 br ENTER進入組。

2. 用9 PART減（–）及加（+）鈕選擇要編輯的單元。

可編輯的參數列表

• 有陰影的單元格表示是由多個項目組成的組。按 br ENTER可顯示組成組的項目。
• 顯示項目的末尾的（V）表示可以選作單元（10）的虛擬控制器目標（第 Ch-29頁）的項目。

顯示的文字 說明 設定

OSC On Off OSC開 /關（OSC On/Off）。選擇關將禁用全體單元。 Off，On

Oscillator >Ent（僅限單元（1）至
（5））

振盪器（oscillator）。可編輯參數的組與合成器 OSC的音高，PCM OSC及音高
移位相關。
• 通過執行“如何編輯音色並保存為用戶音色＂一節（第Ch-20頁）中的第1步後
按住7 EDIT可進入此組。

Synth Wave 
（僅限單元（1）及（2））
PCM Wave
（僅限單元（3）及（4））

合成波（SYNTH WAVE），PCM波（PCM WAVE）。選擇由合成器 OSC或
PCM OSC生成的聲音的基本波。
• 顯示的名稱旁邊有“L＂或“B＂的波將以比實際音高低一個八度的音高發出。
對於“B＂波，按C5以上的鍵盤琴鍵不會有聲音發出。

• 有關各波形的詳細說明，請參閱另一冊“附錄＂。
• 單元（5）中沒有此項目。
• 用戶波形音色（User Wave）的分段可以作為PCM波形分配。用戶波形名由文
字“UserWave＂，後跟兩個由破折號分開的數字構成（例如：UserWave 
1-2）。破折號左邊的數字（本例中為1）是1至10的用戶編號或字母R（取樣循
環器的錄音資料）。破折號右邊的數字（本例中為2）是1至5的分段編號。若資
料中包含波形，則用戶波形名的開頭附有星號（*）。

參閱另一冊“附
錄＂。

Pitch (V) 音高（pitch）。在± 2個八度的範圍內調節最高與最低音高的值。–256設定降
低音高兩個八度，而 255設定升高音高兩個八度。

–256至 0至 +255

Detune (V) 解諧（detune）。調音的微調。 –256至 0至 +255

KeyFollow (V)

鍵間（key follow）。調節兩相鄰鍵盤琴鍵之間的音高變化。較高的數值代表較大
的變化。

例如﹕當鍵間的基音是鍵盤琴鍵的 C4時

–128至 0至 +127

Block
Syn1:Synth OSC1
Syn2:Synth OSC2
PCM1:PCM OSC1
PCM2:PCM OSC2
Ext:外部輸入
Noise:噪音

D4

C#4

C4

C4

Key Follow = 127

Key Follow = 64

Key Follow = 0

Key Follow = -127
C#4

Bb4 Key Follow

Key Follow Base
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KeyFolBase (V) 鍵間基音（key follow base）。該鍵盤琴鍵是鍵間的中心。
• 使用鍵盤琴鍵可以指定設定值。 C-至 G9*

Env.Depth (V) 包絡深度（envelope depth）。指定下示包絡如何起作用。 –64至 0至 +63

Envelope >Ent

音高包絡（envelope）。作用於合成器 OSC、PCM OSC及音高移位器的包絡
（Envelope Generator）的可編輯參數組。
• 下圖還作用於濾音器、放大器及其他包絡。對於音高包絡，聲音的音高對應於
垂直（Level）軸。

Init.Level (V) 初始音高（initial level）。初始音符開時聲音的音高。 –64至 0至 +63

Atk.Time (V) 擊鍵時間（attack time）。從初始音高到到達擊鍵音高所花的時間。 0至 127

Atk.Level (V) 擊鍵音高（attack level）。音符開後立即到達目標音高。 –64至 0至 +63

Dcy.Time (V) 衰減時間（decay time）。聲音從擊鍵音高到到達延音音高所花的時間。 0至 127

Sus.Level (V) 延音音高（sustain level）。按著琴鍵或踩著踏板時聲音延續的音高。 –64至 0至 +63

Rel.Time1 (V) 釋鍵時間 1（release time 1）。從琴鍵被鬆開到到達釋鍵音高 1所花的時間。 0至 127

Rel.Level1 (V) 釋鍵音高 1（release level 1）。琴鍵被鬆開後立即到達目標音高。 –64至 0至 +63

Rel.Time2 (V) 釋鍵時間 2（release time 2）。從釋鍵音高 1到達釋鍵音高 2所花的時間。 0至 127

Rel.Level2 (V) 釋鍵音高 2（release level 2）。琴鍵被鬆開後到達第二個目標音高。 –64至 0至 +63

Clk.Trig 時鐘觸發（clock trigger）。指定重設包絡的拍數。選擇 1/4U至 4U之間的設定
可重設上拍的時間。

Off, 1/4, 1/3, 1/2, 2/3, 
1, 3/2, 2, 3, 4, 1/4U, 
1/3U, 1/2U, 2/3U, 1U, 
3/2U, 2U, 3U, 4U

Ext.Trig（僅
限單元（5））

外部觸發（external trigger）。打開時，包絡被外部觸發重設。 Off，On

LFO1 Depth (V) LFO1深度（LFO1 depth）。指定單元（8）的 LFO1如何起作用。 –64至 0至 +63

LFO2 Depth (V) LFO2深度（LFO2 depth）。指定單元（9）的 LFO2如何起作用。 –64至 0至 +63

PulseWidth
（僅限單元（1）及（2））
（V）

脈衝寬度（pulse width）。當合成器的波是方形波時調節方形波的寬度。 0至 127

PWM LFO1 Dep
（僅限單元（1）及（2））
（V）

PWM LFO1深度（PWM LFO1 depth）。調節由 LFO1變音的脈衝的深度。

–64至 0至 +63

顯示的文字 說明 設定

IL

AL

SL RL1

RL2

AT DT RT1 RT2

Level

Time

IL : 初始音高 RT1 : 釋鍵時間 1
AT : 擊鍵時間 RL1 : 釋鍵音高 1
AL : 擊鍵音高 RT2 : 釋鍵時間 2
DT : 衰減時間 RL2 : 釋鍵音高 2
SL : 延音音高

PWM
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PWM LFO2 Dep
（僅限單元（1）及（2））
（V）

PWM LFO2深度（PWM LFO2 depth）。調節由 LFO2變音的脈衝的深度。 –64至 0至 +63

Sync OSC（僅限單元（2））
振盪器同步（Sync OSC）。打開此設定將根據單元（1）的聲波間隔重設單元
（2）的聲波，使其同步。 Off，On

OriginalKey（僅限單元（5））
（V）

原鍵（original key）。選擇鍵盤琴鍵，從外部向單元（5）輸入的聲音發出與該
琴鍵原音高相同的音高。
• 使用鍵盤琴鍵可以指定設定。

C-至 G9*

MicInstLvl（僅限單元（5））
（V）

麥克風 /樂器的音高（Mic/inst level）。從外部輸入單元（5）的聲音的音高。 0至 127

TrigThresh（僅限單元（5））
（V）

觸發閾值（trigger threshold）。指定決定外部輸入的觸發（第 Ch-24頁）是否
動作的外部輸入音高閾值。 0至 127

TrigRelease
（僅限單元（5））（V）

觸發釋放時間（trigger release time）。調節從外部輸入觸發（第 Ch-24頁）動
作後屏蔽下一次觸發動作的時間。 0至 127

P.ShiftMode（僅限單元
（5））

音高移位器模式（pitch shifter mode）。較大的設定值延長時間直到音符打開，
但會提高音質。此設定關閉時，無論按哪個鍵盤琴鍵音高相同。

Off, 1, 2, 3

P.ShiftMix（僅限單元（5））

音高移位器混頻（pitch shifter mix）。指定移位了音高的聲音（移位音）與未移
位音之間的音量比。

0: 僅音高移位的產生
7: 兩種聲音音量相同
15: 僅原音產生

0至 15

Noise Type（僅限單元（6））
噪音種類（noise type）。選擇單元（6）生成的噪音的種類。有白噪音（所有頻
率均等的噪音），粉噪音（與頻率成反比例的噪音）及其他種類的噪音。
• 另一冊“附錄＂中有噪音種類的完全列表。

參閱另一冊“附
錄＂。

Filter >Ent 濾音器（filter）。與各單元中的濾音器（音色）相關的可編輯參數組。

Gain 增益（gain）。指定高於下述截止頻率設定值的頻率的音量如何衰減。此處指定
為“Flat＂時不切除。

–18dB, –12dB, –6dB, 
–3dB, Flat

Cutoff (V) 截止頻率（cutoff frequency）。指定濾音器的截止頻率。 0至 15

TouchSense (V) 觸鍵感應（touch sense）。根據鍵盤彈奏時觸鍵力度的變化指定濾音器變化的程
度。

–64至 0至 +63

KeyFollow (V) 鍵間（key follow）。調節兩相鄰鍵盤琴鍵之間的濾音器變化量。較高的數值代表
較大的變化。

–128至 0至 +127

KeyFolBase (V) 鍵間基音（key follow base）。該鍵盤琴鍵是鍵間的中心。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

Env.Depth (V) 包絡深度（envelope depth）。指定下示包絡如何起作用。 –64至 0至 +63

Envelope >Ent

濾音器包絡（envelope）。作用於濾音器的包絡（Envelope Generator）可編輯
參數組。
• 有關組中項目及設定範圍的詳細說明請參閱“音高包絡＂一節。對於此組，音
高包絡圖中的垂直（Level）軸與濾音器如何動作相對應。

0至 127（初始音高
到釋放音高 2）
• 時鐘觸發及外部輸
入觸發的設定範圍
與音高包絡的相同。

LFO1 Depth (V) LFO1深度（LFO1 depth）。指定單元（8）的 LFO1如何起作用。 –64至 0至 +63

LFO2 Depth (V) LFO2深度（LFO2 depth）。指定單元（9）的 LFO2如何起作用。 –64至 0至 +63

Amp >Ent 放大器（Amp）。與各單元中的放大器（音量）相關的可編輯參數組。

Volume (V) 音量（volume）。指定放大器的音量。 0至 127

TouchSense (V) 觸鍵感應（touch sense）。根據鍵盤彈奏時觸鍵力度的變化指定音量變化的程
度。

–64至 0至 +63

KeyFollow (V) 鍵間（key follow）。調節兩相鄰鍵盤琴鍵之間的音量變化量。較高的數值代表較
大的變化。

–128至 0至 +127

KeyFolBase (V) 鍵間基音（key follow base）。該鍵盤琴鍵是鍵間的中心。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

顯示的文字 說明 設定
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* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

Envelope >Ent

放大器包絡（envelope）。作用於放大器的包絡（Envelope Generator）可編輯
參數組。
• 有關組中項目的詳細說明請參閱“音高包絡＂一節。音高包絡圖中的垂直
（Level）軸與此組中的音量相對應。但從初始音高到釋放音高2的九個項目的設
定範圍是0至127，與音高包絡的項目不同。

0至 127（初始音高
到釋放音高 2）
• 時鐘觸發及外部輸
入觸發的設定範圍
與音高包絡的相同。

LFO1 Depth (V) LFO1深度（LFO1 depth）。指定單元（8）的 LFO1如何起作用。 –64至 0至 +63

LFO2 Depth (V) LFO2深度（LFO2 depth）。指定單元（9）的 LFO2如何起作用。 –64至 0至 +63

Legato 連奏（Legato）。打開此設定能使隨後彈奏的音符更加平滑和連貫。 Off，On

Portamento 滑音（Portamento）。打開此設定能產生滑音效果。
• 單元（6）中沒有此項目。 Off，On

PortaTime (V) 滑音時間（Portamento Time）。指定滑音到達下一個音符的時間。
• 單元（6）中沒有此項目。 0至 127

顯示的文字 說明 設定
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■單元（7）：單元濾音器的全體可編輯參數

準備
在“如何編輯音色並保存為用戶音色＂一節（第 Ch-20頁）第 2步出現的畫面上，選擇“Total Filter >Ent＂後按 br ENTER進
入組。

可編輯的參數列表

• 有陰影的單元格表示是由多個項目組成的組。按 br ENTER可顯示組成組的項目。
• 顯示項目的末尾的（V）表示可以選作單元（10）的虛擬控制器目標（第 Ch-29頁）的項目。

* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

顯示的文字 說明 設定

FilterType

濾音器類型（filter type）。選擇濾音器的類型。
LPF: 低通濾音器。切去截止頻率以上的高頻率。
BPF: 段通濾音器。切去以截止頻率為中心的一個範圍之外的低音及高音頻率。
HPF: 高通濾音器。切去截止頻率以下的低頻率。

參照左側的單元格。

Cutoff (V) 截止頻率（cutoff frequency）。指定所有獨奏合成器音色的截止頻率。 0至 127

Resonance (V) 共鳴（resonance）。通過強調截止頻率附近的音符來改變音色。 0至 127

TouchSense (V) 觸鍵感應（touch sense）。根據鍵盤彈奏時觸鍵力度的變化指定濾音器變化的程度。 –64至 0至 +63

KeyFollow (V) 鍵間（key follow）。調節兩相鄰鍵盤琴鍵之間的濾音器變化量。較高的數值代表較大的變化。 –128至 0至 +127

KeyFolBase (V) 鍵間基音（key follow base）。該鍵盤琴鍵是鍵間的中心。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

Env.Retrig 包絡生成器觸發（envelope generator retrigger）。打開此設定後，各鍵盤琴鍵的按動都會觸發濾音
器。 Off，On

Env.Depth (V) 包絡深度（envelope depth）。指定下示包絡如何起作用。 –64至 0至 +63

Envelope >Ent
總濾音器包絡（envelope）。作用於總單元濾音器的包絡（Envelope Generator）可編輯參數組。
• 有關組中項目的詳細說明請參閱“音高包絡＂一節。對於此組，音高包絡圖中的垂直（Level）軸
與濾音器如何動作相對應。

0至 127（初始音高到釋
放音高 2）
• 時鐘觸發及外部輸入觸
發的設定範圍與音高包
絡的相同。

LFO1 Depth (V) LFO1深度（LFO1 depth）。指定單元（8）的 LFO1如何起作用。 –64至 0至 +63

LFO2 Depth (V) LFO2深度（LFO2 depth）。指定單元（9）的 LFO2如何起作用。 –64至 0至 +63
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■單元（8）：LFO1與單元（9）：LFO2可編輯參數

準備
從第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面開始執行下述操作。

1. 選擇“LFO >Ent＂後按 br ENTER進入組。

2. 用9 PART減（–）及加（+）鈕選擇要編輯的單元。

可編輯的參數列表

• 顯示項目的末尾的（V）表示可以選作單元（10）的虛擬控制器目標（第 Ch-29頁）的項目。

顯示的文字 說明 設定

WaveType

波形（wave type）。指定下列波形之一用於 LFO。

參照左側的單元格。

Sync

同步（sync）。指定同步的 LFO。
Off: 不同步
Tempo: 與由時鐘同步（下示）指定的拍子同步。
LFO1（只能與 LFO2同時選擇。）：與 LFO1同步。

參照左側的單元格。

Rate (V) 速率（rate）。指定 LFO的速度（頻率）。當上述同步（sync）設定關閉時此設定有效。 0至 127

Clk.Sync
時鐘同步（clock sync）。指定與 LFO頻率同步的拍數。選擇 1/4U至 4U之間的設定可與上拍的時
間同步。
• 只有當同步設定為“Tempo＂時此設定才有效。

1/4, 1/3, 1/2, 2/3, 1, 3/2, 
2, 3, 4, 1/4U, 1/3U, 1/2U, 
2/3U, 1U, 3/2U, 2U, 3U, 
4U

Depth (V) 深度（depth）。指定 LFO如何起作用。 0至 127

Delay (V) 延遲（delay）。指定 LFO作用的時機延遲的程度。 0至 127

Rise (V) 上升（rise）。指定從 LFO起作用開始到效果達到上述深度所指定的水平為止的時間。 0至 127

Mod.Depth (V) 變音深度（modulation depth）。指定變音如何作用於 LFO。 0至 127

Sin
（正弦波）

Puls 1:3
（方波 1:3）

Tri
（三角波）

Puls 2:2
（方波 2:2）

Saw up
（向上鋸齒波）

Puls 3:1
（方波 3:1）

Saw down
（向下鋸齒波）

Random
（隨機）
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■單元（10）：虛擬控制器的控制器可編輯參數
這些控制器是虛擬控制器，用於以任何輸入方式（源）調整任何可編輯的參數（目標）。

準備

從第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面開始執行下述操作。

1. 選擇“VirtualCtrl >Ent＂後按 br ENTER進入組。
• 控制器編號 1至 8，分配在5滑鈕（1/9至 8/16）上。

2. 用9 PART減（–）及加（+）鈕選擇要編輯控制器的編號。

可編輯的參數列表

■其他可編輯的項目
本節介紹還沒說明的單元部分的參數。這些設定不僅作用於獨奏合成器，還作用於其他類別的音色。

準備

顯示第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面。

可編輯的參數列表

• 有陰影的單元格表示是由多個項目組成的組。按 br ENTER可顯示組成組的項目。

顯示的文字 說明 設定

Source

源（source）。指定輸入方式。
Off: 無
CC00至 CC97：MIDI控制變化 *
NoteOnKeyNum：MIDI音符開訊息的鍵編號
NoteOnVel：MIDI音符開訊息的速率值
Ch.Pressure：MIDI觸後頻道
Bend Up：從 bt BENDER中央的向上操作
Bend Down：從 bt BENDER中央的向下操作
Modulation：bt MODULATION操作
LFO1：LFO1（單元（8））
LFO2：LFO2（單元（9））

• 有關各設定的詳細說明，請參閱MIDI執行文件（http://world.casio.com/）及其他MIDI文件。

參照左側的單元格。

Depth 深度（depth）。指定虛擬控制器如何起作用。 –128至 0至 +127

Dest 目標（destination）。指定虛擬控制器操作的目標參數。

• Off
• 其“顯示的文字＂項目
的後面有“（V）＂的單
元（1）至（9）的參
數（第Ch-23至
Ch-28頁）。

• DSP參數
（第Ch-100頁）

顯示的文字 說明 設定

DSP On/Off（僅
限非獨奏合成器
的音色）

DSP開 /關（DSP on/off）。指定 DSP是否應作用於音色。
• 此設定打開時，按br ENTER可進入DSP編輯畫面（第Ch-39頁）。
• 此項目不在獨奏合成器的音色編輯列表中。

Off，On

DSP Edit >Ent
DSP編輯（DSP Edit）。可編輯音效功能的 DSP組（第 Ch-36頁）。按 br ENTER進入 DSP編
輯畫面。
當上述 DSP開 /關設定為關時無效。

Volume 音量（volume）。指定主音量。 0至 127

Rev.Send 回響傳送。指定回響（第 Ch-36頁）如何作用於音色。 0至 127

Cho.Send
（僅限非獨奏合
成器的音色）

合唱傳送。指定合唱（第 Ch-36頁）如何作用於音色。
• 此項目不在獨奏合成器的音色編輯列表中。 0至 127
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有兩種參數：PCM旋律音色特定的可編輯參數，以及作用於其他音色類別的相同參數。
PCM音色中的鼓音組有不同的可編輯參數。有關詳細說明請參閱“鼓音 PCM音色的可編輯參數＂一節。

■非鼓音組 PCM音色的可編輯參數

準備
顯示第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面。

可編輯的參數列表

■與其他音色類別共通的可編輯參數
請參閱第 Ch-29頁上的“其他可編輯的項目＂一節。

PCM旋律音色（非鼓音 PCM音色）的可編輯參數

顯示的文字 說明 設定

Atk.Time 擊鍵時間（attack time）。指定從音符開開始到到達峰值的時間。 –64至 0至 +63

Rel.Time 釋鍵時間（release time）。指定鬆開琴鍵後延續音衰減的時間。 –64至 0至 +63

Cutoff 截止頻率（cutoff frequency）。指定音色的截止頻率。 –64至 0至 +63

Vib.Type 顫音種類（vibrato type）。指定下列波形之一用於顫音。
Sin（正弦波），Tri（三角波），Saw（鋸齒波），Sqr（方波）

Sin, Tri, Saw, Sqr

Vib.Depth 顫音深度（vibrato depth）。指定顫音如何起作用。 –64至 0至 +63

Vib.Rate 顫音速率（vibrato rate）。指定顫音速度（頻率）。 –64至 0至 +63

Vib.Delay 顫音延遲（vibrato delay）。指定顫音作用時機的延遲。 –64至 0至 +63

Oct.Shift 八度移位（octave shift）。以八度為單位改變音符的音色。 –2至 0至 +2

TouchSense 觸鍵感應（touch sense）。根據鍵盤彈奏時觸鍵力度的變化指定音量變化的程度。 –64至 0至 +63
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此處介紹的可編輯參數用於鼓音組音色。有兩種參數：PCM鼓音音色特定的可編輯參數，以及作用於其他音色類別的相同參數。

■鼓音組 PCM音色的可編輯參數

準備

顯示第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面。

可編輯的參數列表
• 有陰影的單元格表示是由多個項目組成的組。按br ENTER可顯示組成組的項目。

鼓音 PCM音色的可編輯參數

顯示的文字 說明 設定

Inst Edit >Ent

樂器編輯（instrument edit）。各鍵盤鼓音色的可編輯參數組
• 按一個鍵盤琴鍵指定要編輯的鍵盤。
• 通過執行“如何編輯音色並保存為用戶音色＂一節（第Ch-20頁）中的
第1步後按住7 EDIT可進入此組。

（C-至 G9*）

Inst Select >Ent

樂器選擇（instrument select）。音色的可編輯參數組。按鍵盤琴鍵的力
度（速率）分解為四個速率段。各段可以配置為不同音色（樂器編號）
的聲音。
• 用9 PART減（–）及加（+）鈕選擇要編輯的範圍。

Inst Number

樂器編號（instrument number）。選擇分配到各速率段的鼓音波。
• 有關各波形的詳細說明，請參閱另一冊“附錄＂。
• 用戶波形音色（User Wave）的分段可以作為樂器編號分配。用戶波形
名由文字“UserWave＂，後跟兩個由破折號分開的數字構成（例如：
UserWave 1-2）。破折號左邊的數字（本例中為1）是1至10的用戶編
號或字母R（取樣循環器的錄音資料）。破折號右邊的數字（本例中為
2）是1至5的分段編號。若資料中包含波形，則用戶波形名的開頭附有
星號（*）。

參閱另一冊“附
錄＂。

VelRangeHi 速段高（velocity range high）。決定各速率段的高限。 0至 127

Volume 音量（volume）。指定鼓音的音量。 –128至 0至 +127

Pan 立體音位（pan）。指定鼓音的立體聲的位置。 –64至 0至 +63

Rev.Send 回響傳送。指定回響如何作用於鼓音音色。 0至 127

NoteOffMode 音符關模式（note off mode）。若打開此設定，則鬆開琴鍵時音符關執
行。 Off，On

Assign Grp 分設組（assign group）。指定目前所選鍵盤應放入 1至 15中的哪個組。
一個組中只有一個鍵盤隨時產生聲音（排他發聲）。 Off, 1至 15

Pitch LFO >Ent 音高 LFO（pitch LFO）。作用於音高的可編輯 LFO組。

WaveType
波形（wave type）。指定 LFO使用的波形。可選擇的波的詳情與“單元
（8）：LFO1與單元（9）：LFO2可編輯參數＂的“WaveType＂
（第 Ch-28頁）相同。

Sin, Tri, SawUp, 
SawDown, Puls1:3, 
Puls2:2, Puls3:1

Rate 速率（rate）。指定 LFO的速度（頻率）。 0至 127

Depth 深度（depth）。指定 LFO如何起作用。 –128至 0至 +127

Delay 延遲（delay）。指定 LFO作用的時機延遲的程度。 0至 127

Rise 上升（rise）。指定從 LFO起作用開始到效果達到上述深度所指定的水平
為止的時間。 0至 127

Mod.Depth 變音深度（modulation depth）。指定變音如何作用於 LFO。 0至 127

Inst Number

[1] [2] [3] [4] 不能指定。

1段 2段 3段 4段

0

Velocity Range Hi

[1] [2] [3] [4] 127 Velocity
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* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

■與其他音色類別共通的可編輯參數
有關獨奏合成器音色的說明，請參閱第 Ch-29頁上的“其他可編輯的項目＂一節。

用戶波形音色有兩種可編輯參數：用戶波形音色類別專用的可編輯參數與亦適用於其他音色類別的參數。

■用戶波形音色類別的專用音色參數

準備
顯示第 Ch-20頁上“如何編輯音色並保存為用戶音色＂一節第 2步中的畫面。

可編輯的參數列表
• 有陰影的單元格表示是由多個項目組成的組。按 br ENTER可顯示組成組的項目。

After Depth 後深度（after depth）。指定當 MIDI頻道觸後感應接收到時 LFO的變
化。 0至 127

Amp LFO >Ent 放大器 LFO（amp LFO）。作用於音量的可編輯 LFO組。組中項目及設
定範圍與上述“LFO（音高 LFO）＂相同。

參照左側的單元格。

用戶波形音色的可編輯參數

顯示的文字 說明 參數

Split Edit >Ent 分段編輯（split edit）。用取樣循環器分段錄音的可編輯參數組。
• 用9 PART減（–）及加（+）鈕切換分段。

Volume 音量（volume）。指定音量。 0至 127

Pan 立體音位（pan）。指定聲音的立體聲的位置。 –64至 0至 63

CoarseTune 粗調（coarse tune）。以半音為單位改變音符的音高。 –24至 0至 24

Fine Tune 微調音（fine tune）。微調聲音的音高。數值以半音為單位最多降低 –256或最多升高
+255。

–256至 0至 255

CutOff 截止頻率（cutoff frequency）。指定用戶波形音色的截止頻率。 0至 127

TouchSense 觸鍵感應（touch sense）。根據鍵盤彈奏時觸鍵力度的變化指定音量變化的程度。 –64至 0至 63

KeyFollow 鍵間（key follow）。調節兩相鄰鍵盤琴鍵之間的音高變化。較高的數值代表較大的變化。 –128至 0至 127

KeyFolBase 鍵間基音（key follow base）。該鍵盤琴鍵是鍵間的中心。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

P.Env.Depth 音高包絡深度（pitch envelope depth）。指定包絡如何作用於音高。 –64至 0至 63

Pitch Env >Ent 音高包絡（envelope）。作用於音高的包絡（Envelope Generator）的可編輯參數組。

Init.Level 初始音高（initial level）。初始音符開時聲音的音高。 –64至 0至 63

Atk.Time 擊鍵時間（attack time）。從初始音高到到達 0音高所花的時間。 0至 127

Rel.Time 釋鍵時間（release time）。從琴鍵被鬆開到到達釋鍵音高所花的時間。 0至 127

Rel.Level 釋鍵音高（release level）。琴鍵被鬆開後立即到達目標音高。 –64至 0至 63

Amp Env >Ent

放大器包絡（envelope）。作用於放大器的包絡（Envelope Generator）的可編輯參數
組。
• 有關組中項目的詳細說明請參閱“音高包絡＂一節（第Ch-24頁）。音高包絡圖中的垂直
（Level）軸與此組中的音量相對應。但從初始音高到釋放音高2的九個項目的設定範圍是
0至127，與音高包絡的項目不同。但請注意，在用戶音色的“Amp Env >Ent＂選單上沒
有時鐘觸發這一項。

0至 127（初始音高
到釋放音高 2）
• 外部輸入的觸發範圍
與“音高包絡＂相
同。

KeyRangeLow 鍵區低（key range low）。設定分段播放的有效鍵盤的低音區。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

KeyRangeHi 鍵區高（key range high）。設定分段播放的有效鍵盤的高音區。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

OriginalKey 原鍵（original key）。指定照原樣分段播放的鍵盤。
• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

顯示的文字 說明 設定
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* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

■與其他音色類別共通的可編輯參數
有關獨奏合成器音色的說明，請參閱第 Ch-29頁上的“其他可編輯的項目＂一節。

Points >Ent 點（points）。改變分段的開始點，循環點及結束點的位置。

Start

開始點（start point）。一個分段的全體錄音長度是下圖所示數值。通過改變其第一個數字
可以改變分段的開始點。
• 使用bq 數字鈕（0至9）可輸入分段開始點的值。
• 您還可以用br減（–）及加（+）鈕改變數值最左邊的三位數。

例如：將第一個點的數值從 100000改變為 125000將使開始點移動到循環中的一個位
置。

0至 205000
（立體聲錄音），

0至 410000
（單聲道錄音）

Loop
循環點（loop point）。與開始點一樣，循環點的位置亦可以改變。
• 使用bq數字鈕（0至9）可輸入分段循環點的值。
• 您還可以用br減（–）及加（+）鈕改變數值最左邊的三位數。

0至 205000
（立體聲錄音），
0至 410000
（單聲道錄音）

End
結束點（end point）。與開始點一樣，結束點的位置亦可以改變。
• 使用bq數字鈕（0至9）可輸入分段結束點的值。
• 您還可以用br減（–）及加（+）鈕改變數值最左邊的三位數。

0至 205000
（立體聲錄音），

0至 410000
（單聲道錄音）

Pitch LFO >Ent 音高 LFO（pitch LFO）。作用於音高的 LFO的可編輯參數組。此組中的參數的設定範圍
與“鼓音組 PCM音色的可編輯參數＂（第 Ch-31頁）的音高 LFO相同。

參照左側的單元格。

Amp LFO >Ent 放大器 LFO（amp LFO）。作用於音量的 LFO的可編輯參數組。此組中的參數的設定範圍
與“鼓音組 PCM音色的可編輯參數＂（第 Ch-31頁）的放大器 LFO相同。

參照左側的單元格。

顯示的文字 說明 參數

開始點 循環點 結束點

100000 150000 200000
125000
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在演奏過程中，您可以使用踏板、彎音輪或其他裝置及時改變
音符的音高及音量、包絡及其他參數。

踏板操作可用於延長音符、琶音（第 Ch-40頁）或樂句
（第 Ch-45頁），或產生柔音效果。
• 有關連接踏板的說明請參閱第 Ch-8頁。
• 在演設編輯列表中執行下述操作能指定踏板操作產生的效
果。Controller >Ent 3 Pedal。有關詳情請參閱
第 Ch-74頁。

bt BENDER輪可用於平滑地上下改變聲音的音高，而 bt 
MODULATION輪在聲音上追加顫音（變音效果）。

• 打開合成器的電源時不要讓任何輪轉動。
• 通過在演設編輯列表中配置下列設定可以控制 bt BENDER
輪的彎音範圍∶ BendRngDwn, BendRngUp
（第 Ch-73頁）。

四個3 ASSIGNABLE KNOBS可分配功能，使聲音的擊鍵
時間及其他包絡參數（第 Ch-21頁）、音量等能立即調整。

• 下面介紹各區段聲部 1音色類別的各旋鈕功能。

獨奏合成器音色（第 Ch-23頁）。

PCM旋律音色（第 Ch-30頁）

PCM鼓音音色（第 Ch-31頁）

用戶波形音色（第 Ch-32頁）

上述功能在音色模式畫面上以縮寫名表示。

• 在演奏模式中，通過在演設編輯列表（第 Ch-74頁）上執行
下述操作，可以改變分配在分設旋鈕上的操作： 
Controller >Ent 3 K1至 K4。

用九個滑鈕（5）可以對獨奏合成器振盪器、包絡及總濾音
器 /LFO參數進行簡單的調整。

1. 選擇一個獨奏合成器的音色。

2. 用1鈕將振盪器（OSC BLOCK）、包絡（ENV 
GENERATOR）或總濾音器 /LFO（TOTAL 
FILTER/LFO）參數分配到滑鈕上。

3. 用三個2鈕執行下述操作之一。

聲音的控制

踏板的使用

輪（彎音，變音）的使用

bt

分設旋鈕的使用

3

K1 : 虛擬控制器 1（第 Ch-29頁）
K2 : 虛擬控制器 2（第 Ch-29頁）
K3 : 虛擬控制器 3（第 Ch-29頁）
K4 : 虛擬控制器 4（第 Ch-29頁）

K1 : 截止頻率
K2 : 擊鍵時間
K3 : 釋鍵時間
K4 : 回響傳送（與其他音色類別相同。）

升高或降低音高。
（鬆開輪可返回原
音高。）

產生變音。
（提升輪產
生變音。）

K1 : 音量（Drum Inst >）
K2 : 立體音位（Drum Inst >）
K3 : 回響傳送（Drum Inst >）
K4 : 回響傳送（與其他音色類別相同。）

K1 : 截止頻率
K2 : 擊鍵時間（Amp Envelope >）
K3 : 釋鍵時間（Amp Envelope >）
K4 : 回響傳送（與其他音色類別相同。）

滑鈕的使用

Y若您在第 2步選擇了 OSC BLOCK（振盪器）
按2 SELECT OSC循環選換 OSC單元（1至 6）與
“ALL＂（所有 OSC單元），選擇所需要的一個。

Y若您在第 2步選擇了 ENV GENERATOR（包絡）
• 按2 SELECT OSC循環選換OSC單元（1至 6）與
“ALL＂（所有 OSC單元），選擇所需要的一個。

• 按2 SELECT EG循環選換 EG單元（OSC，濾音
器，放大器，“ALL＂（所有 EG單元）），選擇所需
要的一個。

Y若您在第 2步選擇了 TOTAL FILTER/LFO（總濾音器 /
LFO）
按2 SELECT LFO選換 LFO1, LFO2及“ALL＂
（LFO1與 LFO2）。
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4. 移動滑鈕（5）調節其分配的參數。
• 有關分配在滑鈕上的參數的資訊請參照下表。有關各參數的詳細說明，請參閱表中的參考頁號。

• 在演奏模式或步音序器模式中，可以使用1鈕編輯用滑鈕的音色，而不用進入其他模式。

• PCM音色及用戶波形音色不能用滑鈕調整。
• 有關滑鈕功能的詳細說明，步音序器模式請參閱第 Ch-52頁，而混頻器模式請參閱第 Ch-78頁。

1鈕 5(滑鈕) 顯示的文字 參數 參閱頁號：

OSC BLOCK

1/9 OSC ON/OFF OSC Block > OSC On/Off Ch-23

2/10 WAVE
OSC Block > Oscillator > Wave（對於Ext OSC無效。）
• 有關用滑鈕能選擇的波形的種類的說明請參閱另一冊“附錄＂。

Ch-23

3/11 PITCH OSC Block > Oscillator > Pitch（對於Noise OSC無效。） Ch-23

4/12 DETUNE OSC Block > Oscillator > Detune（對於Noise OSC無效。） Ch-23

5/13 PORTA TIME OSC Block > PortaTime Ch-26

6/14 P.ENV DEPTH OSC Block > Oscillator > Env.Depth（對於Noise OSC無效。） Ch-24

7/15 CUTOFF OSC Block > Filter > CutOff Ch-25

8/16 F.ENV DEPTH OSC Block > Filter > Env.Depth Ch-25

MASTER VOLUME OSC Block > Amp > Volume Ch-25

ENV GENERATOR

1/9 INIT LEVEL
• OSC Block > Oscillator/Filter/Amp > Envelope > Init.Level
• TotalFilter > Envelope > Init.Level Ch-24

2/10 ATK TIME
• OSC Block > Oscillator/Filter/Amp > Envelope > Atk.Time
• TotalFilter > Envelope > Atk.Time Ch-24

3/11 ATK LEVEL
• OSC Block > Oscillator/Filter/Amp > Envelope > Atk.Level
• TotalFilter > Envelope > Atk.Level Ch-24

4/12 DCY TIME
• OSC Block > Oscillator/Filter/Amp > Envelope > Dcy.Time
• TotalFilter > Envelope > Dcy.Time Ch-24

5/13 SUS LEVEL
• OSC Block > Oscillator/Filter/Amp > Envelope > Sus.Level
• TotalFilter > Envelope > Sus.Level Ch-24

6/14 REL TIME1
• OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Time1
• TotalFilter > Envelope > Rel.Time1 Ch-24

7/15 REL LEVEL1
• OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Level1
• TotalFilter > Envelope > Rel.Level1 Ch-24

8/16 REL TIME2
• OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Time2
• TotalFilter > Envelope > Rel.Time2 Ch-24

MASTER REL LEVEL2
• OSC Block > Oscillator/Filter/Amp > Envelope > Rel.Level2
• TotalFilter > Envelope > Rel.Level2 Ch-24

TOTAL FILTER/LFO

1/9 TOTAL FILTER TYPE TotalFilter > FilterType Ch-27

2/10 TOTAL FILTER CUTOFF TotalFilter > CutOff Ch-27

3/11 TOTAL FILTER RESONANCE TotalFilter > Resonance Ch-27

4/12 TOTAL FILTER ENV.DEPTH TotalFilter > Env.Depth Ch-27

5/13 LFO WAVE LFO > WaveType Ch-28

6/14 LFO RATE LFO > Rate（僅對Sync Off有效。） Ch-28

7/15 LFO DEPTH LFO > Depth Ch-28

8/16 LFO DELAY LFO > Delay Ch-28

MASTER LFO RISE LFO > Rise Ch-28

XWG1_ch.book  Page 35  Wednesday, January 18, 2012  10:34 AM



音色的選擇及創作

Ch-36

當 bn HOLD鈕點亮（通過按下）時，目前產生的音符或琶音
（第 Ch-40頁）延續。

• 再次按 bn HOLD將使其熄滅，表示保持功能已關閉。

用 bs TRANSPOSE及 OCTAVE（–, +）鈕能以半音或八度
為單位改變鍵盤音符的音高。
• 有關以赫茲為單位微調音高（調音）的說明請參閱
第 Ch-81頁。

1. 要以半音為單位改變音高時，請按住 bs 
TRANSPOSE鈕的同時按 bs OCTAVE減（–）或
加（+）鈕。
• 此操作的設定範圍為上下一個八度（–12半音至 +12半
音）。

2. 要以八度為單位改變音高時，請用 bs OCTAVE減
（–）及加（+）鈕（不用按住 bs 
TRANSPOSE）。
• 此操作的設定範圍為上下三個八度（–3個八度至 +3個
八度）。

• 當上示設定畫面顯示時，可以用 bp旋鈕或 br減（–）或加
（+）鈕改變設定。若您不進行任何操作經過一段時間，設
定畫面自動結束。

音符上可以添加回響、顫音及其他音效，提高聲音的效果。

■音效單元圖

保持鈕的使用

bn

如何以半音為單位（移調）或以八度為單位（八
度移位）改變音符的音高

bs

HOLD打開時點亮。

bs

如何為音符添加音效

音源 （5）主均衡器

通過（2）、（3）或
（4）。亦請參考下述
“合唱及 DSP的使用
限制＂。

輸出
（1）回響

（2）合唱

（3）標準 DSP

（4）獨奏合成器
DSP
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* 當不是獨奏合成器音色的帶 DSP的音色（使用特定 DSP的音色）被選擇時。在混頻器畫面（第 Ch-78頁）或演奏編輯畫面
（第 Ch-73頁）上，帶 DSP的音色的名稱旁邊有“DSP＂。

■合唱及 DSP的使用限制
三種音效類型（合唱、標準 DSP，獨奏合成器 DSP）中同時只能有一種有效。

1. 按住 bn EFFECT直到下示音效列表的頂部畫面出現。

（1）回響 添加回響可以使聲音像在室內或音樂廳中演奏的一樣。

（2）合唱 混合同一音符的多個疊加層可以創建更深的聲音。

（3）標準 DSP 多種多樣的標準 DSP音效有助於豐富音色的聲音。例如，電吉他的聲音可以添加失真效果，使其聲
音更有力。共有 46種不同的標準 DSP，最適合所選音色的一種會自動添加。* DSP可以編輯並保存
為用戶 DSP。

（4）獨奏合成器 DSP 組成獨奏合成器音色的元素之一。請參閱第 Ch-21頁上“獨奏合成器音色的可編輯參數＂一節中的
“（7）總單元＂。共有六種獨奏合成器 DSP。當您編輯一種獨奏合成器 DSP時，其作為獨奏合成器
用戶音色的一部分保存。不能保存為用戶 DSP。

（5）主均衡器 調節合成器音符的頻率特徵。主均衡器可用於調節四頻段的頻率及增益。低、中 1、中 2及高。

條件： 有效的音效類型： 各聲部添加音效的方式：

合唱模式
• 區段聲部 1選擇了樂曲音序器以外的音色，而“合唱 /

DSP選擇＂（第 Ch-38頁）選擇了合唱。

（2）合唱 依混頻器的合唱傳送值
（第 Ch-80頁）及選擇的音色的合唱
傳送值（第 Ch-29頁）而不同。

標準 DSP模式
• 區段聲部 1選擇了樂曲音序器以外的音色，而“合唱 /

DSP選擇＂（第 Ch-38頁）選擇了 DSP。

（3）標準 DSP （3）只作用於混頻器的 DSP線路
（第 Ch-80頁）為開的聲部上。

獨奏合成器音色模式
• 由區段聲部 1選擇的獨奏合成器音色。

（4）獨奏合成器 DSP （4）只作用於區段聲部 1及混頻器的
DSP線路為開的聲部上。

如何配置音效設定

bn

XWG1_ch.book  Page 37  Wednesday, January 18, 2012  10:34 AM



音色的選擇及創作

Ch-38

2. 然後，參照下表用 br對項目的選擇及設定的變更進行控制。

■音效設定

顯示幕 說明 設定

Rev Type 回響種類（reverb type）。回響音效的種類。 Type1, Type2

Rev Level 回響音量（reverb level）。回響音效的音量。 0至 127

Rev Time 回響時間（release time）。回響的持續時間。 0至 127

Cho Level 合唱音量（chorus level）。合唱音效的音量。 0至 127

Cho Rate 合唱速率（chorus rate）。合唱音效波動的速率。 0至 127

ChoSendRev 對回響的合唱傳送音量（chorus send level to reverb）。指定回響如何作用於有合唱音效
的全體聲音。 0至 127

Cho/DSP 合唱 /DSP選擇（Chorus/DSP）。選擇是使用合唱還是使用標準 DSP（“合唱及 DSP的
使用限制＂，第 Ch-37頁）。

Cho, DSP

DSP Select >Ent 顯示標準 DSP的主選擇畫面。
• 若區段聲部1選擇了獨奏合成器音色，則無法繼續操作。

（標準 DSP選
擇畫面）

為標準 DSP選擇預設或用戶音色使用與選擇音色相同的操作步驟。
• 另一冊“附錄＂中有預設標準DSP的列表。選擇“ton＂將使用各音色的初始預設DSP。
• 此畫面顯示過程中按7 EDIT可進入DSP編輯畫面（第Ch-39頁）。

ton
Preset: 0-0至 9-9
User: 0-0至 9-9

Master EQ >Ent 主均衡器設定組（第 Ch-36頁上“音效單元圖＂的項目（5））。

EQ Enable 關閉此設定會吏主 EQ設定無效。 Off，On

Low Freq 低頻段（low frequency band）。調節低頻段。 200 Hz，400 Hz， 
800 Hz

Low Gain 低頻增益（low gain）。調節低頻增益。 –12至 0*至 +12

Mid1 Freq 中 1頻段（mid 1 frequency band）。調節中 1頻段。 1.0 kHz至 5.0 kHz

Mid1 Gain 中 1增益（mid1 gain）。調節中 1頻段增益。 –12至 0*至 +12

Mid2 Freq 中 2頻段（mid 2 frequency band）。調節中 2頻段。 1.0 kHz至 5.0 kHz

Mid2 Gain 中 2增益（mid2 gain）。調節中 2頻段增益。 –12至 0*至 +12

High Freq 高頻段（high frequency band）。調節高頻段。 6.0 kHz，8.0 kHz，
10.0 kHz

High Gain 高頻增益（high gain）。調節高頻增益。 –12至 0*至 +12
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DSP根據效果分為 53種。預設標準 DSP的 0-0與 0-1為壓
縮型 DSP。共有兩種 DSP：標準 DSP專用類型與獨奏合成器
DSP專用類型。
在編輯或保存 DSP時，必須首先指定其類型，然後根據類型
進行編輯。

• 請參閱第 Ch-99頁上“DSP類型表＂中的 DSP類型列表。

1. 選擇要添加 DSP的音色。然後，在音色的編輯畫
面上選擇 DSP Edit >Ent（第 Ch-29 頁）後按 br 
ENTER顯示下示 DSP編輯畫面。
• 在編輯標準DSP時，按7 EDIT可以從標準DSP選擇畫
面（第 Ch-38頁）進入 DSP編輯畫面。

2. 用 bp旋鈕選擇 DSP類型編號。

3. 使用與音色編輯（第 Ch-20頁）相同的操作步驟在
畫面上選擇及配置 DSP參數。
• DSP的參數依 DSP類型而不同。有關詳情請參閱“DSP
參數列表＂（第 Ch-100頁）。

4. 編輯完 DSP後，如下所述進行保存。
按7 WRITE顯示保存用戶音色的畫面。資料保存為用戶
音色（第 Ch-12頁）。
• 若您是從第 1步中的標準 DSP選擇畫面（第 Ch-38頁）
進入 DSP編輯畫面
按7 WRITE顯示保存 DSP的畫面。使用與保存用戶
音色相同的操作步驟將編輯的 DSP保存為用戶 DSP。

■如何在外接裝置上保存用戶 DSP
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

編輯後的 DSP的保存

DSP類型編號：類型名

DSP參數
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琶音的自動產生

啟用琶音功能後，您只要在鍵盤上按琴鍵，其便會自動演奏出

各種琶音。您可以選擇各種不同的琶音類型進行播放，其中包

括使用組成您在鍵盤上彈奏和弦的音符的琶音，琶音還包括您
在鍵盤上彈奏組成和弦的音符時自動追加的音符等。

• 琶音功能有 100種琶音預設。一種預設可以編輯並保存為用
戶琶音。記憶器最多能保存 100種用戶琶音。

• 選擇琶音類型時可以使用下述功能。

1. 按住 bn ARPEGGIO直到下示琶音類型選擇畫面
出現。

2. 按 bq PRESET/USER選擇預設琶音或用戶琶音。
• 該鈕熄滅時表示選擇了預設琶音，而該鈕點亮時表示選
擇了用戶琶音。

3. 按 bq NUM/BANK鈕使該鈕閃動。
• bq NUM/BANK閃動過程中，bq（0至 9）鈕可用於輸
入庫編號。

4. 用 bq（0至 9）鈕選擇庫編號。
• 選擇庫編號將使 bq NUM/BANK停止閃動並熄滅。bq 

NUM/BANK熄滅過程中，bq（0至 9）鈕可用於輸入琶
音編號。

5. 用 bq（0至 9）輸入琶音編號。
• 旋轉 bp旋鈕亦能選擇琶音編號。
• 改變琶音編號的另一種方法是用 br減（–）及加（+）
鈕遞減或遞增顯示的琶音編號。同時按 br減（–）及
加（+）鈕可跳至目前所選類別中的第一個琶音編號
（參閱下一節）。

7 bn bp

br

5

bk

4

2

bq

保持（HOLD） : 鍵盤琴鍵被鬆開後琶音繼續演奏。這很有
用，例如用分割功能在鍵盤的一個聲部中
插入琶音時。

同步（SYNC） : 當鍵盤琴鍵被按下時，步音序器自動與琶
音功能同步演奏或停止。

如何使用琶音功能

琶音庫與編號

保持設定 同步設定

琶音名
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6. 選擇琶音保持或同步開 /關。
• 要打開保持功能（HOLD）時，請按 bk STEP +。按該
鈕可打開或關閉 HOLD。

• 要打開同步功能（SYNC）時，請用 bk STEP –選換下
述同步設定。

• HOLD與 SYNC設定是演奏參數。

7. 按一些琴鍵時琶音將自動開始演奏。
• 要關閉琶音功能時請再次按 bn ARPEGGIO。
• 要停止琶音的保持（HOLD）播放時，請按 bn 

ARPEGGIO或將上述操作第2步中的HOLD功能改變為
OFF。

■使用琶音類型選擇畫面可以選擇目前所選琶音類型的
建議音色作為區段聲部 1的音色。

1. 按住 bn ARPEGGIO直到琶音類型選擇畫面出現。

2. 按住7 EDIT直到 bn ARPEGGIO開始閃動後停止
閃動並點亮。
• 對於用戶琶音，當用戶資料被保存時，被選作區段聲部

1的音色是建議的音色。

共有兩種琶音：分步型與變奏型。
• 對於分步型琶音，可以編輯其步及其參數。分步型琶音最多
可以含有 16步。各步的下列值可以改變。

• 對於變奏型琶音，則只能編輯其參數。

1. 按住 bn ARPEGGIO直到下示琶音類型選擇畫面
出現。

2. 在預設或用戶琶音中選擇要編輯的琶音類型。
• 有關如何選擇琶音類型的說明，請參閱“如何使用琶音
功能＂一節（第 Ch-40頁）中的第 2至第 5步。

3. 按7 EDIT。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Step Edit＂，然後按 br 
ENTER。
• 若您在上述第 2步中選擇了一種變奏琶音，則“Step 

Edit＂選項不出現。

5. 用 bp旋鈕或 br減（–）及加（+）鈕改變 TYPE、
NOTE及 VELO 設定。
• 您還可以用41至 16鈕打開或關閉各步。
• 在 TYPE被選擇的情況下，用 br減（–）及加（+）鈕
可打開或關閉 TYPE設定。

• 用5（“MASTER＂之外的八個滑鈕）可以直接改變
相應的步值。使用滑鈕時，請按2 1-8/9-16選換第 1
至 8步（按鈕熄滅）及第 9至 16步（按鈕點亮）。但
請注意，當 TYPE為 TIE或 OFF時不能使用滑鈕。

• 您可以指定連音設定。有關詳情請參閱第 Ch-53頁上的
“如何配置連音符設定＂。

• 下表列出了琶音步編輯選單的內容。

OFF: 鍵盤琴鍵被鬆開時琶音演奏。
ON : 鍵盤琴鍵被鬆開後琶音將繼續演奏。

OFF: 同步設定已關閉。
ON : 琶音演奏只與步音序器的演奏同步。
S/S : 琶音演奏與步音序器的演奏及停止操作同步。

琶音的編輯

TYPE : 指定琶音型中的相對位置，各鍵盤音符將演奏。即
可以指定從最低的音符開始演奏（L1）的位置，亦
可以指定從最高的音符開始演奏（U1）的位置。甚
至可以指定同時演奏最多五個音符（P2至 P5）。

NOTE: 指定以半音為單位的相對移位，從在鍵盤上彈奏的
音符開始。

VELO : 指定音符的音量。

分步型

步數
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6. TYPE, NOTE及 VELO設定完成後，按 br EXIT返回琶音選單畫面。

7. 用 br向上（q）及向下（w）鈕將項目選擇游標（0）移動到“Parameter＂，然後按 br ENTER。

選單層
說明 設定

1 2

Step Edit >Ent

TYPE

指定琶音型中的相對位置，鍵盤音符將從最低音符（L1）開始演奏。
• 若按的琴鍵數少於類型（L）的設定數（例如，要演奏包含L1至L6設定的琶音型時只按三個鍵
盤琴鍵），琶音型將反覆，鍵盤琴鍵的音符將高八度演奏。

• 超出一個高八度的範圍時，琶音自動返回L1音符。

L1至 L8

指定琶音型中的相對位置，鍵盤音符將從最高音符（U1）開始演奏。
• 若按的琴鍵數少於類型（U）的設定數（例如，要演奏包含U1至U6設定的琶音型時只按三個鍵
盤琴鍵），琶音型將反覆，鍵盤琴鍵的音符將低八度演奏。

• 超出一個低八度的範圍時，琶音自動返回U1音符。

U1至 U8

指定從最高音符開始在鍵盤上的彈奏時有多少個音符同時產生。
• 當按下的琴鍵數少於此處指定的多重音（P）值時，只有彈奏的音符產生。 P2至 P5

NOTE 以半音為單位移位按鍵產生的音符。 –24至 +24

VELO 改變按鍵速率。 –64至 +63
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8. 用 bp旋鈕或 br減（–）及加（+）鈕改變參數設定。
• 下表列出了參數編輯選單的內容。

9. 編輯完琶音參數後，如下所述進行保存。
• 按7 WRITE顯示保存琶音資料的畫面。執行與保存用戶音色（第 Ch-12頁）相同的操作步驟保存琶音。
• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存琶音資料
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

選單層
說明 設定

1 2

Parameter >Ent

Max Step 最多步（Maximum step）。只能由步種類進行編輯。 1至 16

Step Size 步大小（Step size）。指定步間的音符長度。 2, 6, , 7, , 8

NoteLngth
音符長度（Note length）。指定作為步大小的百分比演奏的音
符的長度。（與原音長度相同時為 100%，為原音的一半時為
50%。）

1至 100%

Groove 槽（Groove）。指定上拍步的時機。（相等為 50%。較大的數
值加長音符前半部分的長度。） 10至 90%

Grv.Type 槽類型（Groove type）。指定當槽設定不是 50%時的音符長
度。

Norml: 以步長度的實際百分比播放。
Short: 根據步的變化調整為短步。

Velocity 速率（Velocity）。指定輸入琶音的速率。指定 KeyOn將根據
擊鍵力度輸入速率值。 KeyOn, 1至 127

Hold Pedal 踏板保持（Hold pedal）。指定是否保持踏板。 On, Off
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使用下述操作步驟可以清除預設步資料或用 Step Edit
（第 Ch-42頁）編輯的步資料，以及從零開始建立的新步資
料。

• 請注意，變奏類型的資料不能清除。

1. 按住 bn ARPEGGIO直到下示類型選擇畫面出現。

2. 在預設或用戶琶音中選擇要清除的琶音類型。
• 選擇琶音類型的操作步驟與選擇音色（第 Ch-19頁）的
相同。

3. 按7 EDIT。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Clear Step＂，然後按 br 
ENTER。

5. 再次按 br ENTER。
此時“Clear?＂應出現在畫面上。

6. 按 br YES。
資料被清除時“Complete!＂訊息將出現在畫面上。

琶音資料的清除
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樂句的錄音及播放

要記錄您突然浮現在腦海中的樂句並在以後播放時樂句音序器

很方便。

• 音序器有 100個預設樂句。
• 通過新記錄樂句或覆蓋已有樂句都能創建用戶樂句。記憶器
最多能儲存 100個用戶樂句，以後需要時可隨時調用。

• 除了您在鍵盤上彈奏的之外，踏板、輪及旋鈕操作亦被錄製
為樂句的一部分。

• 有兩種不同的播放選項供您選擇：一次播放（不循環）或
反覆播放（循環）。

• 在循環播放過程中可以覆蓋錄音。您亦可以暫時取消覆蓋錄
音，只進行循環播放。

• 按一個鍵盤琴鍵可從相應的音高（彈奏的琴鍵）開始播放
樂句。

1. 按住 bo KEY PLAY直到下示預設樂句選擇畫面出
現。

2. 選擇要播放的樂句的編號。
• 要選擇樂句編號時，請執行“如何使用琶音功能＂一節
（第 Ch-40頁）中的第 2至第 5步操作。

3. 按 bk STEP +可打開或關閉循環。

4. 按 bk STEP –可打開或關閉保持。

5. 按 bo PLAY/STOP開始樂句的播放。
• 若樂句被循環，則當播放返回樂句的開頭時 bo PLAY/

STOP燈將熄滅片刻進行表示。
• 您亦可以使用上述操作播放用戶樂句。
• 樂句循環及保持設定作為各樂句的參數保存。

7 bo

bq

br

bk

如何播放預設

樂句編號

循環設定 保持設定

樂句名

OFF:一次播放
ON :循環播放

OFF:只有在按著 bo PLAY/STOP時樂句才播放，鬆開
按鈕時停止。

ON :樂句播放在 bo PLAY/STOP被按下時開始，而在
bo PLAY/STOP被再次按下時停止。
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共有兩種方法可用於改變速度設定：用 TEMPO鈕或用按鈕敲
拍。

• 使用本操作不僅能調節樂句的速度，還能調節其他功能的速
度。

■如何用 TEMPO鈕改變速度

1. 按8 TEMPO –（更慢）或8 TEMPO +（更快）
鈕。
• 下示速度畫面出現。

• 若您不進行任何操作經過數秒鐘，顯示幕將自動返回前
一幅畫面。

2. 用8 TEMPO –, +鈕改變速度（每分鐘的拍數）。
• 按住其中一鈕或轉動旋鈕可高速選換速度值。
• 速度值可在 30至 255之間指定。

3. 按 br EXIT鈕。
• 電子琴退出速度畫面。

■如何通過敲拍來調節速度

1. 以要設定的速度點擊8 TAP鈕四次。

• 您敲擊四次後，速度設定將立即根據您敲擊的速度改
變。

2. 通過敲擊設定了速度之後，您可以使用“如何用
TEMPO鈕改變速度＂一節（第 Ch-46頁）中的
操作進行微調。

1. 按住 bo KEY PLAY直到樂句選擇畫面出現。

2. 按住7 EDIT直到 bo KEY PLAY開始閃動。
• 對於用戶樂句，當用戶資料被保存時，被選作區段聲部

1的音色是建議的音色。

1. 按 bo KEY PLAY使該鈕點亮。

2. 按鍵盤琴鍵開始播放樂句。
• 若您為開始樂句播放而按的琴鍵比樂句的原音高高或
低，則樂句將以所按琴鍵的音高播放。

• 在保持設定被關閉的狀態下，只有當鍵盤琴鍵被按下時
樂句才播放，琴鍵被鬆開時停止。在保持設定被打開的

狀態下，鍵盤琴鍵被按下時樂句開始播放，直到 bo 
PLAY/STOP鍵被按下為止播放不停止。

• 使用“PhrKeyRgLo＂及“PhrKeyRgHi＂設定可以指
定能進行琴鍵彈奏（第 Ch-75頁）的鍵盤區的高點與
低點。

如何改變速度設定 使用樂句選擇畫面可以選擇目前所選樂句的建議
音色作為區段聲部 1的音色。

如何通過按鍵盤琴鍵開始樂句的播放
（琴鍵彈奏）
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除了您在鍵盤上彈奏的之外，踏板、旋鈕有輪操作亦被錄製在
樂句中。

• 一個樂句最多能錄音約 1,600音符。錄音輪及旋鈕操作會顯
著地削減能錄音的音符數。

1. 按 bo REC。
這將使 bo REC燈閃動。
• 若“Rec Mode＂設定顯示為 OVDB（覆蓋錄音），請
用 br減（–）及加（+）鈕將其改變為 NEW（新樂
句）。此時進入新樂句錄音待機模式。

• 結束量化及音符量化設定可以根據需要配置。

■結束量化（End Qntz）
當您執行按鈕操作結束一段新樂句的錄音時，結束時機可能是

錯誤的。下述結束量化設定用於自動校正結束點的時機，使其

位置更加自然。

■音符量化（Note Qntz）
錄音鍵盤彈奏時，您彈奏的時機有可能會有點偏離。下述音符

量化設定可用於自動校正鍵盤演奏的時機，以及校正在鍵盤上

彈奏的音符的時機。（請注意，只有按下的琴鍵的時機被校
正。鬆開琴鍵、輪、踏板及旋鈕等其他操作的時機不能校

正。）

• 按 br MENU可顯示下述詳細設定的選單。用 br向上
（q）及向下（w）鈕選擇參數，然後用 br減（–）
及加（+）鈕改變其設定。

2. 當您按 bo REC時，或當您通過進行踏板、旋鈕或
輪操作或在鍵盤上按鍵來開始演奏時錄音開始。
錄音開始時 bo REC點亮。

3. 錄音到達要停止的點時按 bo PLAY/STOP。
bo REC熄滅，而“!TEMP＂（暫時）出現在樂句編號
處。
• 在上述第 3步不按 bo PLAY/STOP，而按 bo REC可停
止錄音，暫時進入覆蓋錄音待機模式，同時您錄音的樂

句開始循環播放。有關覆蓋錄音的詳細說明請參閱“如
何錄音在另一個樂句上（覆蓋錄音）＂一節

（第 Ch-48頁）。

4. 錄音完畢後如下所述進行保存。
• 按7 WRITE顯示保存樂句的畫面（第 Ch-49頁）。
• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存樂句
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

新樂句的錄音

Off : 未調整的樂句結束點的時機。
1M: 樂句結束點被調整到小節單位位置。
2 : 樂句結束點被調整到四分音符單位位置。
6 : 樂句結束點被調整到八分音符單位位置。

Off : 時機不調整。（音符在演奏過程中被錄
音。）

6, , 7, : 實際的鍵盤彈奏的時機根據指定的音符
單位被校正為最近的音符。

選單 說明 設定範圍

Guide
引導音（Guide tone）。指定
在樂句錄音及 /或錄音待機過
程中計數音是否產生。

Off，On

Precount
預計數（Precount）。指定在
用按鈕操作觸發樂句錄音開始
之前，插入的計數小節數。

Off，
1:1小節，
2:2小節

Beat
拍子（Beat）。指定使用
Guide，Precount或結束量化
1M時的拍子。

2/4至 8/4，
2/8至 16/8
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通過按鍵盤琴鍵開始樂句的播放（第 Ch-46頁）時，若您按
的琴鍵是樂句中錄音的第一個音符，則樂句資料將以原錄音時

的音調（原調）播放。
樂句資料的設定可用於指定以原錄音音符進行播放，即使按的

鍵盤琴鍵不是原樂句資料中的音符。名樂句都有一個音調移位

（Key Shift）設定，可用於以半音為單位改變原調的音高。

1. 按住 bo KEY PLAY直到樂句選擇畫面出現。

2. 選擇要配置其設定的樂句編號。
• 要選擇樂句編號時，請執行“如何使用琶音功能＂一節
（第 Ch-40頁）中的第 2至第 5步操作。

3. 按7 EDIT。

4. 用 br向上（q）及向下（w）鈕選擇參數，然

後用 bq或 br 減（–）及加（+）鈕改變其設
定。

* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

5. 設定完畢後如下所述進行保存。
• 按7 WRITE顯示保存樂句的畫面（第 Ch-49頁）。
• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存樂句
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

1. 選擇要覆蓋錄音的樂句。
• 要選擇樂句編號時，請執行“如何使用琶音功能＂一節
（第 Ch-40頁）中的第 2至第 5步操作。

2. 按 bo REC。
這將使 bo REC閃動。
• 若“Rec Mode＂設定顯示為 NEW（新樂句），請用 br
減（–）及加（+）鈕將其改變為 OVDB（覆蓋錄
音）。此時進入覆蓋錄音待機模式。樂句編號及名稱將

出現在畫面上，但此時還不能選擇樂句。

• 若需要，此時可配置音符量化（Note Qntz）設定
（第 Ch-47頁）。

3. 按 bo REC或以踏板、旋鈕或輪操作開始演奏，或
在鍵盤上進行彈奏。這些操作都可啟動覆蓋錄音。

bo REC及 bo PLAY/STOP點亮（不閃動）。
• 原樂句將循環播放。在循環播放過程中您在鍵盤上彈奏
的任何音符或執行的任何操作都將覆蓋錄音在原樂句之
上。

4. 錄音到達要停止的點時按 bo PLAY/STOP。
bo REC與 bo PLAY/STOP熄滅並且感嘆號（！）將出
現在樂句編號的旁邊。

樂句資料的設定

選單 說明 設定範圍

OriginalKey

原調（Original Key）。
指定與由 Key Play演奏
的樂句的第一個音符對應

的鍵盤琴鍵。（對樂句進
行錄音時彈奏的音符為

Original Key的初始預設
設定。）
• 使用鍵盤琴鍵可以指定
設定。

C-至 G9*

Key Shift 

移調（key shift）。當對
應於原調的鍵盤琴鍵或

PLAY/STOP鍵被按下
時，以半間為單位指定樂

句的移調。（要解除移調
時請指定 000。）

–127至 000至
+127

如何錄音在另一個樂句上（覆蓋錄
音）
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■如何在循環播放過程中暫停覆蓋錄音
在上述操作的第 4步按 bo REC，而非按 bo PLAY/STOP。
• 這將使 bo REC開始閃動。
• 雖然已經錄音的內容繼續循環播放，但在覆蓋錄音暫停過程
中不能繼續錄音。

• 再次按 bo REC又可恢復覆蓋錄音。

■如何刪除最後的錄音資料（撤銷）
在樂句播放進行或停止的過程中，或覆蓋錄音進行或暫停過程

中，按住 bo REC直到撤銷畫面出現。

• 在已撤銷了最後的錄音後，若您再次進行撤銷操作，則
“Can’t UNDO＂將出現在畫面上。

• 保存為用戶樂句的樂句不能撤銷。

附加在畫面上樂句編號上的指示符的含義如下所述。

• 當目前所選樂句編號標有感嘆號（！）時（表示用戶樂句
尚未保存），若您在“如何播放預設＂一節（第 Ch-45頁）
中的第 2步改變樂句編號，則未保存的用戶句被放棄。要保
存尚未保存的用戶樂句時，請使用下述“如何保存樂句＂

一節中的操作步驟。

按7 WRITE顯示保存樂句的畫面。執行與保存用戶音色
（第 Ch-12頁）相同的操作步驟保存樂句。

• 若合成器的記憶器中沒有足夠的空間保存樂句資料，“not 
enough space＂訊息將出現在上示畫面上，而非“Press 
Enter＂，樂句資料無法保存。此種情況發生時，請刪除合成
器記憶器中的一些用戶資料，以騰出記憶器的空間。

• 合成器共能保存最多 100個用戶樂句，總容量最多 128KB。
• 有關刪除保存的樂句資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存樂句
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

樂句編號旁邊的指示符

! : 未保存的樂句
* : 保存的用戶樂句
!TEMP: 尚未保存的新錄樂句。

如何保存樂句
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步音序器的使用

步音序器最多有 16步。合成器的滑鈕可用於實時控制步音符及速度。步音序器不只是一個節奏器，它能讓您邊在鍵盤上彈奏邊作
曲。

通過編輯預設序列的各步可以創建自己的節奏型，並保存為用戶序列。
• 步音序器有 100種預設序列。用戶序列最多能保存 100個。
• 編輯步有兩種方法：不使用編輯畫面的簡單編輯，以及提供能對步進行更詳細修改的編輯畫面。
• 輪（彎音，變音）及旋鈕操作亦能作為序列的一部分錄音。
• 用步音序器最多能鏈起 99個不同的型，並循環播放。鏈接的序列最多能保存 100個。
• 樂句音序器的播放可以從步音序器開始。

下面介紹單個序列的結構。

• 一個聲部（PART）含有九個音符部分（鼓音 1至 5，貝司，獨奏 1及 2，和弦）及四個控制部分。
• 控制部分由彎音 /控制變化及樂句音序器播放的觸發（開始或停止播放）構成。
• 有關各聲部的設定及其他資訊的詳情請參閱第 Ch-56頁上的“序列的編輯 - 高階＂一節。
• 各序列有八個不同的型。您可以為八個型中的任何一個單獨配置拍子（Beat Info）。
• 一個音軌由 16步的資料及其音軌參數組成。
• 使用合成器的混頻器功能可以改變步音序器的音色。有關詳情請參閱第 Ch-78頁上的“混頻器的使用＂。

步音序器的構成

9 bl

7 bn bp

bq

br

5

bk

4

2

1
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8ch

9ch

10ch

11ch

12ch

13ch

14ch

15ch

16ch

A B
A B
A B
A B
A B
A B
A B
A B
A B

3 4 5 6 7 8 9 10 11 12 13 14 15 161 2

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

音軌

鼓音 1

鼓音 2

鼓音 3

鼓音 4

鼓音 5

貝司

獨奏 1

獨奏 2

和弦

控制 1

控制 2

控制 3

控制 4

拍子

滑鈕
（第 Ch-53頁）

主滑鈕
（第 Ch-54頁）

混頻器
（第 Ch-78頁）

聲部
（第 Ch-50頁）

型 1至 8
（第 Ch-50頁）

音符部分

控制部分

步資料

音軌的參數
• 最多步
• 步大小
• 其他

控制類型
• 僅控制音軌

關，開，連音

音符 1 *音符 2 *音符 3 速率

值 移調
• 僅樂句

*僅控制音軌

序列的聲部

音軌

音符部分

控制部分
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步音序器可以從演奏模式、音色模式或步音序器模式開始播
放。

通過切換為不同的型，選擇不同的序列庫及編號，以及移位音

調（Key Shift）可以改變步音序器。

• 若 bk CHAIN鈕是點亮的（表示鏈接模式），請在開始下述
操作之前先按 bk CHAIN將其熄滅。

1. 按 bk START/STOP。
bk START/STOP鈕閃動的同時序列播放開始。

• 播放過程中按 bk START/STOP可停止序列並使 bk 
START/STOP鈕熄滅。

• 步音序器的播放可自動進行，不用按 bk START/
STOP，用琶音功能能指定步音序器的播放開始條件。
有關詳情請參閱本說明書第 Ch-40頁上從“如何使用
琶音功能＂開始的章節。

• 有關改變播放速度的說明請參閱“如何改變速度設定＂
（第 Ch-46頁）。

2. 要改變為其他型時，請進入步音序器模式後按 bl 
PATTERN的 1至 8鈕之一。
其型被選擇的按鈕從點亮變為熄滅。

• 進入不同的小節時，目前所選型的按鈕燈閃動，直到到
達進行改變的位置。

• 按目前所選型的按鈕將使其鈕燈閃動，表示播放已準備
停止。然後，當播放到達正在播放的小節的末尾時按

bk START/STOP停止播放。要退出上述停止待機狀態
時，請再次按閃動的按鈕。

3. 要進入其他序列時，請進入步音序器模式並改變
序列的庫及 /或編號。
• 要選擇序列時，請執行“如何使用琶音功能＂一節
（第 Ch-40頁）中的第 2至第 5步操作。

4. 要移調時按1 STEP SEQUENCER後按2 KEY 
SHIFT。
• 若原調是 C2，則按鍵盤琴鍵可以在 D2至 B2的範圍內
移位音調。

• 您可以指定是否對各單獨的聲部進行移調。有關詳情請
參閱本說明書第 Ch-56頁上從“序列的編輯 - 高階＂開
始的章節。

• 移調（Key Shift）開 /關設定被保存為演奏參數。

序列的簡單編輯可以從演奏模式、音色模式或步音序器模式開

始進行。

• 若 bk CHAIN鈕是點亮的（表示鏈接模式），請在開始下述
操作之前先按 bk CHAIN將其熄滅。

1. 若合成器是在演奏模式或音色模式中，請按1 
STEP SEQUENCER。
此時進入步音序器模式，1 STEP SEQUENCER鈕點
亮。

2. 執行第 Ch-52頁上“步音序器的播放＂一節中的第
1至 3步操作，選擇要編輯的序列及型。

3. 用9 PART減（–）及加（+）鈕選擇要編輯的聲
部。
畫面上目前顯示的聲部編號的下面將出現指針（e）。

• 若您選擇的是控制類型的部分，則指針（e）不出現在
畫面上。

4. 請使用下列各節中的操作編輯各聲部。

步音序器的播放

序列名

拍子

序列庫，編號

小節

速度

序列的編輯 - 簡單編輯

選擇的聲部編號選擇的聲部名
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■ On（發音）
按要打開的步的編號的4 1至 16鈕。
當一個步打開時，其4 1至 16鈕點亮，並且 NOTE出現在
其步編號的旁邊。

■ Off（不發音）
按要關閉的步的編號的4 1至 16鈕。
當一個步關閉時，其4 1至 16鈕熄滅，並且 OFF出現在其
步編號的旁邊。

• 控制聲部沒有步開 /關設定。

1. 在按住1 STEP SEQUENCER的同時，按對應連
音組第一個音符的步編號的4 1 至 16鈕。

2. 然後，在按住1 STEP SEQUENCER的同時，按
對應連音組最後一個音符的步編號的4 1 至 16
鈕。

• 您指定的步作為連音組的開關打開。其還將從第一步到
最後一步的所有音符連接在一起。

• 與連音組中包含的步編號對應的4 1至16鈕全部熄滅。
鬆開1 STEP SEQUENCER時按鈕燈熄滅。（雖然按
鈕燈熄滅了，但組中的音符仍然連音在一起。）

• 要檢查連接的步時，請按住1 STEP SEQUENCER後
按4 1至 16鈕的任意一個。連音組中包含的步的4 
1至 16鈕閃動。

• 控制部分沒有連音設定。

• 若1 STEP SEQUENCER鈕是熄滅的，請在開始下述操作
之前先按1 STEP SEQUENCER將其燈點亮。

■滑鈕操作
用5 1/9至 8/16改變第 1至第 16步音符的音符及速率設定
（音符部分）。
• 對於控制部分，滑鈕用於改變控制音效。有關詳情請參閱
第 Ch-56頁上的“序列的編輯 - 高階＂。

• 按2 1-8/9-16可在第1至8步與第9至16步之間選換滑鈕的功
能。

• 當2 1-8/9-16鈕熄滅時執行第 1至 8步的操作。當2 1-8/
9-16鈕點亮時執行第 9至 16步的操作。

如何打開或關閉步

如何配置連音符設定

第一步的編號

如何使用滑鈕改變音符及速率設定

最後的步編號

第 1至 8步或第 9至 16步（可選）
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■滑鈕功能的選擇
按2 SLIDER A/B在兩種功能之間切換滑鈕。
例如：預設序列

2 SLIDER A/B熄滅：L（NOTE）

2 SLIDER A/B點亮：M（VELOCITY）

• 移動5 1/9至 8/16滑鈕將打開相應的步，即使其在關閉
狀態。

• 對於控制部分不能進行滑鈕功能的切換。

使用5 MASTER滑鈕能批量改變所有聲部的設定（音符，
速率，斷奏 /續奏，播放速度，槽）。
• 能使用主滑鈕改變的設定依聲部類型而不同。
• 對於有些聲部，主滑鈕不能用於改變設定。
• 需要時，可以將其他設定分配在主滑鈕上。有關詳情請參閱
第 Ch-54頁上的“如何改變分設給主滑鈕的功能＂及
第 Ch-60頁上的“滑鈕設定的變更＂。

在預設設定下，A滑鈕上分配有音符設定，而 B滑鈕上分配有
速率設定。使用下述操作可以在滑鈕上分配音符設定、速率設

定或音符及速率設定。
您可以對八個滑鈕的位置分別指定音符或速率設定。

1. 按1 STEP SEQUENCER。

2. 按住2 SLIDER A/B直到下示 SLIDER畫面出現。

3. 用9 PART減（–）及加（+）鈕選擇要改變其滑
鈕分設的聲部。

4. 按2 SLIDER A/B選擇要改變其分設的滑鈕組
（A或 B）。

5. 將畫面上的游標移動到“TYPE＂，然後用 br NO
及 YES鈕在所選滑鈕上分配下列功能之一。

6. 用 bp旋鈕、br向上（q）及向下（w）鈕或

bl PATTERN（1 至 8）鈕將畫面上的游標移動到
要改變其設定的滑鈕位置（1至 8）。
• 編號 1至 8表示八個滑鈕的位置，最高（8）到最低
（1）。

7. 用 br NO及 YES鈕在目前所選滑鈕位置改變音符
或速率值。
• 您還可以按對應於要輸入的音符的鍵盤琴鍵，以指定目
前所選滑鈕位置的音符及速率。

• 對於和弦聲部，最多可指定三個值。
• 請用高階參數編輯來編輯滑鈕的功能。有關詳情請參閱
“序列的編輯 - 高階＂（第 Ch-56頁）。

1. 按1 STEP SEQUENCER。

2. 按住2 SLIDER A/B直到 SLIDER畫面出現。

3. 按 br MENU後按 br向右（I）鈕將項目選擇游

標（0）移動到“M.Slider＂。

如何使用主滑鈕改變音符及速率設定

滑鈕分設的變更

表示選擇的功能是L還是M。

NOTE :音符
VELO :速率
NOTE & VELO :音符及速率雙方

如何改變分設給主滑鈕的功能
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4. 按 br ENTER。
主滑鈕設定畫面出現。

5. 用 br減（–）及加（+）鈕，以及9 PART減
（–）及加（+）鈕顯示 Part旁邊的方括弧%中

您要改變的聲部。

6. 用 br向上（q）及向下（w）鈕移動到

“Assign＂設定，然後用 bp旋鈕或 br 減（–）
及加（+）鈕改變為下述設定之一。

• 有關步大小、音符長度及槽分設的詳細說明，請參閱
第 Ch-57頁上的“步音序器的參數＂一節。

• 滑鈕功能還可以如下所述修改。有關進行這些變更的說明請
參閱第 Ch-60頁上的“滑鈕設定的變更＂一節。
– 從其他滑鈕複製設定
– 音階，鼓音，速率滑鈕的預設
– 音符移位

在彈奏過程中，通過進行鍵盤、彎音及旋鈕等操作可以輸入音
符、速率及其他步資料。

• 輸入彎音或旋鈕操作時，必須首先用控制音軌選擇彎音輪或
旋鈕，然後再進行輸入。

1. 按7 EDIT。

2. 用 br向下（w）鈕將項目選擇游標（0）移動

到“Step Edit＂，然後按 br ENTER。

3. 如下所述輸入資料。

■序列播放進行過程中
按照播放時機，根據需要按下鍵盤琴鍵並進行其他操作。

■序列播放停止時
向正在顯示的步中輸入。

獨奏 1通常分配在頻道 14。
要將獨奏合成器或其他特定音色用作獨奏音色時，可以使用下

述操作分配到頻道 1。

1. 按1 STEP SEQUENCER。

2. 按 br MENU後按 br向右（I）鈕。

3. 在確認了項目選擇游標（0）在“Setting＂旁邊
後，按 br ENTER。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Solo1 Ch＂。

5. 用 br減（–）及加（+）鈕改變獨奏 1的頻道設
定。

• 獨奏 1頻道的設定被保存為演設參數。

分設 說明

Nop 無操作。主滑鈕功能停止。

S. Data 步資料。改變目前打開的所有步（1至 16）的
資料。

S. Size 步大小

NoteLn 音符長度

Groove 槽

Octave 當有音符分配在滑鈕 1至 8時，在此設定有效
的情況下，移動主滑鈕可以改變音符的八度
（範圍：–1至 0至 1）。

如何通過在鍵盤上彈奏等方法輸入步資料

獨奏 1頻道的變更

1 :頻道 1
14 :頻道 14
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1. 執行第 Ch-55頁上“獨奏 1頻道的變更＂一節中的
第 1至第 3步操作。

2. 用 br向上（q）及向下（w）將項目選擇游標

（0）移動到“Pattern Change Timing＂。

3. 用 br減（–）及加（+）鈕選擇下述型切換時機之
一。

• 型切換時機的設定被保存為演設參數。

請參閱第 Ch-40頁上的“如何使用琶音功能＂一節。

使用合成器的混頻器功能可以改變步音序器的音色。

• 由混頻器分配到頻道 8至 16的資料將保存為步音序器資料。
• 混頻器的參數是所有型的參數。
• 有關詳情請參閱第 Ch-78頁上的“混頻器的使用＂。

1. 按1 STEP SEQUENCER後按7 EDIT。
• 若您已經按了7 EDIT，並且正在編輯步序列，則不需
要此步。

2. 按 bn MIXER。

3. 按住對應需要獨奏的聲部的按鈕（4 9至 16的音
符聲部鈕）。
• 要取消獨奏設定時，請退出步音序器模式或顯示 Track 

On/Off畫面（第 Ch-57頁）。
• 有關混頻器操作的詳細說明請參閱第 Ch-78頁上的“混
頻器的使用＂一節。

使用本節中介紹的操作可以對序列的參數進行高階的詳細的編

輯。

1. 按7 STEP SEQ。

2. 按7 EDIT。

3. 用 br游標（U, q, w, I）鈕將項目選擇游標
（0）移動到要進行編輯的選單項處。

如何改變型切換的時機

Wait :等到下一小節開始。
Real :即使是在小節中間亦立即切換。
Beat :在節拍的開頭切換。

如何使步音序器的播放與琶音同步

如何改變步音序器的音色

如何演奏單個聲部（獨奏模式）

序列的編輯 - 高階

如何進行高階的參數編輯

混頻器畫面
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■步音序器的參數

第 1級 第 2級 第 3級 說明 設定範圍及畫面內容

Trk On/Off >Ent 音軌編輯（track on/off）
• 在步音序器模式中，按7 EDIT可顯示與Trk On/Off >Ent
相同的畫面。

Pattern 型編號 1至 8

Part 聲部名。 Drm1至 5，Bass，Sol1至 2，
Chrd，Ctl1至 4

Track 音軌開 /關。用4 1至 16進行選換。
• 4 1至4對應控制部分1至4。同樣，4 8至16對應音符部
分（第Ch-51頁）。

Off，On

Step Edit >Ent 步編輯。分步編輯組。

Drm1至 5，
Bass，
Sol1及 2

NOTE，
VELO

為步選擇關（OFF），開（NOTE）或連音（TIE）。開時配
置音符（NOTE）及速率（VELOCITY）的參數設定。步 1
不能選擇連音設定。

Off，（開時） NOTE：C至 G9*，
（開時） VELO：1至 127，Tie

Chrd NOTE，
VELO

為步選擇關（OFF），開（NOTE）或連音（TIE）。開時配
置音符（NOTE）及速率（VELOCITY）的參數設定。步 1
不能選擇連音設定。

Off，（開時） NOTE：關或 C至
G9*，（開時） VELO：1至 127，Tie

Ctl1至 4 控制部分（Ctl）的效果。各聲部的資料。 NOP：無操作。其他設定的範圍如下
所示。
下示範例畫面表示的是 PHRASE畫
面。

BEND 彎音輪 –128至 +127

CC1至 97 MIDI控制變化。 0至 127，僅 Pan –64至 +63

K1至 4 由演奏等指定的旋鈕操作。 0至 127

TEMPO 速度 30至 255

PHRASE 指定開始或停止樂句音序器播放的觸發條件。僅控制 4
（Ctl4）表示。

Nop:無效，Stop：停止播放，Start：
開始播放， 
–24至 +24：從原調移位（Start被選
擇）

音符 速率

和弦的音符 速率

選單 值
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Track Param >Ent 音軌的參數

Max Step 最多步（Maximum step）。指定一個聲部播放的步數。若在
播放過程中超出了指定的最多步數，播放將返回第一步。

1至16

Step Size 步大小（Step size）。指定步間的音符長度。 2, 6, , 7, , 8

NoteLngth 音符長度（Note length）。產生的音符長度以步大小的百分
比指定。100%指定為與原大小相同，而 50%指定音符長度
為原長的一半。

1至 100%

Groove 槽（Groove）。指定音符上拍步的時機。步的播放交替改變
步的音符長度。50%指定為相等，而較大的數值增加前半音
符的長度。

10至 90%

Grv.Type 槽類型（Groove type）。槽指定為 50%以外時，指定產生
的音符長度的類型。

Norml：根據實際的百分比的長度正
常播放。

Short：當步長度被槽改變時，請調整
為更短的長度。

Ctrl.Ch
（僅控制部分）

控制頻道。指定產生控制音軌效果的頻道。 頻道 1，8至 16

Smooth
（僅控制部分）

平滑。控制控制音軌的播放。開時控制資料被插入並播放。 On，Off

Phrase No.
（僅控制部分 4）

樂句音序器編號。指定要控制的樂句音序器編號。 P00至 99，U00至 99

Key Shift >Ent 移調編輯組。控制 1至 3不能配置此設定。當控制 4設定為
進行樂句音序器的音調移位時不能進行實時設定。

Enable 移調開 /關 Off，On

BreakPoint 音調超出時，移調下調一個八度的 C與 B之間的點。 C至 B

Realtime 實時。指定斷點的時機。 On：立即改變
Off：在下一個音符改變

Beat Info 節拍設定 2/4至 8/4，2/8至 16/8

第 1級 第 2級 第 3級 說明 設定範圍及畫面內容
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* 畫面上的“C-＂表示 C-1（比 C0低一個八度）。

Copy >Ent 資料複製

Track 從另一個音軌複製資料。複製步資料及聲部參數資料。
• 正在編輯的資料（TMP）亦能複製。
• 下列聲部可以複製。

Pattern 從另一個型複製資料。
• 正在編輯的資料（TMP）亦能複製。

Note Shift >Ent 音符移位編輯組

Shift 指定以半音為單位移位多少。 –24至 +24

Ptn 指定要移位的型。 01至 08

Part 指定要移位的聲部。 Dr1至 5，Bas，Sl1及 2，Chd

Clear >Ent 音軌資料清除

Track Pattern，
Part

選擇一個音軌中的型及 /或聲部。 Pattern: 01至 16
Part: Drm1至 5，Bass，Sol1至 2，
Chrd，Ctl1至 4

Pattern 清除所有型。

Set 清除所有音軌（組）資料。

Slider Edit >Ent 步音序器模式的滑鈕設定。
• 當1 STEP SEQUENCER鈕點亮時，您還可以按住2 

SLIDER A/B直到“TYPE＂畫面出現，然後執行下述操
作。

TYPE
• 當“TYPE＂畫面顯示時，
按br MENU進入第3級。

改變分配給滑鈕的功能。 有關操作步驟與設定的詳情，請參閱
“滑鈕分設的變更＂一節
（第 Ch-54頁）中從第 3步開始的操
作。

Copy >Ent 從其他滑鈕複製設定。 有關操作步驟與設定的詳情，請參閱
“滑鈕設定的變更＂一節
（第 Ch-60頁）中從第 4步開始的操
作。

Preset >Ent 音階，鼓音，速率滑鈕的預設。

Note Shift 
>Ent

音符移位。

M.Slider >Ent 改變主滑鈕的功能。 有關操作步驟與設定的詳情，請參閱
“如何改變分設給主滑鈕的功能＂一
節（第 Ch-54頁）中從第 5步開始的
操作。

第 1級 第 2級 第 3級 說明 設定範圍及畫面內容

從 到

Dr1至 S2 3 Dr1至 S2
和弦 3 和弦

Ctrl1至 3 3 Ctrl1至 3
Ctrl4 3 Ctrl4

複製目標型的編號

複製目標聲部名

複製源型的編號

複製源聲部名

複製源序列
（庫，編號）

複製目標型的編號

複製源型的編號

複製源序列
（庫，編號）
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4. 用 br游標（U, q, w, I）鈕將方括弧%或游

標移動到要改變其設定的項目處，然後用 br減
（–）及加（+）鈕改變選擇的設定。
• 用 bl PATTERN改變型編號。
• 用9 PART減（–）及加（+）鈕改變聲部名。
• 用 bk STEP減（–）及加（+）鈕改變步編號。
• 要返回上層選單時，按 br EXIT。
• 混頻器畫面顯示目前的設定。
• 當 Step Edit畫面顯示時，鍵盤產生目前所選聲部的音
色。混頻器畫面顯示各步（正在改變的音符、速率或數

值項目）的設定。
在混頻器畫面上，音符在 C至 B的特定位置顯示，無論
實際的八度為何。

除能用簡易編輯操作（第 Ch-52頁）進行的變更之外，還可
以進行下述操作。
• 從其他滑鈕複製設定。
• 音階，鼓音，速率滑鈕的預設
• 音符移位

1. 按1 STEP SEQUENCER。

2. 按住2 SLIDER A/B直到如下所示畫面出現。

3. 按 br MENU。

4. 用 br游標（U, q, w, I）鈕將項目選擇游標
（0）移動到所需要的項目處，然後按 br 
ENTER。畫面上有用的項目如下所述。

■ Copy:從其他滑鈕複製設定。
用 br游標（U, q, w, I）鈕將方括弧（%）移動到一
個項目處，然後用 br減（–）及加（+）鈕改變項目設定。

• 和弦聲部只能在和弦聲部之間複製。
• 正在編輯的資料（!TEMP）可以指定為複製源。

滑鈕設定的變更

如何從其他滑鈕複製滑鈕設定

SLIDER A/B按鈕設定

複製目標型名

SLIDER A/B按鈕設定

型複製源序列的編號
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■ Preset: 音階，鼓音，速率滑鈕的預設
用 br游標（U, q, w, I）鈕將方括弧［ ］移動到一個項
目處，然後用 br減（–）及加（+）鈕改變項目設定。輸入
一個滑鈕預設編號時，滑鈕預設名將自動相應改變。

• 下列為滑鈕預設編號及其相應的滑鈕預設名。
1 Major, 2 Minor, 3 Dorian, 4 Lydian, 
5 Mixolydn（Mixolydian） , 6 Phrygian, 7 Locrian, 
8 M.Minor（Melodic Minor） , 9 H.Minor（Harmonic 
Minor） , 10 H.M. 5th（Harmonic Minor 5th） , 
11 Altered（Altered） , 12 WholeTon（Whole Tone） , 
13 Diminish（Diminished） , 14 Pentaton（Pentatonic） , 
15 M.Penta（Minor Pentatonic） , 16 Blues, 
17 Kick（Bass Drum） , 18 Snare, 19 Hi-hat, 20 Toms, 
21 Cymbal, 22 Velocity

• 下列為和弦聲部專用滑鈕預設編號及其滑鈕預設名。
1 Diatonic, 2 Minor, 3 H.Minor（Harmonic Minor） , 
4 Velocity

■ Note Shift: 移位音符。
用 br游標（U, q, w, I）鈕將方括弧［ ］移動到一個項

目處，然後用 br減（–）及加（+）鈕改變項目的移位值設
定。

按7 WRITE顯示保存序列的畫面。執行與保存用戶音色
（第 Ch-12頁）相同的操作步驟保存序列。
• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存序列
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

1. 在步音序器模式中，按 bk CHAIN。

2. 按7 EDIT。

滑鈕預設名

型名 SLIDER A/B按鈕設定

滑鈕預設編號

移位值（–24至 +24）

型名 SLIDER A/B按鈕設定

如何保存編輯後的序列

鏈

如何建立一個鏈
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3. 用 br游標（U, q, w, I）鈕將游標移動到一個
項目處，然後輸入所需要的設定。

• 改變設定所需要的按鈕操作依選擇的項目而不同。

• 對於鏈的種類，可以指定反覆播放的 LOOP，或播放到
鏈最後的 END。

• 用 bk DELETE可刪除鏈中的部分。
• 按 bk INSERT亦能在鏈中插入部分。
• 要檢查目前選擇的型時，按 bk CHAIN後按 bk START/

STOP播放型。型可以在播放過程中進行編輯。

4. 按7 WRITE顯示保存鏈的畫面。執行與保存用戶
音色（第 Ch-12頁）相同的操作步驟保存鏈。
• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存鏈
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

1. 按住 bk CHAIN直到 CHAIN畫面出現。

2. 用 bp旋鈕，bq鈕或 br減（–）及加（+）鈕顯示
要播放的鏈。

3. 按 bk START/STOP。
• 要停止播放時，請再次按 bk START/STOP。
• 需要時，以後可以重新排列鏈。有關詳情請參閱
第 Ch-61頁上的“如何建立一個鏈＂。

1. 按住 bk CHAIN直到 CHAIN畫面出現。

2. 按 br MENU。

3. 用 bp旋鈕或 br游標（U, q, w, I）鈕將項目
選擇游標（0）移動到“Initialize＂，然後按 br 
ENTER。

4. 再次按 br ENTER。
此時“Sure?＂應出現在畫面上。

5. 按 br YES。
初始化完畢時“Complete!＂訊息出現在畫面上。

序列編號 :要選擇序列時，請執行“如何使用琶音功
能＂一節（第 Ch-40頁）中的第 2至第 5
步操作。

型編號 : br（–, +）或 bl PATTERN
小節 : br（–, +）
移調 : br（–, +）或鍵盤琴鍵（最左側的琴鍵，C

至 B的一個八度）
鏈的種類 : br（–, +）

鏈編號

鏈的種類

序列編號

型編號

小節

移調

如何播放鏈

如何初始化鏈的設定
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• 在執行下述操作之前，請先在合成器中插入記憶卡。

1. 按住 bk CHAIN直到 CHAIN畫面出現。

2. 用 bp旋鈕，bq鈕或 br減（–）及加（+）鈕顯示
要保存的鏈。

3. 按 br MENU。

4. 用 bp旋鈕或 br游標（U, q, w, I）鈕將項目
選擇游標（0）移動到“SMF Save＂，然後按

br ENTER。

• 剩下的步驟請執行“如何在記憶卡中保存合成器的資
料＂一節（第 Ch-88頁）中從第 4步開始的操作。

• 要在記憶卡上保存資料時，請參閱第 Ch-86頁上的“記憶卡
的使用＂一節。

如何在記憶卡上以 SMF格式保存鏈
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如何用取樣循環器錄音與播放

使用取樣循環器可以對從合成器演奏、麥克風或線路的輸入進
行錄音與循環最長 19秒，並覆蓋錄音在以前錄音的循環上。
合成器的記憶器最多能儲存錄音資料的 10個樣本。
• 進入cl INST IN及cl MIC IN端子的外部輸入可以錄音為樣
本。請注意，通過 cl AUDIO IN的輸入不能錄音為樣本。

• 要向合成器匯入比外部輸入音質更高的樣本時，請用 Data 
Editor應用軟體（第 Ch-93頁）從電腦傳送波形資料。

• 使用五種不同的錄音模式之一可進行取樣錄音，不同的錄音
模式代表不同的開始方式與錄音種類的組合。有關詳情請參

閱“如何使用取樣循環器進行錄音＂（第 Ch-64頁）。
• 用戶波形編輯功能可對保存的樣本的參數進行編輯。有關詳
情請參閱“用戶波形音色的可編輯參數＂一節
（第 Ch-32頁）。

• 樣本可以作為取樣循環器的資料或作為鍵盤上的用戶波形音
色進行播放。

• 與樂句相同（第 Ch-45頁），對於樣本播放，LOOP與
HOLD設定可以打開或關閉。

• 要從外部音源輸入聲音時，請在合成器上連接外部音源，如
第 Ch-8頁所示。

• 用合成器的踏板能進行取樣錄音及播放操作。有關配置踏板
設定的詳細說明，請參閱“可編輯的演設參數表＂下的

“Pedal＂（第 Ch-73頁）。

1. 按 bm REC。
此時，LOOPER REC（取樣循環器錄音）設定畫面出
現。有關錄音模式的詳情，請參閱本操作的第 2步。

■錄音選單的設定
當 LOOPER REC畫面顯示時，按 br MENU進入錄音選
單。

• 用 br游標（U, q, w, I）鈕選擇選單項，然後用
bp旋鈕或 br減（–）及加（+）鈕改變項目的設定。

bm

br

bp87

bk

取樣錄音

如何使用取樣循環器進行錄音
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• 反向模式、取樣頻道及取樣率設定只適用於新錄音。在覆蓋錄音過程中不起作用。
• 取樣率越高，取樣越接近原音。能錄音的時間取決於取樣率與頻道設定。

• 設定閾值時可以在畫面上查看現在的閾值音量與輸入音量。

■速度的調節
用8 TEMPO減（–）及加（+）鈕調節速度。
• 有關速度調節方式的說明請參閱“如何改變速度設定＂一節（第 Ch-46頁）。

2. 用 bp旋鈕或 br減（–）及加（+）鈕選擇下述五種錄音模式之一。
• 模式名的最後兩個字母表示開始錄音的方式。

• 要在各錄音模式中配置設定（Length, Beats, Splits）時，請用 br向上（q）及向下（w）鈕選擇一項，然後用 bp旋鈕或
br減（–）及加（+）鈕改變設定。

選單 說明 設定

Precount 預計數（precount）。指定當錄音開始方式為手動模式（ML）時在錄音開始之前插入的預
計數。 Off，2 至 8

Threshold
閾值音量（Threshold）。當錄音開始方式為自動模式（AT）時，指定為開始錄音輸入的聲
音必須超過的閾值音量。
• 設定一個大值將需要很大的聲音來開始錄音。

0 至 127

Reverse 反向模式（Reverse）。對於新錄音，只反向播放第一個錄音的聲部。 Off，On

Channel 取樣頻道（Channel）。對於新錄音，指定立體聲錄音或單聲道錄音。 Stereo：立體聲錄音
Mono：單聲道錄音

Smpl Rate 新錄音的取樣率（sampling rate）。取樣頻率。 42 kHz，21 kHz

Auto OVDB 指定在新錄音過程中取樣結束點之後的操作。選項有循環播放的自動開始（Off）或覆蓋錄
音（On）。 Off，On

頻道 /速率 大約最長錄音時間
對各速度能錄音的最大拍子

速度 30 速度 101 速度 120 速度 126 速度 132 速度 255

Stereo/42 kHz 4秒鐘 2 8 9 10 10 20

Stereo/21 kHz
Mono/42 kHz 9秒鐘 4 16 19 20 21 –

Mono/21 kHz 19秒鐘 9 32 – – – –

AT : 自動（Auto）。合成器進入錄音待機狀態並且當您在鍵盤上進行彈奏或通過麥克風輸入聲音時自動開始錄音。
ML: 手動（Manual）。錄音必須手動開始。

閾值音量

輸入音量
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(1) NORM-AT:
使用自動開始功能錄音新樣本。

• Length（錄音時間）設定

(2) NORM-ML:
使用手動開始功能錄音新樣本。

• 此模式的設定與 NORM-AT相同。

(3) BEAT-AT:
通過錄音一拍建立樣本並使該拍反覆指定次數。此模式只

能進行自動錄音。
• Beats（拍數）設定

(4) SPLT-AT:
通過鏈接指定數目及指定長度的取樣錄音建立樣本。此模

式只能進行自動錄音。
• Length（分段長度）設定

• 段數（分割）設定
2, 3, 4, 5: 指定分段數。

■選擇用 SPLT-AT錄音作為用戶波形音色的分段。
• 要選擇分段作為獨奏合成器音色時： 
參閱“PCM波形＂（第 Ch-23頁）。

• 要選擇分段作為 PCM鼓音音色時： 
參閱“樂器編號＂（第 Ch-31頁）。

Free : 樣本的末尾是您按 bm REC或 bm PLAY/
STOP停止錄音的點。若在您按一個按鈕停
止之前錄音到達了最長允許錄音時間，則該

點成為樣本的末尾。

01 - 32bt : 指定錄音時間作為拍數。

02 - 32 : 指定一拍錄音反覆的次數。

Free : 無聲時是樣本的末尾。
1 - 6bt : 指定無聲之前經過的拍數，無聲時下一個分段

的錄音開始。若在到達指定的拍數之前沒有聲

音了，錄音將繼續直到指定的拍數經過為止。
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(5) OVDB-ML:
啟用從頭開始對現有樣本進行覆蓋錄音。此模式只能進行
手動錄音。使用此錄音模式時，在您進行本操作的第 1步
之前需要選擇要覆蓋的現有樣本。
您錄音了樣本後（若樣本尚未保存），合成器將立即自動

進入 OVDB-ML錄音模式。在這種情況下，若您要重新錄
音新資料，請選擇 OVDB-ML之外的其他錄音模式。

• 指定一個超過最長允許錄音時間的長度將使“！＂在畫
面上閃動。若此種情況發生，請根據第 Ch-65頁上說明
的頻道 /速率指示調整長度、取樣頻道、取樣速率、速
度及其他設定。

• 當感嘆號（！）在畫面上閃動時，執行第 3步中的操作
將使訊息“LOOPER: Can’t REC＂出現，表示錄音無
法開始。

3. 按 bm REC鈕使其開始閃動，表示已進入錄音待機
狀態。

4. 根據您選擇的錄音模式，執行下述操作之一開始
錄音。

■NORM-AT

在鍵盤上進行彈奏，從麥克風或外接電子樂器輸

入聲音，或按 bm REC開始錄音。
• 錄音開始時 bm REC鈕停止閃動並點亮。
• 錄音進行過程中，通過查看合成器畫面上的記憶器用量
指示符可以大概瞭解剩餘記憶容量。

• 若您為“Length＂設定指定了拍數，則錄音了指定拍數
後 bm REC鈕將開始閃動。此表示錄音在覆蓋錄音待機
狀態下。

• 若您為“Length＂設定指定了“Free＂，則錄音到循環
的結束時按 bm REC將使 bm REC鈕開始閃動。此表
示錄音在覆蓋錄音待機狀態下。

• 若在錄音過程中到達了最長允許錄音時間，則錄音將自
動進入覆蓋錄音待機狀態。

• 錄音進入覆蓋錄音待機狀態時，合成器立即開始循環播
放已錄音的樣本。在播放過程中，您可以練習要覆蓋錄
音的下一個部分，與循環進行雙重奏等。

• 若“Auto OVDB＂已打開，則覆蓋錄音將自動開始，而
不進入覆蓋錄音待機狀態。

■NORM-ML

要開始錄音時按 bm REC。
• 錄音一旦開始，操作便與 NORM-AT相同。

現有的樣本編號與名稱

取樣頻道與速率

記憶器用量指示符

XWG1_ch.book  Page 67  Wednesday, January 18, 2012  10:34 AM



如何用取樣循環器錄音與播放

Ch-68

■BEAT-AT

在鍵盤上進行彈奏，從麥克風或外接電子樂器輸

入聲音，或按 bm REC開始第 1拍的錄音。
• 錄音開始時 bm REC鈕停止閃動並點亮。
• 錄音完第 1拍後，從第 2拍開始到由“Beats＂設定指定
的拍數為止樣本的其他部分將自動建立。之後，錄音進
入覆蓋錄音待機狀態。

■SPLT-AT

在鍵盤上進行彈奏或從麥克風或外接電子樂器輸

入聲音時錄音自動開始。
• 錄音開始時 bm REC鈕停止閃動並點亮。
• 若“Length＂設定指定了“Free＂之外的值，錄音將
在指定的拍數後停止。沒有輸入音時，錄音將進入輸入

下個聲音的待機狀態。探測到輸入音時錄音自動重新開
始。

• 若“Length＂設定指定了“Free＂，則當輸入音無聲時
錄音暫停並進入輸入音的待機狀態。探測到輸入音時錄

音自動重新開始。

• 合成器用於自動無聲判斷的輸入音量是，輸入音量低於
閾值設定（第 Ch-65頁）指定的音量一半以下持續約
0.5秒鐘。
例如，若閾值音量設定為 80，則 40以下的音量持續約
0.5秒鐘時被判斷為無聲。

• 由“Splits＂設定指定的錄音拍數完成後，錄音進入覆
蓋錄音待機狀態。

• 若您在由“Splits＂設定指定的分段數之前按 bm REC
停止錄音，則只有到此時為止錄音的分段數被保存。例

如，當“Splits＂設定指定為 5時，三個分段之後停止
錄音將建立三個分段的循環。

■OVDB-ML
使用 OVDB-ML錄音模式時，在您進行本操作的第 1步之
前需要選擇要覆蓋的現有樣本。

按 bm REC。
• 此時 bm REC點亮，您選擇的樣本開始覆蓋錄音。
• 在覆蓋錄音過程中，合成器的畫面表示現在的覆蓋錄音
位置。

• 播放進行到樣本的開頭時，bm REC鈕燈熄滅片刻進行
表示。

• 使用取樣循環器不能撤銷覆蓋錄音。

5. 要從覆蓋錄音待機狀態重新開始覆蓋錄音時，請
按 bm REC。
覆蓋錄音開始時 bm REC鈕停止閃動並點亮。
• 要暫停覆蓋錄音時按 bm REC。
• 雖然到此時為止錄音的樣本繼續循環播放，但覆蓋錄音
暫停過程中的演奏不錄音。

• 再次按 bm REC又可恢復覆蓋錄音。

6. 要停止錄音時請按 bm PLAY/STOP。
此時 bm REC鈕燈熄滅，“!TEMP＂（暫時）出現在畫面
上表示樣本編號。
• 即使您停止了不含任何聲音的樣本的錄音，其仍然被當
作樣本。

7. 錄音完畢後如下所述進行保存。
• 按7 WRITE顯示保存樣本的畫面。

表示正在錄音的分段編號。

記憶器用量指示符

現在的覆蓋錄音位置
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1. 為了用取樣循環器進行錄音，選擇要使用的步音
序器。
• 有關步音序器操作的詳情請參閱“步音序器的播放＂
（第 Ch-52頁）。

2. 按 bm REC。
錄音模式畫面出現。

• 用 br減（–）及加（+）鍵將錄音模式改變為
NORM-AT。

• 配置“Length＂設定來指定錄音長度。例如，要指定以
4/4拍錄音兩小節時，“Length＂設定請指定為 8。

3. 再次按 bm REC。
鋼琴進入錄音待機狀態。

4. 按 bk START/STOP。
步音序器的播放與取樣錄音同時開始。

• bm REC鈕停止閃動並點亮。
• 對應您在第 2步指定的“Length＂設定的長度錄音完畢
後，錄音進入覆蓋錄音待機狀態。步音序器亦在此時停

止。
• 隨後的操作與“如何使用取樣循環器進行錄音＂一節
（第 Ch-64頁）中從第 4步開始的操作相同。

1. 按住 bm REC直到下示樣本選擇畫面出現。

2. 選擇要播放的樣本。
• 選擇樣本的操作與選擇琶音（第 Ch-40頁）的第 5步操
作相同。

3. 按 bk STEP +可打開或關閉循環。

• 若樣本為空，則循環設定不能改變。

4. 按 bk STEP –可打開或關閉保持。

• 若樣本為空，則保持設定不能改變。

如何使用步音序器錄音樣本 如何播放樣本

OFF: 播放一次。
ON : 反覆播放。

OFF: 按 bm PLAY/STOP過程中只播放。鬆開按鈕時播
放停止。

ON : 播放在 bm PLAY/STOP被按下時開始，而在 bm 
PLAY/STOP被再次按下時停止。

樣本編號

樣本名

循環設定

保持設定
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5. 按 bm PLAY/STOP開始樣本的播放。
• 在播放過程中，如下所示畫面出現，顯示樣本播放位
置。

• 若您用樣本選擇畫面進行播放，則按 bm REC可開始覆
蓋錄音。

•“LOOPER: EMPTY＂出現在畫面上時表示沒有可用的
樣本。

• 在樣本播放過程中不能調節速度。

6. 按 bm PLAY/STOP停止樣本的播放。

附加在畫面上樣本編號上的指示符的含義如下所述。

• 當目前選擇的樣本的編號之前有感嘆號（！）或 !TEMP取
代了樣本編號（兩種情況都表示其未保存），則改變“如
何播放樣本＂一節（第 Ch-69頁）第 2步中的樣本選擇將
使尚未保存的樣本丟失。要保存尚未保存的樣本時，請使用
下述“如何保存樣本＂一節中的操作步驟。

按7 WRITE顯示保存樣本的畫面。執行與保存用戶音色
（第 Ch-12頁）相同的操作步驟保存樣本。

• 有關刪除保存的資料的說明請參閱第 Ch-83頁。

■如何在外接裝置上保存樣本
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

樣本編號旁邊的指示符

! : 未保存的樣本
* : 保存的樣本
!TEMP : 尚未保存的新錄樣本

現在的樣本播放位置

如何保存樣本
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演奏模式的使用

演奏模式可在鍵盤上最多配置四種音色進行演奏。除配置音色
外，您還可以將音效、步音序器及其他設定保存為一種設置

（稱為“演設＂），以便隨時調用，即使您正在演奏，調用演
設亦能立即改變音序器的設置。

• 共有 100種預設演設。預設演設可以編輯並保存為 100種用
戶演設之一。另一冊“附錄＂中有預設演設的列表。

• 各鍵盤區可分別分配為不同的功能，每當其鍵盤區中的琴鍵
（多功能鍵）被按下時起作用。有關多功能鍵及如何配置其
設定的詳細說明，請參閱“可編輯的演設參數表＂一節

（第 Ch-73頁）中的“多功能鍵＂項。

1. 按7 PERFORM。
該鈕點亮，合成器進入演奏模式。

2. 使用與選擇琶音（第 Ch-40頁）相同的操作步驟選
擇演設庫及編號。

9

7

br

3
8

2

概要 演設的登錄與調用

如何登錄演設

按 br向左
（U）進入下示畫
面。

3 K1至 K4旋鈕的功能（第 Ch-74頁）

多功能鍵功能的開 /
關狀態與鍵盤區設定
（第 Ch-75頁）

用 br向上（q） /向下
（w）選擇編輯的區段
（第 Ch-73頁）。

琶音開 /關狀態與鍵盤區
設定（第 Ch-75頁）

樂句鍵演奏開 /關狀態與鍵
盤區設定（第 Ch-75頁）

Zone Param 
>Arp Enable
（第 Ch-74頁）

Zone Param >Phrase Enable
（第 Ch-74頁）

區段 1至 4的開 /關
及鍵盤範圍設定畫面
（第 Ch-73頁）
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Ch-72

3. 按7 EDIT。
演設編輯列表的頂部畫面出現。

4. 使用與選擇音色時相同的操作步驟，在畫面上選擇項目並改變設定。
• 有關編輯的詳情請參閱第 Ch-73頁上的“可編輯的演設參數表＂。

5. 編輯完畢後，按7 EDIT。
本機退出編輯列表。

6. 按7 WRITE後將編輯後的演設保存為用戶演設。
• 有關保存用戶資料的說明，請參閱保存用戶音色的操作（第 Ch-12頁）。

■如何在外接裝置上保存用戶演設資料
• 記憶卡（第 Ch-86頁）
• 電腦（第 Ch-92頁）

1. 按7 PERFORM。
該鈕點亮，合成器進入演奏模式。

2. 使用與選擇琶音（第 Ch-40頁）相同的操作步驟選擇演設庫及編號。
您選擇的演設被調出。
• 被調出的演設內容與本說明書下一節“可編輯的演設參數表＂中介紹的相同。
• 在這裡，您可以配置一個演設過濾器，濾掉調出的演設資料中包含的一些設定（音序器，琶音等）。按 br MENU顯示演設
選單。然後，選擇下示“PrfrmFilter >Ent＂進入組並配置演設過濾器設定。

演設過濾器設定表

如何調用演設

顯示幕 說明 設定

PrfrmFilter >Ent 演設過濾器

Step Seq
步音序器開 /關。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音序器參數組中包含的
步音序器項目。

Off，On

Arpeggio
琶音開 /關。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音序器參數組中包含的琶音
項目。

Off，On

Phrase
樂句開 /關。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音序器參數組中包含的樂句
音序器項目。

Off，On

Tempo
速度開 /關。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音序器參數組中包含的
Tempo設定。

Off，On

Sys Rev 系統回響。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音效參數組中包含的回響項
目。 Off，On

Sys Cho 系統合唱。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音效參數組中包含的合唱項
目。 Off，On

區段 1至 4的開 /關及鍵盤範圍設定
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可編輯參數表

Master EQ 主均衡器。打開此設定可濾掉可編輯演設參數表（第 Ch-73頁）的音效參數組中包含的主均衡器
項目。 Off，On

Looper 取樣循環器（looper）。此設定被打開時，可編輯演設參數列表（第 Ch-73頁）的音序器參數組
中的取樣循環器項不能調出。 Off，On

Multifunc Key 多功能鍵（multi-function key）。此設定被打開時，可編輯演設參數列表（第 Ch-73頁）的多功
能鍵參數組中的取樣循環器項不能調出。 Off，On

可編輯的演設參數表

顯示幕 說明 設定

Zone Param >Ent

區段參數。此組中含有各區段（區段 1至 4）的參數。
• 用9 PART減（–）及加（+）鈕選擇要編輯的區段。
• 使用下述捷徑亦能進入組：執行“如何登錄演設＂一節（第Ch-71頁）中的第2步，然後按住
7 EDIT。此時進入組。

Zone
區段開 /關。打開或關閉所有區段。此設定與混頻器功能（第 Ch-80頁）中的聲部開 /關（Part 
Enable）設定不同。

Off，On

Tone

音色。為各區段選擇音色。此設定與混頻器功能的聲部音色（第 Ch-80頁）相同。
• 當此項目被選擇時，可以使用與在音色模式中使用的相同的操作步驟選擇音色。
• 此設定還可以用快捷編輯功能（第Ch-16頁）進行配置。
• 區段2至4（第Ch-16頁）的音色類別的選擇有一些限制。
• 在畫面上帶DSP音色的音色名旁邊有DSP（第Ch-36頁）。

區段 1：
Solo Synth P000至
PCM Drum U309
區段 2至 4：
PCM Tone P100至
PCM Drum U309

KeyRangeLow

鍵區低。為各區段指定鍵盤區的最低音。此設定與鍵區高設定配合使用，配置各區段的音區。

例如，為區段 1與 2配置 F3（低）至 C7（高），而為區段 3與 4配置 C2（低）至 E3
（高），您可以在右側鍵盤區彈奏區段 1及 2的音色，而在左側鍵盤區彈奏區段 3及 4的音色，
如下圖所示。

• 使用鍵盤琴鍵可以指定設定。

C-至 G9*

KeyRangeHi
鍵區高。為各區段指定鍵盤區的最高音。此設定與鍵區低設定配合使用，配置各區段的音區。

• 使用鍵盤琴鍵可以指定設定。 C-至 G9*

Volume 音量。此設定與混頻器功能的音色音量（第 Ch-80頁）相同。 0至 127

Pan 立體音位。調節立體聲的左右音位。此設定與混頻器功能的聲部立體音位（第 Ch-80頁）相同。 –64至 0至 +63

Oct.Shift 八度移位。以八度為單位移位音符的音色。 –2至 0至 +2

Transpose 移調。以半音為單位移位音符的音色。此設定與混頻器功能的聲部粗調音（第 Ch-80頁）相同。 –12至 0至 +12

FineTune 微調音。此設定與混頻器功能的聲部微調音（第 Ch-80頁）相同。 –99至 0至 +99

BendRngDwn 向下彎音範圍。由彎音輪操作向下改變音高的量。 0至 24

BendRngUp 向上彎音範圍。由彎音輪操作向上改變音高的量。 0至 24

Rev Send 回響傳送。此設定與混頻器的回響傳送（第 Ch-80頁）相同。 0至 127

Cho Send 合唱傳送。此設定與混頻器的合唱傳送（第 Ch-80頁）相同。 0至 127

顯示幕 說明 設定

C2 F3E3 C7

區段 3
區段 4

區段 1
區段 2
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DSP Line DSP線路。此設定與混頻器功能的聲部 DSP線路（第 Ch-80頁）相同。 Off，On

Knob1Enable 旋鈕 1開 /關。啟用 /禁用各區段的3 K1操作。 Off，On

Knob2Enable 旋鈕 2開 /關。啟用 /禁用各區段的3 K2操作。 Off，On

Knob3Enable 旋鈕 3開 /關。啟用 /禁用各區段的3 K3操作。 Off，On

Knob4Enable 旋鈕 4開 /關。啟用 /禁用各區段的3 K4操作。 Off，On

Bend Enable 彎音輪開 /關。啟用 /禁用各區段的 bt BENDER操作。 Off，On

Wheel Enable 變音輪開 /關。啟用 /禁用各區段的 bt MODULATION操作。 Off，On

Pedal Enable 踏板開 /關。啟用 /禁用各區段的踏板操作，踏板插在 cl SUSTAIN/ASSIGNABLE JACK中。 Off，On

Arp Enable 琶音開 /關。啟用 /禁用各區段的琶音功能（第 Ch-40頁）。 Off，On

Phrase Enable 樂句開 /關。啟用 /禁用各區段的樂句音序器（第 Ch-45頁）。 Off，On

Controller >Ent 控制器的參數。控制器的可編輯參數組。

K1

旋鈕目標 1。選擇由3 K1旋鈕操作控制的參數。例如，若此設定指定為“CC67:Soft＂，則

3 K1操作將產生柔音踏板效果。

CC00至 CC97：MIDI控制變化 *1

NRPN, RPN:MIDI NRPN及 RPN參數 *1 *2

Ch Pressure:MIDI頻道壓力 *1

Arpeggio:預設琶音的種類（第 Ch-40頁）
Tempo:速度設定（第 Ch-46頁）
EQ Low Gain - EQ High Gain:Master EQ >Low Gain - High Gain（第 Ch-38頁）

*1 有關各設定的詳細說明，請參閱MIDI執行文件（http://world.casio.com/）及其他MIDI文件。
*2 選擇了這些參數後，再次按br ENTER後調整下列項目。

MSB: NRPN的63H，RPN的65H（設定範圍：000至127）
LSB: NRPN的62H，RPN的64H（設定範圍：000至127）
Send Data: 指定旋鈕操作是否控制MSB或LSB。（設定：MSB, LSB）

參照左側的單元

格。

K2至 K4 旋鈕目標 2至旋鈕目標 4。對於 K1（旋鈕目標 1），選擇由3 K2至 K4的旋鈕控制的參數。 與 K1相同。

Pedal

踏板。指定插在 cl SUSTAIN/ASSIGNABLE JACK中的踏板的功能。

保持：按用踏板延音的音符。延音效果產生。

柔音：輕踩踏板調低音符的音量。

抽選延音（Sostenut）：鍵盤琴鍵被按下的過程中踩踏板，只有已按下的鍵盤琴鍵的音符延續
（保持）。

步音序器的播放 /停止（SSEQ P/S）：踩踏板可開始或停止步音序器的序列播放。
樂句音序器的播放 /停止（Phrase P/S）：踩踏板可開始或停止樂句音序器的樂句播放。
樂句錄音（Phrase REC）：與樂句音序器的 bo REC鈕功能相同。
取樣循環器的播放 /停止（Lper P/S）：踩踏板可開始或停止取樣循環器的樣本播放。
取樣循環器的錄音（Lper Rec）：與取樣循環器的 bm REC鈕功能相同。

參照左側的單元

格。

Touch

觸鍵。指定鍵盤彈奏的觸鍵敏感度。

關（Off）：音符產生固定的音量，與擊鍵力度無關。
標準

輕：輕擊鍵能產生大音量。

參照左側的單元

格。

TchOffVel 釋鍵速率。在上述觸鍵曲線設定值為關的情況下指定音量。 0至 127

Sequencers >Ent
音序器參數。此組包含步音序器（第 Ch-50頁）、樂句音序器（第 Ch-45頁）及琶音功能
（第 Ch-40頁）。

Tempo 速度。調節樂句音序器及步音序器的播放速度。用8 TEMPO亦能改變播放速度。 30至 255

Step SEQ Number 步音序器編號。指定步音序器的序列（第 Ch-52頁）。 Preset00至 User99

Solo1 Ch
步音序器的獨奏音軌聲部。步音序器的獨奏音軌 1通常為第 14聲部，但可以改變為第 1聲部
（區段聲部 1，第 Ch-55頁）。

1，14

Change 步音序器的變化時機。指定型被步音序器（第 Ch-56頁）改變時的切換時機。 Wait，Real，Beat

顯示幕 說明 設定
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Key Shift 步音序器移調。打開或關閉步音序器的移調功能（第 Ch-52頁）。 Off，On

Pattern 步音序器的型編號。選擇步音序器的型（第 Ch-50頁）。 1至 8

Arp On/Off 琶音開 /關。此設定關閉時琶音功能無效。 Off，On

Arp Type 琶音種類。指定琶音的種類（第 Ch-40頁）。 Preset00至 User99

ArpKeyRgLo
琶音鍵區低。指定可使用琶音功能的鍵盤區的最低音。此設定與琶音鍵區高組合使用，配置能使

用琶音功能的鍵盤區。
C-至 G9*

ArpKeyRgHi
琶音鍵區高。指定可使用琶音功能的鍵盤區的最高音。此設定與琶音鍵區低組合使用，配置能使

用琶音功能的鍵盤區。
C-至 G9*

Arp Hold 琶音保持開 /關。啟用 /禁用琶音保持（第 Ch-40頁）。 Off，On

Arp Synchro 琶音同步。切換琶音的同步設定（第 Ch-40頁）。 Off，On，S/S

Key Play 樂句鍵演奏。打開或關閉樂句音序器的樂句鍵演奏。 Off，On

Phrase 樂句編號。選擇樂句音序器的樂句（第 Ch-45頁）。 Preset00至 User99

PhrKeyRgLo
樂句鍵區低。指定樂句音序器的鍵演奏有效（第 Ch-46頁）的鍵盤區最低音。此設定與樂句鍵
區高組合使用，指定能使用鍵演奏功能的鍵盤區。

C-至 G9*

PhrKeyRgHi
樂句鍵區高。指定樂句音序器的鍵演奏有效（第 Ch-46頁）的鍵盤區最高音。此設定與樂句鍵
區低組合使用，指定能使用鍵演奏功能的鍵盤區。

C-至 G9*

Looper Number 循環器編號（looper number）。用於選擇取樣循環器的樣本編號（第 Ch-64頁）。 U:0至 U:9

Mltfunc Key >Ent

多功能鍵（Multi-function Key）。為從 C5到 C7（最多 25個琴鍵）的各鍵盤區分配不同的功
能。

Enable 打開或關閉多功能鍵。 Off，On

KeyRangeLow 多功能鍵的低音鍵盤區（Multi-function Key Range Low）。指定多功能鍵動作的最低鍵盤區。
• 使用鍵盤琴鍵可以指定設定。 C5至 C7

Key Setting >Ent

分配到鍵盤區的功能（Key Setting）。有兩種方法可以分配鍵盤區：在鍵盤區中彈琴鍵與用
9 PART減（–）及加（+）鈕。

--------- 表示未設定多功能鍵功能。
• 該功能未設定時，即使打開“Mltfunc Key >Enable＂亦不會有任何聲音發出。

–

Phrase 1

樂句1（Phrase 1）。指定播放聲部並進行樂句的播放。可以分配到鍵盤區C5至Bb5。配置了樂句
1後，樂句1的停止（Phrase 1 stop）操作可以用B5鍵執行。聲部5或聲部1可以選作播放聲部。
在播放過程中，畫面上聲部15頂部的段點亮。播放過程中移調值可以指定。
• 按bn MIXER可顯示播放聲部的混頻器設定畫面。
• 播放聲部的混頻器設定可保存為演設。

• Play Part: 1, 5
• Phrase: 

P:0-0至P:9-9，
U:0-0至U:9-9

• Key Shift:
–127至000至
+127 

顯示幕 說明 設定

C7C5

功能參數

鍵盤 功能

B
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Phrase 2

樂句2（Phrase 2）。指定播放聲部並進行樂句的播放。可以分配到鍵盤區C6至Bb6。配置了樂句
2後，樂句2的停止（Phrase 2 stop）操作可以用B6鍵執行。聲部6或聲部1可以選作播放聲部。
在播放過程中，畫面上聲部16頂部的段點亮。播放過程中移調值可以指定。
• 按bn MIXER可顯示播放聲部的混頻器設定畫面。
• 播放聲部的混頻器設定可保存為演設。

• Play Part: 1, 6
• Phrase: 

P:0-0至P:9-9，
U:0-0至U:9-9

• Key Shift:
–127至000至
+127 

Tempo 速度（Tempo）。改變速度（tempo）。此設定選擇為 TAP時，與 TAP鈕的作用相同。其他設
定被選擇時，速度根據右欄中表示的設定改變。

TAP, +, –, 
30至 255

Tone 音色（Tone）。按音色指定的鍵盤區中的琴鍵時，指定區段的音色根據音色內容改變。

• Zone: 1, 2, 3, 4
• Tone: 數字可以用

+, –, 或“Zone 
Param >Tone＂
選擇

Step Seq 步音序器（Step Sequencer）。改變正在演奏的序列。
+, –, 
P:0-0至 P:9-9，
U:0-0至 U:9-9

Chain 鏈（Chain）。切換並打開鏈。
+, –, 
U:0-0至 U:9-9

DSP
DSP（DSP）。選換DSP。關閉後，合唱/DSP選擇（第Ch-38頁）設定變為合唱。但獨奏合成
器音色被選擇時不能選換DSP。

Off, +, –, ton, 
P:0-0至P:9-9，
U:0-0至U:9-9

DSP Line DSP線路（DSP Line）。為所選聲部打開或關閉 DSP線路的選擇。 01至 16

Note 音符（Note）。根據指定的聲部編號（Part）、鍵盤琴鍵（Key）及速度（Velocity）設定產生
音符。

• Part: 01至16
• Key: C-至G9*
• Velocity: KeyOn, 

001至127

Ctrl Chng
控制變化（Control change）。根據指定的聲部編號（Part）、控制編號（Control）及數值
（Value）產生控制變化。數值為 KeyOn時，產生鍵開速度值。但請注意，鍵盤琴鍵被鬆開時不
產生 000值。

• Part: 01至16
• Control: 

000至119
• Value: KeyOn, 

000至127

Prog Chng 庫 MSB的程式變化（Program change）。根據指定的聲部編號（Part）、庫 MSB（Bank 
MSB）及數值（Value）產生程式變化。

• Part: 01至16
• Bank MSB: 

000至127
• Value: 

000至127

Ch Press 頻道觸鍵（Channel Pressure）。根據指定的聲部編號（Part）及數值（Value）產生頻道觸
鍵。觸後頻道。鍵盤琴鍵被鬆開時產生 000值。

• Part: 01至16
• Value: KeyOn, 

001至127

Pitch Bend 彎音輪（Pitch Bender）。根據指定的聲部編號（Part）及數值（Value）產生彎音。鍵盤琴鍵
被鬆開時產生 000值。

• Part: 01至16
• Value: KeyOn, 

–256至000至255

Poly Press
多重音觸鍵（Polyphonic Key Pressure）。根據指定的聲部編號（Part）、鍵盤琴鍵（Key）及
數值（Value）產生多重音觸鍵。鍵盤琴鍵被鬆開時產生 000值。
• 使用鍵盤琴鍵可以指定設定。

• Part: 01至16
• Key: C-至G9*
• Value: KeyOn, 

001至127

Effect >Ent
音效參數。此組包含音效設定（第 Ch-37頁）。有關組項目的詳細說明請參閱“音效設定＂一
節（第 Ch-38頁）。

MIDI >Ent MIDI的參數。此組包含 MIDI參數（第 Ch-82頁）的設定。用9 PART減（–）及加（+）鈕
選擇合成器 16個音源之一進行編輯。

Ext Out Ch 外部輸出頻道。指定 MIDI傳送頻道來向外接目的地（第 Ch-82頁）傳送各聲部的訊息。 1至 16

Ext In Ch 外部輸入頻道。此為各聲部接收 MIDI訊息的頻道。 Off, 1至 16

顯示幕 說明 設定

B
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Ch-77

* 畫面上的“C-＂表示C-1（比C0低一個八度）。

MIDI Out MIDI輸出開 /關。指定各聲部訊息的 MIDI傳送是否從 ck MIDI OUT/THRU進行。 Off，On

USB Out USB輸出開 /關。指定各聲部訊息的 MIDI傳送是否從 ck USB進行。 Off，On

顯示幕 說明 設定
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其他實用功能

混頻器能調節合成器音源聲部（聲部 01至 16，外部輸入聲
部，第 Ch-18頁）的音色、音量及其他設定 *，請查看畫面上
聲部間的平衡。

* 影響單獨聲部的設定稱為“聲部設定＂，而影響所有聲部的
設定稱為“主設定＂。

1. 按 bn MIXER。
混頻器畫面出現。

2. 用9 PART減（–）及加（+）鈕選擇要配置其設
定的聲部。

3. 用 br游標（U, q, w, I）鈕選擇所需要的項
目，然後用 bp 旋鈕或 br減（–）及加（+）鈕
改變其設定。
• 有關各設定的詳細說明第 Ch-80頁上的“混頻器設定＂

4. 設定完成後，按 bn MIXER退出混頻器畫面。

9

7 bn bp

br

5

bk

4

2

混頻器的使用

要執行的調節： 選擇的聲部：

聲部 01至 16的單獨設定
（第 Ch-80頁）

All, 01 至 16
• 選擇“All＂可以批量調節01至16的所
有聲部。要選擇“All＂，“01＂顯示
時按9 PART減（–）鈕一次。

主設定（第 Ch-80頁） Master
• 要選擇“Master＂，“01＂顯示時按
9 PART減（–）鈕兩次。

外部輸入聲部設定
（第 Ch-80頁）

Ext
• 要選擇“Ext＂，“01＂顯示時按9 

PART減（–）鈕三次。

正在配置的聲部 目前的聲部設定

設定項列表 表示正在配置的聲部
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用5 1/9至 MASTER的滑鈕及4步（1至 16）鈕可即時
改變混頻器的設定。

1. 按 bn MIXER。
混頻器畫面出現。

2. 用2 KEY SHIFT，SLIDER A/B及 1-8/9-16鈕改變
分配在5 1/9至 MASTER滑鈕的聲部。
• 按上述按鈕之一可點亮或熄滅鈕燈。

3. 撥動滑鈕，調節分配在滑鈕上的聲部的設定。
• 用 br游標（U, q, w, I）鈕選擇設定項。

4. 用4的 1至 16鈕打開或關閉聲部 01至 16。
• 按一個按鈕可使其點亮（打開）或熄滅（關閉）。
• 按住一個按鈕可打開其聲部，同時關閉所有其他聲部
（獨奏模式）。再次按相同的按鈕可退出獨奏模式。
例如：要進入聲部 08的獨奏模式時

使用滑鈕及步鈕的即時設定分配

2

熄滅
點亮

Master
Ext

熄滅
點亮

聲部 01 - 08
聲部 09 - 16

熄滅
點亮

聲部 01至 08（或 09至 16）
所有聲部（僅最左邊的滑鈕）

4

點亮

按住片刻。
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■聲部 01至聲部 16的設定

■外部輸入聲部的設定

■主設定

混頻器設定

顯示幕 說明 設定

Part 聲部開 /關。打開或關閉各聲部。此參數與由4 1至 16鈕（第 Ch-79頁）打開或關閉的參數相同。 Off，On

Tone

聲部的音色。此為各聲部的音色。
當此項目被選擇時，可以使用與在音色模式中使用的相同的操作步驟選擇音色。
• 在畫面上帶DSP音色的音色名旁邊有DSP（第Ch-37頁）。

聲部 01： 
Solo Synth P000 至
PCM Drum U309
聲部 02至 16： 
PCM Tone P100至
PCM Drum U309

Volume 聲部的音量。此為各聲部的音量。 0至 127

Pan 聲部的立體音位。調節立體聲的左右音位。 –64至 0至 +63

CoarseTune 聲部的粗調音。以半音為單位移位音符的音高。 –12至 0至 +12

FineTune 聲部的微調音。以分為單位移位音符的音高。 –99至 0至 +99

BendRange 聲部的彎音範圍。指定（以半音為單位）轉動 bt BENDER輪時音高改變的最大限。 –24至 0至 +24

DSP Line 聲部的 DSP線路。指定 DSP（第 Ch-36頁）是否作用於各聲部的音符。 Off，On

Rev Send 聲部的回響傳送。控制回響音效（第 Ch-36頁）如何作用於各聲部。 0至 127

Cho Send 聲部的合唱傳送。控制合唱音效（第 Ch-36頁）如何作用於各聲部。 0至 127

顯示幕 說明 設定

Part

與“聲部 01至聲部 16的設定＂（第 Ch-80頁）相同。

Volume

Pan

DSP Line

Rev Send

Cho Send

N.Thresh 噪音門的閾值。通過切去音量低於本設定值的所有輸入音來減少噪音。 0至 127

N.Release 噪音門的釋放。輸入音切斷的時間，當輸入音量下降到噪音門閾值以下時切斷。 0至 127

Auto Level 自動音量控制。自動調節輸入訊號的音量。設定值越大，效果越強。 Off, 1至 3

顯示幕 說明 設定

Volume 主音量。調節所有聲部的音量。 0至 127

Pan 主立體音位。調節所有聲部的立體聲的左右音位。 –64至 0至 +63
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Ch-81

下列為合成器的通用設定。
• 調音（音高的微調音）
• 本機控制
• 主粗調音（以半音為單位調節音符的音高）
• 初始開機模式
• 顯示幕對比度
• 自動關機的開 /關（第 Ch-10頁）

1. 按7 SETTING。
設定畫面出現，“General >Ent＂處於被選擇狀態。

2. 按 br ENTER。

3. 用 br游標（U, q, w, I）鈕選擇所需要的項目，然後用 bp旋鈕或 br減（–）及加（+）鈕改變其設定。

設定

4. 設定完成後，按7 SETTING退出設定畫面。

合成器的通用設定

顯示幕 說明 設定

Tuning 調音。以 0.1赫茲為單位微調合成器的音高。 415.5至 465.9 Hz

M.Coarse 主粗調音。以半音為單位調節合成器的全體音高。 –24至 0至 +24

Local Ctrl 本機控制。關閉本機控制能切斷合成器的內部音源，按鍵盤琴鍵時沒有聲音產生。要用合成器的鍵盤及踏
板操作外接音源，不讓合成器自身產生聲音時請關閉本機控制。 Off，On

Start Up

啟動項。指定下列之一作為合成器的初始開機模式。

Perfm:演奏模式
Tone:音色模式
S.Seq:步音序器模式

參照左側的單元格。

Contrast 顯示幕對比度。調節顯示幕的對比度。 1至 17

Auto Power 自動關機功能的開 /關。關閉此設定時自動關機（第 Ch-10頁）不起作用。 Off，On
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Ch-82

MIDI是Musical Instrument Digital Interface（樂器數位介面）的縮寫，是關於數位訊號及連接器的世界標準的名稱。通過 MIDI可
在不同廠家生產的樂器和電腦（機器）之間互傳音樂資料。

有關本合成器的 MIDI規格的詳情，請參閱下示 URL網站上的“MIDI應用＂文件。
http://world.casio.com/

• 使用另購的或市賣的MIDI纜線連接合成器的 MIDI端子與其他電子樂器，可進行MIDI資料的互傳（第 Ch-8頁）。
• 有關連接電腦的說明請參閱第 Ch-92頁。
• 有關合成器的各聲部（第 Ch-78頁）與 MIDI IN及MIDI OUT頻道之間關係的資訊，請參閱“可編輯的演設參數表＂
（第 Ch-73頁）。

• 本合成器符合通用 MIDI標準 1（GM）。

1. 按7 SETTING。

2. 用 br向下（w）鈕選擇“MIDI >Ent＂後按 br ENTER。

3. 用 br游標（U, q, w, I）鈕選擇所需要的項目，然後用 bp旋鈕或 br減（–）及加（+）鈕改變其設定。

設定

MIDI的使用

什麼是 MIDI？

MIDI設定

顯示幕 說明 設定

Device ID
裝置 ID（device ID）。為 MIDI系統專用訊息的傳送 /接收選擇合成器的 ID編號。
• 當“All＂被選擇時，無論ID編號是什麼，系統專用訊息都傳送。
• 有關ID編號的詳細說明，請參閱http://world.casio.com/處的MIDI執行說明。

1至 16，ALL

Basic Ch 基本頻道（basic channel）。指定“Perform NRPN＂、“S.Seq NRPN＂及下述其他 MIDI訊息的接收頻
道。 1至 16

MIDIOutSel

MIDI OUT選擇（MIDI OUT select）。指定作為 MIDI OUT輸出的內容。*
KEY（鍵盤）：合成器的鍵盤彈奏、操作等。
MIDI（MIDI IN） :通過 ck MIDI IN（MIDI THRU）輸入的訊息
USB（USB IN） :通過 ck USB輸入的訊息

參照左側的單元格。

USBOutSel
USB 輸出選擇（USB out select）。指定作為 USB out輸出的內容。*
KEY（鍵盤）：鍵盤及其他合成器的操作。
MIDI（MIDI IN） :通過 ck MIDI IN輸入的訊息

參照左側的單元格。

MIDI In MIDI IN開 /關（MIDI IN啟用）。此設定打開時，合成器的內部音源反映通過 ck MIDI IN輸入的訊息。 Off，On

USB In USB IN開 /關（USB IN啟用）。此設定打開時，合成器的內部音源反映通過 ck USB輸入的訊息。 Off，On

Sync Mode

同步模式（sync mode）。設定合成器與外接裝置之間的 MIDI同步。*
關：不同步

Mast（主控）：從音序器輸出時鐘、開始 /停止（步音序器）及其他訊號，對外接裝置進行控制。
Slav（從屬）：從外接裝置接收時鐘、開始 /停止及其他訊號。
• 除非接收到時鐘訊號，否則不能播放步音序器及樂句音序器。開始/停止訊號被解釋為步音序器的開始/
停止。

參照左側的單元格。

Perform NRPN 演設 NRPN變化（performance NRPN change）。
當此設定打開時，合成器的演設（第 Ch-72頁）可以通過 MIDI NRPN訊息從外接裝置進行選擇。 Off，On

S.Seq NRPN 步音序器 NRPN變化（step Sequencer NRPN Change）。當此設定打開時，合成器的序列
（第 Ch-52頁）可以通過 MIDI NRPN訊息從外接裝置進行選擇。 Off，On

Phrase NRPN 樂句 NRPN變化（phrase NRPN change）。當此設定打開時，合成器的樂句（第 Ch-45頁）可以通過
MIDI NRPN訊息從外接裝置進行選擇。 Off，On
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其他實用功能

Ch-83

* 要使對設定的變更起作用時，關閉合成器的電源後再重新打開。每當您退出設定畫面時，有效設定的訊息出現在畫面上。

4. 設定完成後，按7 SETTING退出設定畫面。

• 使用演設資料的編輯操作亦能改變MIDI資料的傳送頻道及配置其他設定。有關詳情請參閱“MIDI >Ent＂組（第 Ch-76頁）。

使用下述操作可以刪除用戶音色、用戶序列及您建立的其他資料。

1. 請參照“如何將合成器的資料保存至記憶卡＂一節（第 Ch-88頁）中的第 2步中的表，執行刪除資料的類型所
需要的操作。

2. 用 br向上（q）及向下（w）鈕將項目選擇游標（0）移動到“Clear USER＂，然後按 br ENTER。
• 如下所示選單畫面出現。下示示範畫面為當您在步音序器模式中執行本操作時出現的畫面。

• 對於樂句音序器，樂句資料的大小亦顯示。

3. 用 bp旋鈕或 br減（–）及加（+）鈕選擇要刪除的用戶資料。

4. 按 br ENTER鈕。

5. 畫面上出現“Sure?＂訊息後，按 br YES鈕進行刪除或按 br NO鈕取消操作。

Arp NRPN 琶音 NRPN變化（arpeggio NRPN change）。當此設定打開時，合成器的琶音（第 Ch-40頁）可以通
過 MIDI NRPN訊息從外接裝置進行選擇。 Off，On

合成器中保存的資料的刪除

顯示幕 說明 設定
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Ch-84

使用下述操作可以使合成器的設定及資料返回初始預設值。

1. 按7 SETTING。

2. 按 br ENTER。

3. 用 br游標（U, q, w, I）鈕選擇“Initialize 
>Ent＂後按 br（ENTER）。
INITIALIZE畫面出現。

4. 用 br向上（q）及向下（w）鈕選擇所需要的

初始化選項。

初始化選項

5. 按 br ENTER。
此時“Sure?＂應出現在畫面上。

6. 按 br YES。
刪除完畢時“Complete!＂訊息出現在畫面上。

7. 按7 SETTING退出設定畫面。
• 需要時，可以訪問 CASIO網站
（http://world.casio.com/），下載合成器的出廠預設設定
及資料，並傳送到合成器中。

要與電腦連接時，請參閱“電腦的連接＂一節

（第 Ch-92頁）。

使用下述操作步驟可播放合成器內置的示範曲，以及播放記憶
卡上保存的 SMF（標準 MIDI檔案）音樂檔案。

1. 同時按7 SETTING及7 WRITE。

2. 用 br向上（q）及向下（w）鈕選擇要執行的

播放的類型。

自動播放的種類

合成器的全體設定及資料的初始化

顯示幕 說明

Parameter >Ent 僅參數。初始化顯示幕對比度（第 Ch-81頁）之
外的所有合成器設定。

All >Ent 所有設定及資料。將所有合成器的設定及資料返回
初始預設值。亦刪除用戶波形。

如何播放示範曲或記憶卡上的檔案

顯示幕 說明

Demo >Ent 示範曲（Demo）。用於播放合成器的內置示範
曲。

Smf >Ent

SMF（Standard MIDI File）音樂檔案。用於播放
插在合成器卡槽中的記憶卡上的 SMF音樂檔案。
• 可播放的音樂檔案為SMF格式0及1的MIDI檔案
（MID）。

• 請確認要播放的資料在記憶卡上的MUSICDAT資
料夾（第Ch-89頁）中。
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3. 按 br ENTER。
播放畫面出現。
• 對於示範曲，播放自動開始。對於 SMF音樂檔案，用

br減（–）及加（+）鈕選擇一個檔案後按 bk 
START/STOP開始播放。

• 播放進行過程中，用 bp旋鈕或 br減（–）及加（+）
鈕可改變為其他樂曲或檔案進行播放。
您還可以使用四個 bk鈕進行快進或其他播放操作，如
下所述。

示範曲播放畫面

4. 按 bk START/STOP。
播放停止，播放畫面結束。
• 同時按7 SETTING及 WRITE鈕或按br EXIT亦可停止
播放。

樂曲名

操作指南
s（快退） : bk STEP –

d（快進） : bk STEP +

Y（停止） : bk START/STOP

k（暫停） : bk CHAIN
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記憶卡的使用

合成器的用戶區資料可以保存到記憶卡上，資料亦可以從記憶

卡載入合成器的記憶器。您還可以在合成器上播放記憶卡上保
存的音樂檔案（MIDI檔案）。

• 請使用滿足下列條件的記憶卡。
格式：SDHC或 SD
容量：32GB以下
不滿足上述條件的記憶卡不能使用。

• SDHC徽標為 SD-3C, LLC的商標。

■能保存到記憶卡中並從記憶卡導出
的資料

• 有關保存及導入個別資料項的資訊請參閱“如何在記憶卡
中保存合成器的資料＂（第 Ch-88頁）及“如何從記憶卡
載入資料＂（第 Ch-90頁）。

• 有關保存及載入所有資料的詳情請參閱“如何在記憶卡中
批量保存所有合成器的資料＂（第 Ch-89頁）及“如何從
記憶卡批量載入所有合成器記憶器的資料＂

（第 Ch-90頁）。

■可以從記憶卡直接播放的檔案

• 若要使用本合成器不支援的記憶卡上保存的資料，需要將資
料複製到合成器能識別的記憶卡上，或用資料編輯器將資料

從電腦傳送到合成器中。有關詳情請參閱“電腦的連接＂
（第 Ch-92頁）。

7 bn bp

br

3

bk

bq

可使用的資料的種類

資料種類 說明 （副檔名）

用戶演設 
（第 Ch-71頁）

用合成器編輯過的演設資料（ZPF）

用戶 PCM旋律音色 
（第 Ch-30頁）

用合成器編輯過的旋律音色資料
（ZTN）

用戶獨奏合成器音色 
（第 Ch-21頁）

用合成器編輯過的獨奏合成器音色資
料（ZSY）

用戶 PCM鼓音音色 
（第 Ch-31頁）

用合成器編輯過的鼓音音色資料
（ZDR）

用戶波形音色 
（第 Ch-32頁）

用合成器編輯過的用戶波形音色資料
（ZWT）

用戶 DSP資料 
（第 Ch-39頁）

用合成器編輯過的 DSP資料（DS7）

用戶步序列 
（第 Ch-61頁）

用合成器錄音的步序列資料（ZSS）

步序列鏈 
（第 Ch-62頁）

用合成器錄音的序列鏈資料（ZSC, 
MID（僅保存））

用戶樂句 
（第 Ch-49頁）

用合成器錄音過的樂句資料（ZPH）

用戶琶音 
（第 Ch-41頁）

用合成器編輯過的琶音資料（ZAR）

所有資料 所有上述資料（ZAL）

設定資料 用合成器配置的設定資料（ZST）

資料種類
說明 

（副檔名）

樂曲檔案 
（第 Ch-91頁）

SMF格式 0或 1的 MIDI檔案（MID）
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• 必須遵守記憶卡附帶文件中的注意事項。
• 記憶卡上有一個寫保護開關。要保護卡上的資料以防意外刪
除時可以使用此開關。

• 不要在下述情況下使用記憶卡。這些情況會使記憶卡上保存
的資料受到損壞。

– 在高溫、高濕或有腐蝕性氣體的地方。
– 有強靜電及數位噪音的地方。

• 在合成器中插入或取出記憶卡時切勿觸摸其觸點。
• 資料保存操作進行過程中，“Please Wait＂訊息將停留在畫
面上。此訊息顯示過程中不要執行任何其他操作。

關閉合成器的電源或取出記憶卡會使合成器的資料被清除或
損壞。還會使合成器在6 POWER被按下時不開機。此種
情況發生時請參照“疑難排解＂（第 Ch-95頁）。

• 若“No Card＂訊息出現在畫面上，則表示卡槽中沒有記憶
卡。有關插入有卡時畫面出現的內容的詳情請參閱“如何

播放記憶卡上的樂曲檔案＂（第 Ch-91頁）。
• 除記憶卡之外卡槽中切勿插入任何其他物品。否則有發生故
障的危險。

• 從您的手指或從記憶卡上傳到記憶卡槽的靜電可能會使合成
器發生故障。此種情況發生時，請關閉合成器的電源後再重

新打開。
• 在記憶卡槽中長時間使用後，記憶卡可能會變得很熱。此為
正常現象，並不表示發生了故障。

• 插入合成器時記憶卡的方向必須正確。強行將方向不正確的
記憶卡插入卡槽會損壞記憶卡及卡槽。

1. 記憶卡的正面必須朝上（您能看到），小心將卡
插入合成器的 SD卡槽（ck）中直到發出喀嚓聲
停止為止。

2. 要取出記憶卡時，請先向卡槽內按一下卡。
• 記憶卡脫離後彈出一部分。從卡槽中抽出記憶卡。

卡及卡槽須知 記憶卡的插入及取出

正面
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• 在首次使用之前請先格式化記憶卡。
• 在格式化記憶卡之前，必須首先確認上面沒有任何有用的資
料。

• 由本合成器進行的記憶卡格式化是一種“快速格式化＂。若
您要完全刪除記憶卡上的所有資料，請在電腦或一些其他設
備上進行格式化。

1. 在合成器的卡槽中插入要格式化的記憶卡。
• 確認記憶卡為可寫入狀態。檢查卡的寫保護開關，確認
其不在寫保護位置。

2. 按7 SETTING。

3. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“CardUtility＂，然後按 br 
ENTER。
• 此時“CARD UTIL＂畫面出現。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Format＂。

5. 按 br ENTER 鈕。
• 確認訊息“Sure?＂出現。

6. 按 br YES鈕格式化記憶卡，或按 br NO鈕取消操
作。
• 格式化操作進行過程中，“Please Wait＂訊息將停留在
畫面上。此訊息顯示過程中不要執行任何合成器操作。

格式化完畢後“Complete!＂將出現在畫面上。
• 格式化會需要幾分鐘的時間才能完成。

1. 將記憶卡插入卡槽中。

2. 根據您要在記憶卡上保存的資料的種類，請執行
下述操作之一。

記憶卡的格式化 如何在記憶卡中保存合成器的資料

如何將合成器的資料保存至記憶卡

要保存資料的
種類：

執行的操作：

一種用戶演設 1. 按7 PERFORM。
2. 按 br MENU。

一個用戶音色

（用戶獨奏合成器
音色，用戶 PCM
旋律音色，用戶

PCM鼓音音色，
用戶波形音色）

1. 按7 TONE。
2. 用 bp旋鈕或 bq數字鈕選擇音色。
3. 按 br MENU。

一個用戶波形 1. 按住 bm REC直到“LOOPER＂出現在畫面
上。

2. 按 br MENU。

一種用戶 DSP 1. 按住 bn MIXER直到 EFFECT畫面出現。
2. 用 br游標（U, q, w, I） 鈕將項目選擇
游標（0）移動到“DSP Select＂，然後按
br ENTER。
• 對於獨奏合成器音色，“Ent＂不出現。

3. 按 br MENU。

一個用戶步序列 1. 按7 STEP SEQ。
2. 按 br MENU。

一個步序列鏈 1. 按住 bk CHAIN直到 CHAIN畫面出現。
2. 按 br MENU。

一段用戶樂句 1. 按住 bo KEY PLAY直到 PHRASE畫面出
現。

2. 按 br MENU。

一種用戶琶音 1. 按住 bn ARPEGGIO直到 ARPEGGIO畫面
出現。

2. 按 br MENU。

所有資料 1. 按7 SETTING。
2. 用 br向上（q）及向下（w）鈕將項目
選擇游標（0）移動到“CardUtility＂，然
後按 br ENTER。

3. 用 br向上（q）及向下（w）鈕將項目
選擇游標（0）移動到“All data＂，然後按
br ENTER。

設定資料 1. 按7 SETTING。
2. 用 br向上（q）及向下（w）鈕將項目
選擇游標（0）移動到“CardUtility＂，然
後按 br ENTER。

3. 用 br向上（q）及向下（w）鈕將項目
選擇游標（0）移動到“SettingData＂，然
後按 br ENTER。
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3. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Card Save＂（要保存所有資料
時移動到“Save＂），然後按 br ENTER。
• 如下所示畫面出現。（作為范例，本操作的剩餘部分使
用的畫面，是從演奏模式執行這些操作時出現的畫

面。）

4. 按 br ENTER。

5. 輸入一個編號（以及相應的庫，如需要）及檔案
名。
執行下述操作能改變自動分配的初始預設檔案名。

• 有關輸入字符的詳細說明第 Ch-12頁上的“音色的創
建＂。

• 下列為可以選擇的字符。

• 檔案名最後面的三個字符是副檔名，表示保存在檔案中
的資料的種類。

6. 操作全部完畢後，按 br（ENTER） 鈕。

7. 畫面上出現“Sure?＂訊息後，按 br YES鈕進行
保存或按 br NO 鈕取消操作。

1. 按7 SETTING。

2. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“CardUtility＂，然後按 br 
ENTER。
• 此時“CARD UTIL＂畫面出現。

3. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“ALL Data＂，然後按 br 
ENTER。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Save＂。

• 剩餘操作步驟與“如何將合成器的資料保存至記憶卡＂
（第 Ch-88頁）中從第 3步開始的操作相同。

■記憶卡資料的儲存
上述操作在記憶卡上名為MUSICDAT的資料夾中保存合成器
的資料。
• 在合成器上格式化記憶卡時（第 Ch-88頁），MUSICDAT資
料夾自動被建立。

• 請注意，不在 MUSICDAT資料夾中的檔案都無法由本合成器
載入、刪除或更名。MUSICDAT資料夾內的任何子資料夾
中保存的所有檔案亦無法調用或刪除。

(1)用 br 游標 （U, I） 鈕移動游標至要改變的字符處。
(2)用 bp 旋鈕或 br減（–）及加（+）鈕改變字符。

9
J
T
'

8
I
S
_
`

7
H
R
&
~

6
G
Q
S
@

5
F
P
Z
}

4
E
O
Y
{

3
D
N
X
^

2
C
M
W
-

1
B
L
V
)

0
A
K
U
(

如何在記憶卡中批量保存所有合成器的資料
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• 請確認所有要載入的資料都在記憶卡上的MUSICDAT資料夾
中。

1. 將記憶卡插入卡槽中。

2. 請參照“如何將合成器的資料保存至記憶卡＂一
節（第 Ch-88頁）中的第 2步中的表，執行從卡
載入指定類型的資料所需要的操作。

3. 用 br向上（q）及向下（w） 鈕將項目選擇游
標（0）移動到“Card Load＂（要載入所有資料
時移動到“Load＂），然後按 br ENTER。
• 如下所示選單畫面出現。下示示範畫面為當您在步音序
器模式中執行本操作時出現的畫面。

4. 用 bp旋鈕或 br減（–）及加（+）鈕顯示要匯入
的檔案。

5. 用 br向下（w） 鈕向下移動游標，然後用 bp旋
鈕或 br減（–）及加（+）鈕顯示載入操作的目
的地。

6. 按 br ENTER鈕。

7. 畫面上出現“Sure?＂訊息後，按 br YES鈕進行
載入或按 br NO 鈕取消操作。

1. 按7 SETTING。

2. 用 br向上（q）及向下（w） 鈕將項目選擇游
標（0）移動到“CardUtility＂，然後按 br 
ENTER。
• 此時“CARD UTIL＂畫面出現。

3. 用 br向上（q）及向下（w） 鈕將項目選擇游
標（0）移動到“All Data＂，然後按 br 
ENTER。
• 剩餘操作步驟與“如何從記憶卡向合成器的記憶器載入
資料＂（第 Ch-90頁）中從第 3步開始的操作相同。

1. 將記憶卡插入卡槽中。

2. 按7 SETTING。

3. 用 br向上（q）及向下（w） 鈕將項目選擇游
標（0）移動到“CardUtility＂，然後按 br 
ENTER。
• 此時 CARD UTIL畫面出現。

4. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“Delete＂，然後按 br ENTER
鈕。
• 用於指定要刪除的檔案的畫面出現。

5. 用 bp旋鈕或 br減（–）及加（+）鈕顯示要刪除
的檔案。

6. 按 br ENTER鈕。

7. 畫面上出現“Sure?＂訊息後，按 br YES鈕進行
刪除或按 br NO 鈕取消操作。
• 按 br YES鈕顯示“Please Wait＂訊息（表示操作正
在進行）。此訊息顯示過程中不要執行任何操作。操作

完畢後“Complete!＂將出現在畫面上。

如何從記憶卡載入資料

如何從記憶卡向合成器的記憶器載入資料

如何從記憶卡批量載入所有合成器記憶器的資料

如何從記憶卡刪除檔案
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1. 將記憶卡插入卡槽中。

2. 按7 SETTING。

3. 用 br向上（q）及向下（w）鈕將項目選擇游

標（0）移動到“CardUtility＂，然後按 br 
ENTER。
• 此時 CARD UTIL畫面出現。

4. 用 br游標（U, q, w, I）鈕將項目選擇游標
（0）移動到“Rename＂，然後按 br ENTER 
鈕。
• 用於指定要更名的檔案的畫面出現。

5. 用 bp旋鈕或 br減（–）及加（+）鈕顯示要更名
的檔案。

6. 用 br 向左（U）及向右（I）鈕將游標移動到要

改變名稱字符的位置，然後用 bp 旋鈕或 br減
（–）及加（+）鈕選擇所需要的字符。

7. 名稱輸入完畢後，按 br ENTER鈕。

8. 畫面上出現“Sure?＂訊息後，按 br YES 鈕對檔
案進行更名或按 br NO 鈕取消操作。
• 按 br YES 鈕顯示“Please Wait＂訊息（表示操作正
在進行）。此訊息顯示過程中不要執行任何操作。操作
完畢後“Complete!＂將出現在畫面上。

合成器能播放您用電腦保存到卡上的音樂檔案。
有關播放方法的詳細說明請參閱第 Ch-84頁上的“如何播放
示範曲或記憶卡上的檔案＂一節。

如何重新命名記憶卡上的檔案

如何播放記憶卡上的樂曲檔案
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電腦的連接
您可以連接合成器與電腦並在其間交換MIDI資料。您演奏的
資料可以從合成器傳送到電腦上正在運行的市賣音樂軟體中，

或將MIDI資料從電腦傳送到合成器進行播放。

要傳送及接收MIDI資料，電腦系統必須符合下列最低要求。
在與合成器連接之前，請檢查並確認電腦符合這些要求。

• 作業系統

• USB埠

• 不要與不符合上述要求的電腦進行連接。否則會使電腦出現
問題。

• 必須嚴格按照下述步驟進行操作。連接錯誤將使資料無法傳
送及接收。

1. 關閉合成器的電源，然後啟動電腦。
• 先不要起動電腦上的音樂軟體！

2. 電腦啟動後，用市賣 USB電纜將其與合成器連接。

3. 打開合成器的電源。
• 若是第一次連接合成器與電腦，傳送及接收資料所需要
的驅動軟體將自動被安裝在電腦上。

4. 在電腦上啟動市賣音樂軟體。

5. 配置音樂軟體的設定，選擇下列 MIDI裝置之一。

• 有關如何選擇MIDI裝置的說明，請參閱音樂軟體附帶的
用戶說明書。

• 在起動電腦上的音樂軟體之前，必須先打開合成器的電源。

• 首次連接成功後，當您關閉電腦及 /或合成器的電源時，不
拔下 USB電纜亦可。

• 通過改變MIDI資料的傳送頻道或其他設定可以改變合成器的
MIDI設置。有關詳情請參閱“MIDI設定＂
（第 Ch-82頁）。

• 有關由本合成器傳送及接收的MIDI資料所符合的規格及連接
的詳情，請參閱下示 URL提供的最新資訊。
http://world.casio.com/

電腦系統的最低要求

Windows® XP（SP2以上）*1

Windows Vista® *2

Windows® 7 *3

Mac OS® X（10.3.9, 10.4.11, 10.5.X, 10.6.X, 10.7.X）

*1: Windows XP Home Edition
Windows XP Professional（32位元）

*2: Windows Vista（32位元）
*3: Windows 7（32位元，64位元）

如何連接合成器與電腦

CASIO USB-MIDI：（對於Windows 7，Windows Vista，
Mac OS X）

USB音頻裝置：（對於Windows XP）

電腦的 USB埠

A插頭

B插頭

合成器的 USB埠

USB電纜
（A-B型）
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用合成器保存的用戶音色、樂句及其他資料可以傳送到電腦上
進行儲存。以後需要時，資料又可傳回合成器。

方便時您還可以在電腦上編輯音色、演設及其他合成器的資

料。要進行這些操作需要專用的 Data Editor（資料編輯器）
應用程式。

1. 訪問下示 URL的 CASIO WORLDWIDE網站。
http://world.casio.com/

2. 在此網站中選擇地區或國家。

3. 訪問到地區網站後，找到本產品的 Data Editor所需
要的電腦系統最低要求。
• 在本產品的產品介紹網頁中有 Data Editor資訊的鏈接。
若您找不到此鏈接，請在所在地區網站的搜索窗內輸入
本產品的型號名並進行搜索。

• 請注意，網站的內容如有變更，恕不另行通知。

4. 檢查您的電腦系統是否符合 Data Editor的最低要
求。

5. 在電腦上下載 Data Editor及其用戶手冊。

6. 按照您在第 5步下載的 Data Editor用戶手冊中的說
明安裝並使用 Data Editor。

7. 使用 Data Editor用戶手冊中的操作步驟傳送及編
輯資料。
• 有關能傳送及編輯的資料種類的說明，請參閱 Data 

Editor用戶手冊。

如何將合成器的資料保存及載入電腦
並在電腦上編輯合成器的資料
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參考資料

錯誤訊息

顯示訊息 原因 對策

Format 1.記憶卡的格式與本合成器不相容。 1.在合成器上格式化記憶卡（第 Ch-88頁）。

2.記憶卡的容量超過了 32GB。 2.請使用 32GB以下容量的記憶卡。

3.您使用的是 SDXC卡。 3.不能使用 SDXC卡。請使用 SD或 SDHC記憶卡。

4.記憶卡有問題。 4.使用其他的記憶卡。

Card Full 記憶卡上已沒有足夠的存儲空間。 刪除記憶卡上的一些檔案，為新資料騰出空間

（第 Ch-90頁），或使用其他卡。

Card R/W 記憶卡上的資料已損壞。 使用其他的記憶卡。

No Card 1.插在合成器卡槽中的記憶卡沒有正確插入。 1.在卡槽中正確插入記憶卡。

2.有些操作進行過程中取出了記憶卡。 2.任何操作進行過程中都不要取出記憶卡。

No Data 您要向記憶卡保存不含任何資料的合成器的用戶區
（用戶節奏、用戶樂曲等）。

選擇含有資料的用戶區。

No File 1.記憶卡上沒有MUSICDAT資料夾
（第 Ch-89頁）。

1.在記憶卡上建立MUSICDAT資料夾或在合成器上
格式化記憶卡（第 Ch-88頁）。

2. MUSICDAT資料夾中沒有可載入或可播放的檔案。 2.將要載入或播放的檔案移動到記憶卡的 MUSICDAT
資料夾中。

Not SMF0/1 您試圖播放 SMF格式 2的檔案。 本合成器只能播放格式 0或格式 1的 SMF。

Protect 記憶卡處於寫保護狀態。 切換記憶卡的寫保護開關，使其可寫入。

Read Only 記憶卡上已存在與您要使用的檔案名相同的只讀檔

案。

• 使用其他檔案名保存新檔案。
• 移除現有檔案的只讀屬性並用新檔案覆蓋。
• 使用其他的記憶卡。

Size Over 1.記憶卡上的樂曲資料過大，無法播放。 1.本合成器只能播放最大 320KB的樂曲檔案。

2.您要載入的檔案過大。 2.下列為將資料載入合成器的記憶器中時的大約最大
檔案大小（資料項分別）。

用戶樂句：8KB
共能載入約 128KB的用戶樂句（所有 100個用戶
樂句的合計）。

3.鏈 SMF資料過大，無法變換並保存到卡上。 3.合成器能變換最大 320KB的鏈 SMF資料並將其保
存到卡上。

Wrong Data 1.記憶卡上的資料已損壞。 使用其他的記憶卡。

2.記憶卡上含有本合成器無法使用的資料。

Memory Full 記憶器中已沒有樂句音序器操作所需要的存儲容量。 縮短樂句使其佔用更少的記憶空間。
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File Name 重新命名記憶卡上的檔案時，試圖指定已被使用的檔

案名。

使用其他名稱。

Invalid Tone 您為 PART1（ZONE1）以外的聲部選擇了合成器音
色。

只能為 PART1（ZONE1）選擇合成器。

Battery Low 電池電量不足。 更換電池或改用交流電變壓器供電（第 Ch-9頁）。

Write Error! 內存寫入失敗。 再試一次。

疑難排解

現象 對策

附件

我找不到產品附帶的配件。 仔細檢查包裝材料中的所有物品。

電源要求

電源不打開。 • 檢查交流電變壓器或確認電池的朝向正確（第 Ch-9頁）。
• 更換新電池或改用交流電變壓器供電（第 Ch-9頁）。

按6 POWER後畫面點亮片刻，但不開
機。

請完全按下6 POWER打開電源。

合成器大音量輸出聲音，然後突然斷電。 更換新電池或改用交流電變壓器供電（第 Ch-9頁）。

數分鐘後合成器突然斷電。 自動關機功能（第 Ch-10頁）動作時會發生此種情況。

顯示幕

畫面一直熄滅或閃動。 更換新電池或改用交流電變壓器供電（第 Ch-9頁）。

畫面的內容只能垂直看時才能看得到。 產品硬體規格的限制。這不表示發生了故障。

聲音

按任何鍵盤琴鍵時都沒有反應。 • 調節主音量（第 Ch-12頁）。
• 本合成器不內置揚聲器。除非連接一些能輸出聲音的裝置（第 Ch-8頁），否則其
不產生聲音。

啟動步音序器後沒有聲音產生。 琶音功能被步音序器的啟動觸發後，直到您在鍵盤上彈奏為止序列不開始。

音符一直演奏，不停止。 更換新電池或改用交流電變壓器供電（第 Ch-9頁）。

演奏過程中有些音符丟失了。 當要同時演奏的音符數超出了最大多重音值 64（有些音色是 1至 32）時，超出的
音符被切去。這不表示發生了故障。

我所配置的音量或音色設定改變了。 • 調節主音量（第 Ch-12頁）。
• 更換新電池或改用交流電變壓器供電（第 Ch-9頁）。

即使我改變了擊鍵力度，輸出音量仍沒有

變化。

改變觸鍵設定（第 Ch-74頁）。

顯示訊息 原因 對策
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在有些鍵盤區內，音量及音質與其他鍵盤

區內的有輕微的不同。

產品系統的限制。這不表示發生了故障。

對於有些音色，在鍵盤的一端八度不改
變。

產品系統的限制。這不表示發生了故障。

音符的音高與其他伴奏樂器不一致，或與

其他樂曲一起演奏時聲音奇怪。

檢查移調及八度移位設定（第 Ch-36頁）。

使用獨奏合成器音色彈奏高音時，聲音中
混有數位噪音。

產品系統的限制。這不表示發生了故障。

音符的回響好象突然改變了。 檢查並調節回響設定（第 Ch-36頁）。

電腦連接

無法在合成器與電腦之間交換資料。 • 檢查並確認 USB電纜已連接在合成器及電腦上，並且電腦上的音樂軟體已選擇了
正確的裝置（第 Ch-92頁）。

• 關閉合成器的電源，然後在電腦上結束音樂軟體。接著，重新打開合成器的電
源，然後在電腦上重新啟動音樂軟體。

現象 對策

XWG1_ch.book  Page 96  Wednesday, January 18, 2012  10:34 AM



參考資料

Ch-97

規格

型號 XW-G1

鍵盤 61標準尺寸琴鍵

觸鍵感應 2種，關閉

最大多重音 64音符（有些音色為 1至 32音符）

音色 420種預設，220種用戶

獨奏合成器音色 100種預設，100種用戶

PCM旋律音色 300種預設，100種用戶

PCM鼓音音色 20種預設，10種用戶

用戶波形音色 10種用戶

音效

回響 系統回響

合唱 系統合唱

DSP 100種預設，100種用戶
53種（46種標準，7種獨奏合成器）

主均衡器 4頻段

示範曲 3首樂曲

演設功能 100種預設，100種用戶

樂句功能

預設樂句 100

用戶樂句 100

播放模式 一次，循環

記憶器容量 128KB

其他 覆蓋錄音

步音序器功能

預設序列 100

用戶序列 100

音軌數 單聲道：8，多聲道：1， 控制：4
型 每個序列 8種

鏈 100

最多步 16

其他 樂句功能控制

取樣循環器功能

用戶範例 10

取樣頻率 42 kHz, 21 kHz

取樣頻道 立體聲，單聲道

量化 16位元

混頻器 16個內部聲部 +外部輸入聲部

其他功能

移調 ± 1 個八度（–12 至 0至 +12 個半音）

八度移位 ± 3個八度

調音 A4 = 415.5 - 440.0 - 465.9 Hz

琶音 預設： 100
用戶： 100

MIDI 16頻道多音色接收，GM標準 1
輪 彎音，變音

記憶卡

可使用的記憶卡 SD或 SDHC記憶卡，32GB以下

功能 SMF播放，檔案儲存，檔案調用，檔案刪除，卡格式化
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• 設計及規格如有變更，恕不另行通知。

輸入 /輸出

USB埠 B型

MIDI IN/OUT端子 IN, OUT

延音 /分設插孔 標準插孔（延音，抽選延音，柔音，開始 /停止）

耳機插孔 立體聲標準插孔

線路輸出右，左 /單聲道插孔 標準插孔 × 2
輸出電阻：2.3kΩ，輸出電壓：最大 1.7V（RMS）

音頻輸入插孔 立體聲迷你插孔
輸入電阻：9kΩ，輸入電壓：200mV

樂器輸入插孔 標準插孔

輸入電阻：9kΩ，輸入電壓：200mV
麥克風輸入插孔 標準插孔（僅用於連接動態麥克風）

輸入電阻：3kΩ，輸入電壓：10mV
樂器輸入，麥克風輸入 A/D轉換： 42 kHz，10位元

電源插孔 9.5V DC

電源 雙路

電池 6節 D型鋅碳電池或鹼性電池

電池壽命 約 35個小時（鹼性電池，使用另選的 CASIO CP-16耳機）

交流電變壓器 AD-E95100L

自動關機 使用電池時在最後一次鍵操作約 6分鐘後，使用交流電變壓器時在最後一次鍵操作約 4小時
後。自動關機功能可以解除。

耗電量 9.5V = 4W

外形尺寸 94.8 × 38.4 × 12.4 cm

重量 約 5.4kg（不含電池）

必須閱讀及遵守下述操作須知。

■場所
本產品應避免放置在下列場所。
• 受直射陽光照射及濕度高的地方
• 溫度極端的地方
• 收音機、電視機、放像機或調諧器附近
上述裝置不會使本產品發生故障，但本產品可能會干擾附近

裝置的音頻或視頻接收。

■用戶維護保養
• 切勿使用苯、酒精、稀釋劑或其他化學試劑清潔本產品。
• 要清潔本產品或其鍵盤時，請使用蘸有水和中性清潔劑稀釋
溶液的軟布。請先將軟布完全擰乾後再進行擦拭。

■附件及另選件
只能使用本產品指定的配件。使用未指定的配件有造成火災、
觸電及人身傷害的危險。

■交流電變壓器使用須知
• 請使用距離較近的電源插座，以便在發生故障時或在其他必
要的情況下能隨時拔下交流電變壓器。

• 交流電變壓器只能在室內使用。不要在可能會濺上水或沾上
濕氣的環境中使用。不要在交流電變壓器上放置花瓶等任何
盛有液體的容器。

• 交流電變壓器應在乾燥的地方保管。
• 請在寬敞、通風的地方使用交流電變壓器。
• 切勿將報紙、桌布、窗帘或任何其他類似的物品蓋在交流電
變壓器上。

• 打算長期不使用本產品時請從電源插座拔下交流電變壓器。
• 切勿以任何方式修理或改造交流電變壓器。
• 交流電變壓器的使用環境
溫度：0至 40℃
濕度：10%至 90% RH

• 輸出極性﹕ &

■焊線
本產品的外表可能會有線條。這些“焊線＂是塑料壓模成型工

序的結果。不是裂紋或劃痕。

■樂器使用禮儀
使用本產品時，應總是想到周圍的人。在深夜演奏時，需要特
別注意音量，不要打擾其他人。深夜演奏時您還可以關上窗

戶，或使用耳機。

操作須知
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■標準 DSP類型
• 類型編號 01至 14為單類 DSP，而編號 15至 46為雙類 DSP。單類 DSP為單一結構，而雙類 DSP為兩種單類 DSP的組合。
• 雙類 DSP的名稱由其兩個組成要素的單類 DSP的名稱構成，以其作用的先後順序排列。例如，在該序列中名為
“Wah-Compressor＂的第 15種與“Wah＂及“Compressor＂有線連接。

• 有關能用各 DSP類型配置的參數的詳情，請參閱下表所示各節。

■獨奏合成器的 DSP類型

• 有關能對各種 DSP分別配置其設定的參數的說明請參閱“獨奏合成器的 DSP參數＂（第 Ch-102頁）。

DSP音效表

DSP類型表

此 DSP類型的資訊： 參閱：

單類（類型編號 01至 14） 標準 DSP的單類 DSP的參數（第 Ch-100頁）

雙類（類型編號 15至 46） 標準 DSP的雙類 DSP的參數（第 Ch-102頁）

類型編號 DSP類型名 畫面名

01 Wah Wah
02 Compressor Comp
03 Distortion Dist
04 Enhancer Enhance
05 AutoPan AutoPan
06 Tremolo Tremolo
07 Phaser Phaser
08 Flanger Flanger
09 Chorus Chorus
10 Delay Delay
11 Reflection Reflect
12 Rotary Rotary
13 RingModulator RingMod
14 Lo-Fi Lo-Fi
15 Wah-Compressor WahCmp
16 Wah-Distortion WahDst
17 Wah-Chorus WahCho
18 Wah-Flanger WahFln
19 Wah-Reflection WahRef
20 Wah-Tremolo WahTrm
21 Wah-AutoPan WahPan
22 Compressor-Wah CmpWah
23 Compressor-Distortion CmpDst

24 Compressor-Chorus CmpCho
25 Compressor-Flanger CmpFln
26 Compressor-Reflection CmpRef
27 Compressor-Tremolo CmpTrm
28 Compressor-AutoPan CmpPan
29 Distortion-Wah DstWah
30 Distortion-Compressor DstCmp
31 Distortion-Chorus DstCho
32 Distortion-Flanger DstFln
33 Distortion-Reflection DstRef
34 Distortion-Tremolo DstTrm
35 Distortion-AutoPan DstPan
36 Chorus-Reflection ChoRef
37 Chorus-AutoPan ChoPan
38 Flanger-Reflection FlnRef
39 Flanger-AutoPan FlnPan
40 Reflection-Distortion RefDst
41 Reflection-Chorus RefCho
42 Reflection-AutoPan RefPan
43 Tremolo-Distortion TrmDst
44 Tremolo-Chorus TrmCho
45 Tremolo-Flanger TrmFln
46 Tremolo-Reflection TrmRef

類型編號 DSP類型名 畫面名

類型編號 DSP類型名 畫面名

Bypass Bypass
01 Auto Pan AutoPan
02 Distortion Dist
03 Flanger Flanger

04 Chorus Chorus
05 Delay Delay
06 Ring Modulator RingMod

類型編號 DSP類型名 畫面名
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■標準 DSP的單類 DSP的參數

01: Wah
此為一種“wah＂音效，能根據 LFO自動影響頻率。
參數及值的範圍：

1 :Resonance（0至 127）
調節共鳴的強度。

2 :Manual（0至 127）
調節 wah濾音器的參考頻率。

3 :LFO Rate（0至 127）
調節 LFO的速率。

4 :LFO Depth（0至 127）
調節 LFO的深度。

5 :LFO Waveform（off, sin, tri, random）
選擇 LFO的波形。

02: Compressor
壓縮輸入訊號，有抑制音高電平發生變化的效果並能使經阻尼

的聲音持續時間更長。

參數及值的範圍：

1 :Attack（0至 127）
調節輸入訊號的擊鍵力度。較小的數值會促進壓縮操作，
抑制輸入訊號的擊鍵力度。較大的數值會延遲壓縮操作，
使擊鍵按原樣輸出。

2 :Release（0至 127）
調節從輸入訊號下降至某一水平的時點開始到壓縮操作停
止為止的時間。當擊鍵的感覺恰到好處時（聲音發生時無
壓縮），此參數設定得越低越好。要一直都進行壓縮時，
應設定為一個較高的數值。

3 :Level（0至 127）
調節輸出音量水平。

4 :Threshold（0至 127）
調節壓縮操作開始時的音量。

03: Distortion
對輸入訊號追加泛音的數位失真。
參數及值的範圍：

1 :Gain（0至 127）
調節輸入訊號的增益。

2 :Level（0至 127）
調節輸出音量水平。

04: Enhancer
移位輸入訊號的低音域音符及高音域音符，增加訊號的特。

參數及值的範圍：

1 :Low Frequency（0至 127）
調節低音域增強器的頻率。

2 :Low Phase（0至 127）
調節低音域增強器的位移量。

3 :High Frequency（0至 127）
調節高音域增強器的頻率。

4 :High Phase（0至 127）
調節高音域增強器的位移量。

05: Auto Pan
使用 LFO持續執行輸入訊號的左右立體音位調節。
參數及值的範圍：

1 :LFO Rate（0至 127）
調節立體音位的速率。

2 :LFO Depth（0至 127）
調節立體音位的深度。

3 :LFO Waveform（sin, tri）
選擇 LFO的波形。

4 :Manual（範圍 : –64至 0至 63）
調節立體音位（立體聲的位置）。
–64為最左，0為中央，63為最右。

06: Tremolo
用 LFO調節輸入訊號的音量。
參數及值的範圍：

1 :LFO Rate（0至 127）
調節顫音的速率。

2 :LFO Depth（0至 127）
調節顫音的深度。

3 :LFO Waveform（sin, tri）
選擇 LFO的波形。

07: Phaser
產生有特色的脈衝，用 LFO拓寬聲音，改變輸入訊號的相位
並與原輸入訊號混合。
參數及值的範圍：

1 :Resonance（0至 127）
調節共鳴的強度。

2 :LFO Rate（0至 127）
調節 LFO的速率。

3 :LFO Depth（0至 127）
調節 LFO的深度。

4 :LFO Waveform（sin, tri, random）
選擇 LFO的波形。

DSP參數列表
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08: Flanger
對聲音追加寬脈衝及金屬性回響。可選擇 LFO的波形。
參數及值的範圍：

1 :LFO Rate（0至 127）
調節 LFO的速率。

2 :LFO Depth（0至 127）
調節 LFO的深度。

3 :LFO Waveform（sin, tri, random）
選擇 LFO的波形。

4 :Feedback（0至 127）
調節反饋的強度。

09: Chorus
使聲音更深更寬。合唱類型可選。

參數及值的範圍：

1 :LFO Rate（0至 127）
調節 LFO的速率。

2 :LFO Depth（0至 127）
調節 LFO的深度。

3 :LFO Waveform（sin, tri）
選擇 LFO的波形。

4 :Feedback（0至 127）
調節反饋的強度。

5 :Type（mono, stereo, tri）
選擇合唱類型。

10: Delay
延遲輸入訊號並進行反饋，產生反復的音效並使聲音更寬。

參數及值的範圍：

1 :Delay Time（0至 127）
調節延遲時間。

2 :Feedback（0至 127）
調節延遲的反復。

3 :Ratio Lch（0至 127）
調節左頻道的延遲時間。此值是為延遲時間指定的速率
值。

4 :Ratio Rch（0至 127）
調節右頻道的延遲時間。此值是為延遲時間指定的速率
值。

5 :Wet Level（0, 1, 2, 3, 4, 5）
調節延遲音的音量。

6 :Type（1, 2）
選擇延遲類型。

7 :Tempo Sync（範圍：Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 
4/3, 3/2, 2）
調節音序器的速度與延遲時間的關係。
選擇為 Off時，Delay Time參數的目前設定用於延遲時
間。任何其他設定被選擇時，延遲時間與音序器的拍子同
步。
例如，選擇 1時延遲時間約等於一拍的長度。
（延遲時間與拍子不是精確的同步。）

重要！

調節延遲時間及類型時，有些設定可能會導致延遲音的移動。

11: Reflection
音效器從回響中抽取先期反射。為聲音添加聲樂存在感。

參數及值的範圍：

1 :Type（1, 2, 3, 4, 5, 6, 7, 8）
從八種反射形式之中進行選擇。

2 :Feedback（0至 127）
調節反射音的反復次數。

12: Rotary
模擬旋轉式揚聲器。
參數及值的範圍：

1 :Overdrive Gain（0, 1, 2, 3）
調節超速增益。

2 :Overdrive Level（0至 127）
調節超速的輸出音量。

3 :Speed（Slow, Fast）
在快與慢之間切換速度模式。

4 :Brake（Rotate, Stop）
停止揚聲器的旋轉

5 :Fall Acceleration（0至 127）
調節當速度模式從快切換到慢時的加速度。

6 :Rise Acceleration（0至 127）
調節當速度模式從慢切換到快時的加速度。

7 :Slow Rate（0至 127）
調節慢速模式中的揚聲器旋轉速度。

8 :Fast Rate（0至 127）
調節快速模式中的揚聲器旋轉速度。

13: Ring Modulator
用內部振蕩器訊號增加輸入記號，產生金屬類聲音。
參數及值的範圍：

1 :OSC Frequency（0至 127）
設定內部振蕩器的參考頻率。

2 :LFO Rate（0至 127）
調節 LFO的速率。

3 :LFO Depth（0至 127）
調節 LFO的深度。

4 :Type（1, 2, 3）

1 :延遲的反復取決於延遲時間。

2 :延遲的反復取決於延遲時間及 L/R比。

1 :僅輸出環形調製器訊號。

2 :輸出環形調製器訊號及輸入訊號。

3 :用作用於 2的合唱音效輸出訊號（環形調製器訊號及
輸入訊號）。
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14: Lo-Fi
為輸入訊號追加各種噪音再現反向 Lo-Fi音。
如同磁帶及錄音機一樣含有抖晃及擺動的旋轉波動，噪音 1生
成器生成連續的 FM無線類型，而噪音 2生成器生成錄音型的
唱針噪音。

參數及值的範圍：

1 :Wow and Flutter Rate（0至 127）
調節抖晃及擺動速率。

2 :Wow and Flutter Depth（0至 127）
調節抖晃及擺動深度。

3 :Noise1 Level（0, 1, 2, 3, 4, 5）
調節噪音生成器 1的音量。

4 :Noise2 Level（0, 1, 2, 3, 4, 5）
調節噪音生成器 2的音量。

5 :Noise2 Density（0, 1, 2, 3, 4, 5）
調節噪音生成器 2的頻率。

6 :Bit（0, 1, 2, 3）
使聲音失真。較大的數字產生較大的失真。

重要！
即使沒有輸入訊號，在沒有音符演奏時提高噪音的音量將使噪

音發出。

■標準 DSP的雙類 DSP的參數
雙類 DSP由兩種不同的單類 DSP組合構成。請使用下述操作
確定各雙類 DSP可以配置的參數，以及雙類 DSP的操作及設
定範圍。
例如﹕類型編號 29： Distortion-Wah
1.此 DSP類型名有兩個部分：左側部分及右側部分。

Distortion-Wah 3“Distortion＂及“Wah＂
2.通過查看下表中“類型名＂欄中的雙類 DSP的左側部分，
可找到可以配置的參數。

3.在第 Ch-100頁至第 Ch-102頁上“標準 DSP的單類 DSP
的參數＂的表中找到相同的類型名，並記下與上表的“可
配置的參數＂欄中列有的相同項目的操作及設定範圍。

4.然後，對雙類 DSP的參數名的右側部分反復執行上述第 2
步及第 3步操作。

■獨奏合成器的 DSP參數
• 當獨奏合成器音色被選擇時，（Param A）及（Param B）
是分配在5 8/16 及 MASTER 滑鈕上的參數。

（無編號）： Bypass
選擇此選項可禁用 DSP。
無參數

01: Auto Pan
參數及範圍

1 :LFO Waveform（範圍 : sin, tri）

2 :LFO Rate（範圍 : 0至 127）（Param A）

3 :LFO Depth（範圍 : 0至 127）（Param B）

4 :Manual（範圍 : –64至 0至 63）

02: Distortion
參數及範圍：

1 :Gain（範圍 : 0至 127）（Param A）

2 :Level（範圍 : 0至 127）（Param B）

03: Flanger
參數及範圍

1 :LFO Waveform（範圍 : sin, tri, random）

2 :LFO Rate（範圍 : 0至 127）（Param A）

3 :LFO Depth（範圍 : 0至 127）（Param B）

04: Chorus
參數及範圍

1 :LFO Waveform（範圍 : sin, tri）

2 :LFO Rate（範圍 : 0至 127）（Param A）

3 :LFO Depth（範圍 : 0至 127）（Param B）

類型名 可配置的參數

Wah LFO Waveform
LFO Rate
LFO Depth

Distortion Gain
Level

Chorus LFO Waveform
LFO Rate
LFO Depth

Flanger LFO Waveform
LFO Rate
LFO Depth

Reflection Feedback

Compressor Threshold
Level

Auto Pan LFO Waveform
LFO Rate
LFO Depth
Manual

Tremolo LFO Waveform
LFO Rate
LFO Depth

• 在“Distortion-Wah＂範例中，名稱的左側部分為
“Distortion＂，所以在上表中可以看到“Gain＂及
“Level＂參數可以配置。參照第 Ch-100頁上的“03: 
Distortion＂可以找到“Gain＂及“Level＂的作用及設
定範圍。

• 在參數設定畫面上出現的參數的編號從 1開始計數，各隨
後的參數的編號遞增。
“Distortion-Wah＂範例中的參數編號如下所示。
1: Gain
2: Level
3: LFO Waveform
4: LFO Rate
5: LFO Depth
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05: Delay
參數及範圍

1 :Delay Time（範圍 : 0至 127）（Param A）

2 :Feedback（範圍 : 0至 127）

3 :Damp（範圍 : 0至 3）
調節高音域的制音。最大制音中的 3個結果。

4 :Wet Level（範圍 : 0, 1, 2, 3, 4, 5）（Param B）

5 :Tempo Sync（範圍 : Off, 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 
4/3, 3/2, 2）

06: Ring Modulator
參數及範圍

1 :Frequency（範圍 : 0至 127）（Param A）
調節環形調節器的變音頻率。

2 :Dry Level（範圍 : 0至 127）
調節原音的音量。

3 :Wet Level（範圍 : 0至 127）（Param B）
調節環形調節器的音量。

• 有關上述中未包含的參數的資訊，請參閱“標準 DSP的單
類 DSP的參數＂（第 Ch-100頁）中名稱相同的參數的說
明。

可輸入的字符

XWG1_ch.book  Page 103  Wednesday, January 18, 2012  10:34 AM



F
u

n
ct

io
n

Tr
an

sm
it

te
d

R
ec

o
g

n
iz

ed
R

em
ar

ks

B
as

ic
 

C
h

an
n

el
1 

- 
16

1 
- 

16
1 

- 
16

1 
- 

16
D

ef
au

lt 
C

ha
ng

ed

N
o

te
N

u
m

b
er

0 
- 

12
7

0 
- 

12
7 
*
1

Tr
ue

 v
oi

ce

A
ft

er
 

To
u

ch

C
o

n
tr

o
l

C
h

an
g

e

X X
X O

P
it

ch
 B

en
d

er
O

O

K
ey

’s
C

h’
s

V
el

o
ci

ty
O

 9
nH

 v
 =

 1
 -

 1
27

X
 9

nH
 v

 =
 0

, 8
nH

 v
 =
*
*

O
 9

nH
 v

 =
 1

 -
 1

27
X

 9
nH

 v
 =

 0
N

ot
e 

O
N

N
ot

e 
O

F
F

M
o

d
e

M
od

e 
3

X

0 
- 

12
7

M
od

e 
3

X
D

ef
au

lt
M

es
sa

ge
s

A
lte

re
d

M
o

d
el

: X
W

-G
1

V
er

si
o

n
 : 

1.
0

0 1 5
6,

 3
8 7 10 11

16
 -

 1
9 64 65 66 67

70
 -

 9
0 91

B
an

k 
se

le
ct

M
od

ul
at

io
n

P
or

ta
m

en
to

 T
im

e
D

at
a 

en
tr

y 
LS

B
, M

S
B

V
ol

um
e

P
an

E
xp

re
ss

io
n

H
ol

d 
1

P
or

ta
m

en
to

 O
n/

O
ff

S
os

te
nu

to
S

of
t p

ed
al

R
ev

er
b

se
nd

O O O O O O X O O O O O O O

*
2
*
2

*
2
*
3
*
2

*
3
*
3
*
2

O O O O O O O O O O O O O O

*
2
*
2

*
2

*
2

*
2

**
：
無
關

M
ID

I I
m

p
le

m
en

ta
ti

o
n

 C
h

ar
t

XWG1_ch.book  Page 104  Wednesday, January 18, 2012  10:34 AM



F
u

n
ct

io
n

Tr
an

sm
it

te
d

R
ec

o
g

n
iz

ed
R

em
ar

ks

B
as

ic
 

C
h

an
n

el
1 

- 
16

1 
- 

16
1 

- 
16

1 
- 

16
D

ef
au

lt 
C

ha
ng

ed

N
o

te
N

u
m

b
er

0 
- 

12
7

0 
- 

12
7 
*
1

Tr
ue

 v
oi

ce

P
ro

g
ra

m
C

h
an

g
e

O
O

0 
- 

12
7

:T
ru

e 
#

A
ft

er
 

To
u

ch

C
o

n
tr

o
l

C
h

an
g

e

X X
X O

P
it

ch
 B

en
d

er
O

O

S
ys

te
m

 E
xc

lu
si

ve
O

 *
2

O

K
ey

’s
C

h’
s

V
el

o
ci

ty
O

 9
nH

 v
 =

 1
 -

 1
27

X
 9

nH
 v

 =
 0

, 8
nH

 v
 =
*
*

O
 9

nH
 v

 =
 1

 -
 1

27
X

 9
nH

 v
 =

 0
N

ot
e 

O
N

N
ot

e 
O

F
F

M
o

d
e

M
od

e 
3

X

0 
- 

12
7

M
od

e 
3

X
D

ef
au

lt
M

es
sa

ge
s

A
lte

re
d

S
ys

te
m

 
C

o
m

m
o

n
X X X

X X X

: S
on

g 
P

os
: S

on
g 

S
el

: T
un

e

A
u

x 

M
es

sa
g

es

R
em

ar
ks

X O X O X X

O O O O O X

: A
ll 

so
un

d 
of

f
: R

es
et

 a
ll 

co
nt

ro
lle

r
: L

oc
al

 O
N

/O
F

F
: A

ll 
no

te
s 

O
F

F
: A

ct
iv

e 
S

en
se

: R
es

et

S
ys

te
m

 
R

ea
l T

im
e

O O
X X

: C
lo

ck
: C

om
m

an
ds

M
o

d
el

: X
W

-G
1

V
er

si
o

n
 : 

1.
0

M
od

e 
1 

: O
M

N
I O

N
, P

O
LY

 
M

od
e 

3 
: O

M
N

I O
F

F,
 P

O
LY

M
od

e 
2 

: O
M

N
I O

N
, M

O
N

O
 

M
od

e 
4 

: O
M

N
I O

F
F,

 M
O

N
O

O
 : 

Ye
s

X
 : 

N
o

*
2

0 1 5
6,

 3
8 7 10 11

16
 -

 1
9 64 65 66 67

70
 -

 9
0 91 93

98
, 9

9
10

0,
 1

01

B
an

k 
se

le
ct

M
od

ul
at

io
n

P
or

ta
m

en
to

 T
im

e
D

at
a 

en
tr

y 
LS

B
, M

S
B

V
ol

um
e

P
an

E
xp

re
ss

io
n

H
ol

d 
1

P
or

ta
m

en
to

 O
n/

O
ff

S
os

te
nu

to
S

of
t p

ed
al

R
ev

er
b 

se
nd

C
ho

ru
s 

se
nd

N
R

P
N

 L
S

B
, M

S
B

R
P

N
 L

S
B

, M
S

B

O O O O O O X O O O O O O O O O O

*
2
*
2

*
2
*
3
*
2

*
3
*
3
*
2

*
2
*
2

O O O O O O O O O O O O O O O O O

*
2
*
2

*
2

*
2

*
2

*
2
*
2

* 1
:
依
音
色
而
不
同
。

* 2
:
請
參
閱

ht
tp

://
w

or
ld

.c
as

io
.c

om
/上
的

M
ID

I執
行
說
明
。

* 3
:
依
照
踏
板
效
果
設
定
。

XWG1_ch_Cover1-4.fm  Page 2  Friday, January 6, 2012  12:56 PM



Ch

XWG1-CH-1B

XW-G1

MA1204-B Printed in China
XWG1-CH-1B

K

XWG1_ch_Cover1-4.fm  Page 1  Tuesday, April 10, 2012  9:08 AM




